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What's new in this version

Thisversion of the Wave Contact Center Administrator Guide hasbeen updated for
Wave5.0:

» Contact center queue callback letsyou offer a caller on hold the option to enter a
phone number and receive a callback when an agent is avail able, rather than stay
connected listening to hold prompts. See “ Contact center queue callback” on
page 5-16.

* IntheCall Log table (see page A-3), the column heading “HoldTime” has been
renamed “WaitTime” to better reflect that it displays the number of seconds the
caller waited before being connected with an agent.
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Chapter 1

About Wave Contact Centers
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Wave Contact Centers provide a full-featured system for automatically distributing incoming
callsto agroup of agents. Examples of Contact Centersinclude a sales workgroup, a customer
support department, or any department in which multiple agentsanswer callsto asingle number.

A Contact Center queue automatically answers calls, puts them in aqueue, and then distributes
them to ready agents. With Contact Center queues you can customize the caller’s waiting
experience, play single or repeating prompts, prompt callersto enter data, configure call
priority, grant specialized supervisor permissions such as the ability to monitor calls, and use
the Wave Contact Center Reporter to run avariety of reports on Contact Center activity.

Once your queue is up and running
» If you are supervising an active queue, see Chapter 9.

» If you are working as an agent in a queue, see Chapter 10.

Wave Contact Center Administrator Guide
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How a Wave Contact Center queue works

How and when does an agent receive a queue call?

For an agent to receive calls from a queue, the following four conditions must be true:

The agent is defined as a member of the queue. A Wave user who is not amember of a
gueue can see no part of that queue in ViewPoint, and never receives calls from that
gueue. The queue administrator adds and del etes agents as members of a queue.

The agent is signed in to the queue. This setting determines whether the agent receives
calls from this particular queue. Agents must be signed in to the queue to receive calls
fromit. An agent who is signed out does not receive calls from that queue, but can till
see and monitor the queue in ViewPoint—a useful state for supervisors. An agent might
be signed into some queues and signed out of others at any given time. The queue
administrator determines which agents are signed in or out of each queue. You can also
give individual agents permission to sign themselvesin and out.

The agent is in an available personal status. To receive queue calls, an agent must bein
the personal status Available, Available (Queue Only), or any personal status with the
Queue calls field set to Yes. Agentsin any personal status with Queue calls set to No—
for example, Available (Non Queue) or Do Not Disturb—do not receive calls from any
gueue. Agents can change their own personal statusif they have permission to do so, and
it can aso be changed by othersif they have permission to do so.

The agent is ready. This agent state, viewable in the Queue Monitor (see “The Agents pane’
on page 9-4), determines whether the agent is currently eligible to receive queue calls. Agents
are ready when they are signed into at |east one queue, are in an available personal status, and
are not currently in acall or the wrap-up period following acall.

What do agents experience?

Agents can work in a queue using the phone alone or in conjunction with Wave ViewPoint.
Agents can change their personal status to begin their shifts, take breaks, and end their shifts.
After finishing each call, agents have awrap-up timeto complete paperwork beforethey receive
the next call.

By default agents have permission to change their own personal status, enabling themto control
their own workflow. You can revoke this permission for individual agents, so that a supervisor
must changetheir personal statusfor them. See* Preventing agentsfrom changing their personal
status’ on page 3-11.

Wave 5.0

Wave Contact Center Administrator Guide
July 2016



Wave Contact Center queue features 1-3

Chapter 1: About Wave Contact Centers

What do callers experience?

Callers reach the queue either by dialing its extension directly or choosing it from your
company’s auto attendant (for example, “for Technical Support, press2"). They hear an initial
message, called a Welcome prompt, that introduces them to the queue. You can aso have the
gueue prompt them to enter data at this point, such as a customer number, that can optionally
modify their waiting experience. If no agents are ready, the callers are then placed on the queue
to wait.

While waiting, callers hear hold music. Occasionally they hear other messages called Hold
prompts. These are messages that you record to assure callers that their calls will be answered,
to play them an advertisement, and so on. You can define Hold promptsthat play only once, play
on arepeating basis, or change based on how close the call isto being answered. Instead of
waiting, callers can choose to |eave avoice message or transfer out of the queue to an extension
you define, such as an Operator or your auto attendant.

When an agent becomes ready, the caller is transferred to that agent.

Wave Contact Center queue features

Administration

Single-point interface to create and manage queues

Take a queue off-line and send its calls to voicemail

Automatically take a queue off-line when all agents are unavailable

Choice of language for system prompts

E-mail and pager notification of new voicemail

Voicetitles for Contact Center extensions

Overflow groups of agents for times when primary agents are busy

Overflow agents with individual overflow levels

Overflow agents only called after all agents are busy for atime you configure

Wave 5.0

Wave Contact Center Administrator Guide
July 2016



Wave Contact Center queue features 1-4
Chapter 1: About Wave Contact Centers

Agents automatically placed on break if they let queue calls ring unanswered

Callersredirected if the queue is too busy, callers are waiting too long, there are not enough
agents, or there are no agents with matching skills

Individual permissions for whether an agent can use personal status to make himself or herself
unavailable

View Contact Center and persona Call Log in the same ViewPoint application

Queue logs for troubleshooting

Separate licensing required per agent

Caller Experience

Contact Center automatically answersincoming calls

Hold music

Different hold music for each queue

Extension or DID number to dial queues

Contact Center extensions listed in the dial-by-name directory

Greetings to welcome callers

Repeating messages for waiting callers

Conditional messages for waiting callers

Priority for individual callers that reduces wait time

Messages that tell callers their expected wait times

Messages that tell callers how many callers are ahead of them

Caller options to stop waiting and leave voicemail or transfer out of the queue to an extension

Ability to prompt callersto enter data

Agent Experience

Call Monitor tabs for agents

Agents can answer any call using ViewPoint

Wave Contact Center Administrator Guide
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Agents can work from home or any remote location

Contact Center listed in Extensions folder in ViewPoint

Individually configurable agent wrap-up time

Agents can manually end their wrap-up time early

System-wide wrapup time

Special personal statuses for agents: Available (Queue only), Available (Non-Queug) and On
Break

Agents can make themselves ready or unavailable to receive calls using ViewPoint or phone com-
mands

Agents can sign in and out of individual queues using ViewPoint or phone commands

Visual indication of which agent will get the next call

Agents can place calls as the queue, enabling supervision and reporting of outbound calls

Supervision

Changing an agent’s personal status

Signing an agent in or out of a queue

Comprehensive Queue Monitor to view real-time queue and agent statistics

Customizable shift periods for comparative statistic display

Critical queue statistics available by phone in audio format

Coaching and monitoring of agents

Viewing agents who are being monitored

Automatically setting absent agents to On Break status

Automatically recording of agent and Contact Center calls on a periodic basis

Call Distribution

Sequentially by agent order

Wave 5.0
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Round robin (each agent in turn)

Simultaneously (ring all agents)

To longest idle agent

To agent with fewest calls

To agent with least talk time

To agent with best matching skills

To agent via custom routing method

Reports

Separate licensing required for reports

User Activity Report for agents includes personal status breakdown and Contact Center details
section

All other reports

Agents, call forwarding and routing lists
Queue callsto agentsdo not usethe agents’ routing listsor call rules, so they cannot try an agent
at multiple locations. Queue calls do follow the agents’ call forwarding / Where | Am settings.
Viewing queue configuration and setup
The Contact Center Queue Information report shows general information about each queuein

your system, including alist of agents and their current settings. You can use this report to get
a snapshot of a queue’s setup.

Wave Contact Center Administrator Guide
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Using the Call Classifier with Wave Contact Centers

Wave Call Classifier can greatly improve the productivity of Contact Centers by identifying
calers, intelligently routing calls, and presenting Contact Center agents with scripts and related
caller information before they take the call.

Basic Contact Center queue terminology

To work in a Contact Center queue as an administrator, supervisor, or agent, you should be
familiar with the following Contact Center queue terms:

» Agent. A Wave user who answers incoming calls to the Contact Center.

* Queue. A Contact Center that is set up at asingle extension. Callersto that extension who
are waiting are said to be “in the queue.”

A Contact Center can have more than one queue. For example, atechnical support
department can have one queue for Product A and another queue for Product B. Each
gueue hasitsown list of agents who answer calls and its own method of distributing calls
to agents. A user can be an agent for more than one queue.

* Supervisor. An agent who has special permissions. An agent with full supervisory
permissions can perform any of the following tasks. (Agents can be configured with
varying levels of permission to perform some but not all supervisory tasks.)

» Monitor, coach, and join other agents' calls.

» Perform administrative maintenance on a queue, for example, add and remove
agents from a queue, sign agentsin or out of a queue, change an agent’s personal
status, manage a queue’s voice mailbox, and so forth.

» View current queue statisticsin ViewPoint.
These supervisory functions are described in Chapter 9.

e Overflow agent. A user who answers calls to a queue only when all the queu€e’s regular
agents are busy (standby or unavailable).

» Personal calls. Any calls directly to an agent’s extension, as opposed to calls the agent
receives from a queue.

Wave Contact Center Administrator Guide
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Using the audio controls

This manual describes how to use various recordings—greetings, prompts, and so forth—to
customize the behavior of your Contact Center queues. Wave's audio controls make it easy to
create and modify recordings of al types. Thefollowing controls appear in Wave wherever you
can create and listen to recordings.

o v|a|w|w| B

To create and play recordings, use the buttons on the audio controls as shown in the following
table and speak into your phone.

R d
i ecor When you are ready to record, pick up your phone,
and then click this button. A beep signals that
recording has begun.

Pl
[} ad Click to listen to the recording.
Stop . .
D When you are done recording, you can either hang
up or click this button.
Fast . . S . .
B Forward Click to skip ahead while listening to the recording.
Rewind . . _— . .
<K Click to skip back while listening to the recording.

To move forward and backward within the recording, drag the dlider bar.

Wave Contact Center Administrator Guide
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Importing audio files

You can import an audio filein WAV format to use for any Wave recording (greetings, voice
titles, and so on). Wave canimport WAV fileswith afrequency of 8Khz, 11.025 Khz, 22.05 Khz,
or 44.1 Khz., as shown in the following table.

To import an audio file, click the Import audio control.

Wave 5.0
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Chapter 2

Creating a Contact Center Queue

CHAPTER CONTENTS

Queue requirements . ... ... ... 2-1
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Defining call logging foraqueue .. ......... ... .. . . i, 2-24
Setting external Caller ID for outbound queuecalls. . ................... 2-25
Managing a queue’s password security. . .. ....... ... i .. 2-27

The queue is the backbone of a Contact Center. A queue defines the primary and overflow
agents who receive Contact Center calls, the method by which calls are distributed to those
agents, what callers experience while they are waiting, and so forth.

Queue requirements

To create a Contact Center queue, you must have the appropriate licenses installed and
Supervisor permissions set.

Agent licenses: To create a queue, you must first purchase and enter one Contact Center
Agent license for each Contact Center agent. Only one license is required for each agent,

even if agents are members of multiple queues.

Queuefolder permission: To create or edit a queue, you must have the general Wave
permission Access Queues Folder set to View and Edit. Y ou do not need other
Administrator permissions, so you can manage queues without being a full Wave system

administrator. To set permissions, use the Users view in the User/Group Management appl et

in the Wave Global Administrator Management Console.

Wave 5.0
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Queue creation and customization tasks

You create aqueue viathe Queues view using the User/Group Management applet in the Wave
Globa Administrator Management Console.

e Basic queue creation tasks are covered in this chapter:
» Entering genera information about a queue. See page 2-6.
» Managing a queue’s prompts and audio recordings. See page 2-7.
» Directing callsto aqueue. See page 2-13.
* Redirecting calls. See page 2-17.
» Defining call logging for a queue. See page 2-24.
e Setting external Caller ID for outbound queue calls. See page 2-25.
» Managing a queue's password security. See page 2-27.
* Adding primary and overflow agents to a queue is described in Chapter 3.
» Different methods of distributing incoming callsto agentsis covered in Chapter 4.

» Adding features that can enhance the caller experience, such as hold options and queue
callback, is described in Chapter 5.

»  Queue management options, such asimproving expected wait time for callers,
automatically recording queue calls, collecting queue statistics, and using custom data
variablesis covered in Chapter 6. This chapter also explains how to close and delete a
queue.

» Advanced call routing options—skills-based routing and custom routing—are explained
in Chapter 7.

» Using Wave contacts and call rules with queuesis covered in Chapter 8.

» Contact Center queue reporting options are described in Chapter 11. If you want to create
additional custom reports, see Appendix A.

Wave Contact Center Administrator Guide
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The Queues view

The Queues view

To create or edit a queue

1 If necessary, click the Administration tab in the Global Administrator Management
Console.

Click 2 Click the User/Group Management icon, located in the PBX Administration section.

[ZL]

I Log on to the User/Group Management applet, which opensin aremote access window.
A Once you log on, open the Queues view by clicking itsicon in the view bar.

File Edit Wew Tools OQueues Help |

-3 X2 @

Mame 4 | Extension| DID Diistribution Mumber of Agents| Record Mth Call | Hold Music

MT Queue 164 Top down Open 4 Dizabled

4] | i

| 8 ltems Globaltdministrator | sapphirel3 v

Each queue that you create appears as arow in the view.

Wave Contact Center Administrator Guide
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The following table shows the information that is displayed for each queue.

Name Name of the queue
. Extension dialed to reach the queue from the auto attendant or

Extension .
when transferring a call

DID Direct Inward Dial—Phone number dialed to reach the queue
directly

Distribution Algorithm used to distribute calls to agents
Whether the queue is currently distributing calls to agents. The
possible statuses are:
Open. The queueis distributing its calls to ready agents as nor-
mal.

Satus Closed. The queueis closed. No calls are being distributed to

agents.

Closed - No agents. All agentsin the queue are currently signed
out, so the queue is automatically sending its calls directly to
voicemail.

Number of Agents

Total number of agents who are members of the queue.

Record Nth Call

If checked, the queueis set to record its calls.

ChangeHold Music To

The name of the music-on-hold source being used for the queue’s
hold music, if any.

The amount of time that the queue waits before ringing back an

Hold Callback agent who leaves acall on hold or parked. “ Off” indicates that
ringback is not being used.
. If checked, the queue has a priority variable that can be used for
Priority L . 7
assigning some callers a higher priority than others.
Overflow If checked, the queueis using overflow agents.
Separate columns for Too Busy, Maximum Wait, and Queue
Redirect Closed. If checked, the queue is set to redirect callers when the
circumstance occurs.
Mail Usage Percentage of allocated voicemail space currently used.
Greeting Usage Percentage of allocated space for greetings currently being used.
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|
Amount of disk space (in megabytes) used by the queue’s audio

Disk Usage files, including voicemail and greetings.

Mailbox size How much space (in minutes) the queue’s voice mailbox has.

Greeting size How much space (in minutes) is allocated to the queue for greet-
ings.

Comments Any comments about the queue

4 To edit an existing queue, double-click its row in the Queues view. To create a new queue,
choose File > New > Queue.

5 The Queue diaog opens.

%] Untitled - Queue

Quewe |
[#-Bueue Wlenies Il
- Skillz -
[ Agerts Extenzion: I
(- Distribution Password: I— Canfirmatian: I—
- Redirection
- Hald DID number: |
[#-Yoice Mail o .
perator: Aftendant [« 8 -
- Caller Entry I [+ 8] J
- Dial-by-name Directony Cornments: ;I
- Sacurity
- Audio
- Recording =
[#- Statistics W] B s llsed
¥ Trace queus and agent activity to queue logs

QK I Cancel | Help |

The tasks that you can perform on the tabs in the Queue dialog are described in the rest of
the sections in this chapter.
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Entering general information about a queue

To enter general information about a queue

1 Click the Queue tab in the Queue dialog.

%] Untitled - Queue

Quewe |
[#-Bueue Name: Il
- Skillz
[ Agerts Extenzion: I
(- Distribution Password: I— Canfirmatian: I—
- Redirection
- Hald DID number: |
[#-Yoice Mail o .
perator: Aftendant [« 8 -
- Caller Entry I [+ 8] J
- Dial-by-name Directony Cornments: -
- Sacurity
- Audio
- Recording LI
[#- Statistics W] B s llsed
¥ Trace queus and agent activity to queue logs

QK I Cancel | Help |

2 Enter the following information for the queue:

» Name. Give the queue a short name that will easily identify it, such as“ Sales queue.”
When users transfer a call to this queue using ViewPoint, they will select it by name.

* Extension. Enter an extension for the queue. Users can then transfer callsto the queue
by phone. The extension is generally not used by callersto dia the queue from an
auto attendant. Callers should reach the queue either by dialing a Direct Inward Dial
number or by making a choice on the auto attendant menu. See “ Setting up a menu
choice for aqueue’ on page 2-14.

e Password. Give the queue a unique numeric password. You will need to log in with
the password if you want to change the queue configuration or check the queue's
voice messages when you are at aremote phone. For example, on a day when your
businessis closed unexpectedly, you can call, log in, and change the queue’s
voicemail greeting so that callers are aware of the situation.

Reenter the password in the Confirmation field.
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DID number. Optionally, you can give the queue a Direct Inward Dial number from
the block of numbers provided by your phone company. Callers can then dial the
gueue directly, without going through an auto attendant.

To assign multiple DID numbers to a queue, separate each number by a comma. For
example, enter 1234,1235,1236.

Operator. Select the extension to which callerswill betransferred if they pressO while
they are leaving voicemail for the queue.

Comments. Enter any descriptive information about the queue.
Queue is closed. See“Defining call logging for a queue” on page 2-24.

Trace queue and agent activity to queue logs. Check to create queue logs that record
detailed agent and queue activity for troubleshooting purposes.

3 Click OK to save the queue.

Managing a queue’s prompts and audio recordings

In addition to Hold prompts (see” Creating Hold prompts’ on page 5-11), you can configure and
record the following audio messages for the queue:

Phone prompts. You can specify the language used for phone prompts played to
calersto the queue.

Important: Thelist of languages that you may select from for telephone promptsis
determined by the languagesthat have beeninstalled on the Wave Server. U.S. English
isinstalled by default. French, German, Spanish, and UK English are availablein
General HotFix 1005. Note that this HotFix installs system and auto attendant voice
prompts, but does not affect the text that appears on a phone’s LED display. To obtain
General HotFix 1005, contact your Wave provider.

Voice title. A queue can have avoicetitlethe same as auser can. Wave playsthe voice
title to callers during call transfers and other operations.

Welcome prompt. A Welcome prompt is a message played once to each caller when
the caller first reaches the queue.

Greetings. You can record greetings for the queue’s voice mailbox.
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Choosing the language for a queue’s phone prompts

To choose alanguage for a queue’s phone prompts
1 Click the Audio tab in the Queue dialog.

2 From the Telephone prompts drop-down list, choose the language in which the phone
prompts play to callersin the queue. The list shows the languages that you have installed
with Wave.

%] Untitled - Queue

Category pudio |

[]E:‘iue Telephone prompts:  [English (Linited States) 4|
kil

Deutsche
[#-Agents B ted i
[#- Distribution Wil

- Redirection esparol
£

£

+- Hold frangaiz [Canada)
H-Woice Mail frangais [France]

- Caller Entry

- Dial-by-name Directory

- Sacurity

=1~ Audio

Woice Title

weloame Prampt
- Greetings

- Recording

[#- Statistics

QK I Cancel Help

3 Click OK to save the queue.
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To record a voice title for a queue
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1 Click the Audio\ Voice Title tab in the Queue dialog.

%] Untitled - Queue

[#- Queue

o|v]] Sl 4

- Skillz

[ Agerts | Ready to play
[#- Distribution
- Redirection
[+ Hold
[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

1+ Audia

-welcome Prompt
i Greetings

- Recording

[#- Statistics

B

Cancel | Help |

2 Usetheaudio controlsto record the voice title. The voice title should be a short recording
of the queue’s name only. See “Using the audio controls’ on page 1-8 for instructions.

3 Click OK to save the queue.
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Creating a Welcome prompt for a queue

Callers hear the Wel come prompt once when they reach the queue. It might say, “ Thank you for
calling Julep technical support. Please hold. The next available agent will be with you shortly.”

To create a Welcome prompt for a queue
1 Click the Audio \ Welcome Prompt tab in the Queue dialog.

251 Untitled - Queue

[#- Queus

- Skills

H- Agents

- Distribution
- Redirection
#-Hold

-]

H-Yoice Mai .l L | -|| Bl%l }
- Caller Entry

- Dial-by-name Directory
- Security

| Fieady to play

- Recording
[#- Statistics

QK I Cancel | Help |

2 Typethetext of the prompt or a description of it.

3 Record the Welcome prompt using the audio controls. See “Using the audio controls’ on
page 1-8 for instructions.

4 Click OK to save the queue.
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Using the Welcome prompt to inform callers that their calls may be recorded

Wave provides a professionally-recorded prompt, MayBeMoni tored.wav, that you can import as
aWelcome prompt. It says, “ Your call may be monitored or recorded.” By default the prompt
isin the following location:

C:\Program Files\Televantage Server\vfiles\EN0O\MayBeMonitored.wav

If you decide to use this prompt, you do not need to record a Welcome prompt as described
above.

Creating voicemail greetings for a queue

You can create and store as many different voicemail greetings as you want, and you can easily
change the active greeting, which is the one played to callers who reach the queue’s voicemail.
The greetings appear on the Audio \ Greetingstab in the Queue dialog. The active greeting
appearsin bold.
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To create a voicemail greeting for a queue

1 Click the Audio\ Greetings tab in the Queue dialog.

%] Untitled - Queue

[#- Queue b aximum size of greetings [minutes]: |1 1]

- Skillz

[+ Agents Mame | Text |
[#- Distribution
- Redirection
£
£

#-Hald
- Yoice Mail
- Caller Entry
- Dial-by-name Directory
- Sacurity
=1~ Audio
~oice Title
‘welcome Prompt

103
- Recording
[#- Statistics

§etActive| aid. | Ea. | e |
QK I Cancel | Help |

2 Optiondly, enter the Maximum size of greetings (minutes) for all voicemail greetings created
for the queue.

3 Click Add. The Greeting dialog opens.

eUntitIed - Greeting [ %]
M ame: || D ate recorded: I
Lontents: ;I
Audio
o| 1| a|w|w| &=
| Fieady to play
Brevious | st | QK I Cancel Help
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4 Enter aName for the greeting.
5 Under Contents, type the text of the greeting or a description of it.

6 Record the greeting using the audio controls. See “Using the audio controls’ on page 1-8
for instructions.

7 Click OK to save the greeting, which now appearsin thelist on the Audio \ Greetings tab.
To make this greeting the active greeting, click Set Active on the Audio \ Greetings tab.

8 Click OK to save the queue.

Enabling callers to leave a callback phone number via voicemail

While leaving voicemail, callers can press 7 and then enter a phone number at which an agent
can call them back. If callers use thisfeature, agents can call them back quickly by selecting the
message in any Voice Messages folder and choosing Speed Dial. This method of getting
callback numbers s often a better alternative than asking callers to record their own phone
numbers on the voice message.

If you want callersto enter a callback phone number, record instructions for how to do soin
your voicemail greeting. For example, your greeting might say, “We're sorry no one was
availabletotake your call. To leave amessage and have an agent call you back, press7." Callers
can press 7 during your greeting, while recording their message, or after recording their

message.

Entering a callback number while recording the message ends the message. However, the caller
can then add more to the message by pressing 4.

Note: You can aso offer acallback option to customers who are waiting on hold in a queue,
rather than stay connected listening to hold prompts. See “Contact center queue callback” on
page 5-16.

Directing calls to a queue
Before your queueisready to be opened for calls, you must create ameans by which callers can
reach the queue.

» Define amenu choice that transfers callers to the queue from your company’s main auto
attendant, for example, “For Sales, press 2." For instructions, see below.

» Include the queue in your dial-by-name directory.
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* Givethe queue afull phone number, so that callers can dial it directly. To do so, do either
of the following:

» Givethequeue aDID number on the General tab in the Queue dialog (see “Entering
general information about a queue” on page 2-6). Note that your phone lines must
support DID to use this option.

» Direct atrunk lineto the queue

Setting up a menu choice for a queue

If you have multiple auto attendants, perform the following steps for each auto attendant from
which you want to offer callers the choice of transferring to the queue.

To set up a menu choice in an auto attendant for a queue

1 InViewPoint, open the Auto Attendants view and double-click the auto attendant from
which you want to offer callers a menu choice for a queue.

2 Inthe Auto Attendant diaog, click the Menu Choices tab.

Default Auto Attendant - Auto Attendant

1] Transfer to Operator = |
# User login

nathing  Transfer to Operator

Add.. Edi. |  Dekete |

Mumber of geconds before performing ‘nothing' menu choice: |3

¥ Process all other digits as user extensions
[~ Prevent type-ahead
[~ Bestrict dial-by-name and extension matching to members of:

I Eric group j EI

QK Cancel | Help |
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3 Click Add. The Edit Menu Choice dialog opens.

r— Brompt to offer thiz menu choice:

o||,|_||_|i

| Fieady to play

— when caller presses: Ig vl

Perfarm action: ITransfer to uzer j

Birian MohM x|

Annournce: IName or extension 'l

QK | Cancel | Help |

4 Record the prompt that you want callers to hear, for example, “For the Sales department,
press 2.” See“Using the audio controls’ on page 1-8 for instructions.

5 From the When Caller Presses drop-down list, select the key that callers pressto be
transferred to the queue.

6 Do one of the following in the Perform Action drop-down list:
» Select Transfer to Queue and select the queue to which you want to transfer callers.

e If youareusing autility user to transfer calls to the queue, select Transfer to user and
select the utility user.

7 Click oK inthe Edit Menu Choice dialog.
8 Click OK inthe Auto Attendant dial og.
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Including a queue in the dial-by-name directory

You can include the queue in the dial-by-name directory so that, for example, acaller could dial
SALES to reach your Sales queue.

If you include the queue in the dial-by-name directory, you should record its voice title. See
“Recording avoice title for aqueue’ on page 2-9.

To include a queue in the dial-by-name directory

1 Click the Dial-by-name Directory tab in the Queue diaog.

%] Untitled - Queue

Category Dial-by-name Directory

- Queue v Ligt in dial-by-name directony
- Skillz
[+-&Agents

[#- Distribution
- Redirection
£
£

¥ Plap extenzion to the caller

#-Hald
- Yoice Mail
- Caller Entry

- Audio
- Recording
[#- Statistics

QK I Cancel | Help |

2 Select theList in dial-by-name directory checkbox.

3 Toplay auser's extension along with the user's name when callers choose the user from the
dial-by-name directory, and then select the Play extension to the caller checkbox.

4 Click OK to save the queue.
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Redirecting calls

You can define how incoming calls to the queue are handled in the following situations:
*  When the queue is too busy
*  When acall exceeds the maximum wait time
*  When the queueisclosed

* When there are no agents with matching skills

Note: You can follow how many calls a queue is redirecting using the Redirection statistic in
the Queue Monitor. See “The Queue Statistics pane” on page 9-8.

Redirecting calls when the queue is too busy

You can automatically divert new calls out of the queue when the queue hits a certain level of

traffic that you define. For example, if the expected wait timeislonger than 30 minutes, you can
play a message to callers telling them that the queue is currently too busy to accept new calls,

then transfer them to another destination such as voicemail or your auto attendant.
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To define redirect options when a queue is too busy
1 Click the Redirection \ Queue Too Busy tab in the Queue dial og.

2 Select the Redirect callers if queue is too busy checkbox.

%] Untitled - Queue

[ Queue v Redirect new calls if queus is too busyt
- Skillz
[ Agerts [~ 1f the number of waiting call: would excesd |2D
[l Distribution [ I the expected wait time is maore than IBDD seconds
[=I- Redirection . .
Queue Too Busy [ If the number of queued calls excesd |2 times the available agents

- b airnurn 4 ait Time:

-+ Queue Clozed [ Play this prompt befare redirection:
Mo Matching Skill .
i Hold o v|o| Sl
[ Yoice bail [
- Caller Entry
-~ Dialby-name Directory Perform this action:
- Sacurity
- Audia = Transfer the call to: Iaaa bbb [ 542) j
~Recording @ Sendto voice mail. | < this queue » =
[+ Statistics B I d J
" Hangup

QK I Cancel | Help |

Note: If this checkbox isnot selected, all incoming calls enter the queue regardless of how
busy the queueis.

3 Todefinethe “too busy” threshold at which the queue beginsto redirect new calls, choose
any combination of the following options. New calls are redirected if any of the specified
thresholds are met.

* If the number of waiting callers would exceed __. Check this option to redirect new
callsif they would cause the number of callsin the queue to exceed the number you
enter. Callsin the queue include those connected with agents as well as those waiting.

* If the expected wait time is more than __ seconds. Check this option to redirect cals
when the expected wait time meets or exceeds the number of seconds you enter. For
information on how the expected wait timeis calculated and how to improve its
accuracy, see “Including a queue in the dial-by-name directory” on page 2-16.
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* If the number of queued callers exceeds __times the available agents. Check this
option to redirect calls when the number of callswaiting in the queue is greater than the
number of available agents by the factor you enter. For example, if you enter 2 then
redirection begins when there are twice as many calls waiting in the queue as available
agents. Available agents are signed-in agentsin the personal status Available or Available
(Queue Only).

4 To play amessage to callers who are about to be redirected, select the Play this prompt

before redirection checkbox. Use the audio controls to record or import the prompt. See
“Using the audio controls’ on page 1-8 for instructions.

To define how calls are redirected, choose one of the following options under Perform this
action:
» Transfer the call to. Redirected calls are transferred to the extension you select.

* Send to voicemail. Redirected calls are transferred directly to the voicemail of the
extension you select.

Note: If you choseto play aredirection messagein step 4, the caller will hear theredirection
message followed by the voicemail greeting. You can use the combination to create full
messages. For example, the redirection message can say “1’ m sorry, we' re temporarily
closed,” and the voicemail greeting can add, “Please leave a message.”

e Hangup. Redirected calls are disconnected.

6 Click OK to savethe queue.
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Redirecting calls after maximum wait time expires

You can automatically redirect individual calls after the calls have waited on the queue for a
length of time that you specify.

To define a maximum wait time for a queue

1 Click the Redirection / Maximum Wait Time tab in the Queue dialog.

%] Untitled - Queue

Redirection % Maximum Wait Time
- Queue ¥ Bedirect calls when they have waited too lang
- Skills
[ Agents I aximunn wait time: |1 |00 seconds
[#- Distribution
(=] Redirection [ Play this prompt befare redirection:

EHET

. No Matching Skil
-Haold Perfarm this action:
- Voice Mail & Transfer the call to: Iaaa bbb [x 542) j
- Caller Entry
. Dialby-name Directory " Send to voice mail |< this queue > j
----Sec:.urity ¢ Hangup
- Audio
- Recording
[#- Statistics

QK I Cancel | Help |

2 Toredirect callsthat meet the maximum wait time, select the Redirect callers when they
have waited too long checkbox. If unchecked, the specified maximum wait time has no
effect.

3 Enter the Maximum wait time (in seconds).

4 To play amessage to callers who are about to redirected, check Play this prompt before
redirection. Use the audio controls to record or import the prompt. See “Using the audio
controls’ on page 1-8 for instructions.
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5 To define how calls are redirected, choose an option under Perform this action:
» Transfer the call to. Redirected calls are transferred to the extension you select.

* Send to voicemail. Redirected calls are transferred directly to the voicemail of the
extension you select.

e Hangup. Redirected calls are disconnected.

6 Click OK to savethe queue.

Redirecting calls when the queue is closed

This section describes how to redirect incoming calls when the queue is closed. (See “Closing a
gueue” on page 6-15). You can a so have the queue close automatically whenever there are no agents
signed in, as described in the following steps.

To redirect calls when a queue is closed
1 Click the Redirection \ Queue Closed tab in the Queue dialog.

%] Untitled - Queue

Redirection \ Queue Closed
F-Queue [+ Close queue if no agents are signed in
- Skillz
[#-Agents [ Play this prompt befare redirection:
[#- Digtribution .
1+ Redirection ililil EIEI v
' |

i Queue Too Busy
I awirnum '/ ait Time

Perfarm this action:

&-Hald = Transfer the call to: Iaaa bbb [ 542

[#-Woice Mail {* Send to voice mail Iaaa bbb [x 542]
- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

Lef L«

" Hangup

QK I Cancel Help
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To have the queue close automatically when no agentsare signed in, select the Close queue
if no agents are signed in checkbox.

Note: Agentsinthe On Break statuswill not cause the queueto close. For the queueto close,
all agents must be either signed out, or in a personal status other than Available, Available
(Queue Only), and On Break.

If the queue closes because no agents are signed in, the queue will reopen automatically
when an agent signsin. You can also reopen it manually by deselecting this checkbox.

Note: Thisfield does not affect the Queue is closed checkbox on the Distribution tab. For
example, if that checkbox is selected, the queue remains closed regardless of how many
agents are signed in or out.

To play amessage to callers who are about to redirected, check Play this prompt before
redirection. Use the audio controls to record or import the prompt. See “Using the audio
controls’ on page 1-8 for instructions.
To define how calls are redirected, choose an option under Perform this action:

» Transfer the call to. Redirected calls are transferred to the extension you select.

* Send to voicemail. Redirected calls are transferred directly to the voicemail of the
extension you select.

* Hangup. Redirected calls are disconnected.

Click OK to save the queue.

Redirecting calls when there are no matching agent skills

This section describes how to redirect incoming calls when none of the signed-in agentsin the
queue have skills that match that call’s skill requirements.

Note: If you have set the queue to reduce calls’ skill requirements over time (see “ Adjusting
skill requirements over time” on page 7-12), then calls are not redirected for lack of matching
skills.
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To redirect calls when there are no matching skills

Click the Redirection\ No Matching Skills tab in the Queue dialog.

%] Untitled - Queue

1

Redirection \ No Matching Skill
- Queue [~ Bedirect call if all signed in agents do nat meet the call's skill requirements
- Skillz
[#-Agents [ Play this prompt befare redirection:
[#- Distribution .
1+ Redirection ililil EIEI v
|

i Queue Too Busy
- M awirnum ' ait Time

Perfarm this action:

(+ Transfer the call to: Iaaa bbb [+ 542]

- Waoice Mai " Send ta voice mail Iaaa bbb [« 542
- Caller Entry

- Dial-by-name Directory
- Sacurity

[+ Audio

- Recording

[#- Statistics

" Hangup

K1

o]

To have the queue redirect callers for whom no agents with matching skills are signed in,
select the Redirect call if all signed-in agents do not meet the call’s skill requirements

checkbox.

To play a message to callers who are about to redirected, check Play this prompt before
redirection. Use the audio controls to record or import the prompt. See “Using the audio

controls’ on page 1-8 for instructions.

To define how calls are redirected, choose an option under Perform this action:
» Transfer the call to. Redirected calls are transferred to the extension you select.
* Send to voicemail. Redirected calls are transferred directly to the voicemail of the

extension you select.
* Hangup. Redirected calls are disconnected.

Click OK to save the queue.
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Defining call logging for a queue

To define call logging for a queue
1 Click the Queue\ Call Log tab.

%] Untitled - Queue

[=1- Queue ¥ Log this queus's calls: IAII callz j

[~ Organization:

H- Agents

- Distribution
- Redirection
#-Hald

- Yoice Mail
- Caller Entry
- Dial-by-name Directory
- Sacurity
- Audio

- Recording
[#- Statistics

-]
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IVerticaI j ;?I

QK I Cancel Help
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2 Enter the following information:

Log this queue’s calls. Specify which of this queue’s calls appear inthe Call Log. You
can log inbound calls, outbound calls, both, or none. To log no calls, uncheck the
field.

Important: If you turn off call logging for the queue, you cannot run reports on this
queue.

Organization. If you are using Organizations, check to associate this queue with the
Organization you select from the drop-down list. Click to create a new Organization.
Inbound calls to the queue that did not reach an agent will be logged as belonging to the
selected Organization (for example, abandoned calls and callswhere the caller |eft avoice
message).

Organizations are a means to represent different companies or tenants that share a
Wave Server.

Note: Outbound calls made by users calling as the queue are not associated with the
gueue’s Organization. They are always associated with the user’s Organization, even
if the user has no associated Organization.

3 Click OK to save the queue.

Setting external Caller ID for outbound queue calls

An outbound calls placed by an agent isidentified as being from the queue rather than from the
agent’s personal extension (see*“Placing callsfrom aqueue vs. calling asuser” on page 10-10).
For outbound queue calls, you can determine the Caller ID information that accompanies the
call. The Caller ID information that you specify for the queueis used for outbound calls placed
by any of the agentsin the queue.

Note the following:

» Cadller ID information entered here will be overridden by any external Caller ID that is
specified for the outbound trunk.

*  Ontrunk types other than ISDN, outbound Caller ID is aways set by the phone company.
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To set external Caller ID for a queue

1 Click the Queue\ External Caller ID tab.

%] Untitled - Queue

{+ Use external caller 1D from U ser Configuration

- Call Log _
ternal Caller 1D ” Send company name and main number

- Skills {~ Send queus namie and interal extenzion number
H- Agents :
- Distribution {~ Send queus name and this number: |

£
£
[+ Redirection I~ plus last |3 vl digits of calling estersion rurmber
£
£

- Hald i
H-Yoice Mail ¢~ Danot send caller 1D
- Caller Entry

- Dial-by-name Directory

- Sacurity

[+ Audio

- Recording

[#- Statistics

QK I Cancel | Help |

2 Select one of the following:

» Use external caller ID from General Settings. External Caller ID as specified viathe
General Settings applet is sent as Caller ID number for outbound calls from the
gueue.

* Send company name and main number. Company name and main number (as
specified viathe General Settings applet) is sent as Caller ID number for outbound
calls from the queue. (

e Send station name and this number. The name associated with the station as well as
the number that you specify is sent as Caller ID number for outbound calls from the
queue.
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* Do not send caller ID. Caller ID is blocked on outbound calls from the queue. Note that
the system still sends Caller ID information even though it is blocked—thisis a
requirement, because some institutions have the right to read blocked Caller ID, for
example emergency services and 800 numbers.

* Send organization name. Organization Nameis sent as Caller ID number for outbound
calls from the queue.

3 Click OK to savethe queue.

Managing a queue’s password security

Use the options on the Security tab in the Queue dial og to protect the queue’s account and your
Wave system from unauthorized access and toll fraud.

To configure password security for a queue

1 Click the Security tab in the Queue dialog.

%] Untitled - Queue

Category B

- Queue ¥ Password never expires

- Skils [~ Password must be changed on next log on

[+ Agents

- Distribution I™ Queue is locked out
- Redirection

[+ Hold

[#-Yoice Mail

- Caller Entry

- Recording
[#- Statistics

QK I Cancel Help
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2 Specify security options:
* Password never expires. If checked, the queue’s password does not expire, although
you can always manually change it or force it to be changed. If unchecked, the
password may expire as determined by your system settings.

Important: Checking thisfield isasecurity risk, aslong-standing passwordsare easier
to guess.

e Password must be changed on next logon. If checked, the system requires the
password to be changed the next time someone |ogs on to the queue’s account, using
any workstation application or the phone commands.

* Queue is locked out. If checked, the queue's account cannot log on to the system, even
with the correct username and password. Depending on your system settings, lockout can
occur automatically if someone repeatedly tried and failed to log on to the account.
Deselect the checkbox to unlock the account and permit normal logging on.

3 Click OK to save the queue.
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A queue can have both primary agents and overflow agents:
» Primary agents are agents whose primary task is answering queue calls.
» Overflow agents are agents whose primary task is not answering queue calls, but who
receive them when all primary agents are busy.

An agent can work in more than one queue—you must add the agent separately to each of the
gueues. Before you can add an agent to a queue, he or she must already be a Wave user.
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Setting default wrap-up time and permissions for agents

You can set defaults for agent wrap-up time and permissions. There are two benefits to doing
this:

e To save time when adding agents. Before adding agents, set the defaults to the way you
want them to be for atypical agent. The default settings will then appear as each new
agent’s settings, which you can then modify for an individual agent if necessary.

* To change a permission for several agents at once. When you change a default agent
permission, you changeit for al existing agents except agents for whom you have specified
an unchanging permission. For example, you might give your agents the Queue Sign In/Out
permission, and then later decide to disallow it. This effect works only for permissions, not
wrap-up time.

To set a default wrap-up time for agents in a queue
1 Click the Agentstab.

%] Untitled - Queue

-- Queue Default wrap up for new agents in seconds: |1 5

EIM [~ If an agent does nat answer, set that agent to On Break

s [;;;EL:?::IWS After how many unanzwered calls: |2

[+ Redirection
-Haold Agent | Ovwerflow Tier | i|
[#-Yoice Mail

- Caller Entry Ll
- Dial-by-name Directory

- Sacurity
[+ Audio

- Recording
[#- Statistics

aid. | Ea. | e |

QK I Cancel | Help |

2 Enter anumber of secondsin Default wrap-up for new agents in seconds.
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To set default agent permissions

Click the Agents\ Permission tab in the Queue dial og.

%] Untitled - Queue

1

Category Agents \ Permizsions

- Queue
- Skils
EI--Agents

- Distribution
- Redirection
#-Hald

- Yoice Mail
- Caller Entry

-

- Sacurity
- Audio

- Recording
[#- Statistics

- Dial-by-name Directory

another agent

Coach an agent Dizallow

Monitor Agent calls Dizallow

Monitor Queue statistics Disallow

Queue Sign In/Out Disallow

Sign In/0ut other agents Dizallow

Wiew agents being monitored Dizallow

Access Queue call log Mo access

Access Queue call monitor Mo access

Access Queue mailbox “igw and Edit

QK I Cancel | Help

To set adefault permission, click the value column in itsrow in the list, then select the

permission level you want from the drop-down list. For a description of the permissions
and permission levels, see “ Agent permissions’ on page 3-9.

Click OK to save the queue.
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Adding primary agents to a queue

To add primary agents to a queue
1 Click the Agentstab in the Queue dialog.

2 Click Add. The Agent dialog opens at the General tab.
pgent

General | Permissionsl Skills I

This agent is the follawing user: -
Wrap up time in seconds: I‘I 5
Owerflow tier: ID

[~ This agent iz an observer, not shown in Queus Monitor

[¥ This agent is signed in

[~ Automatically record this agent's calls

Becord 1 call out of eveny: |5

Fiecarding direction: JInbound and outbound

Send agent call recordings to: Ithis Agent

Ll L]

‘wihen mailbos is full: IDeIete oldest call recording

QK I Cancel | Help |

3 For This agent is the following user, select auser from the drop-down list. Agents must be
Wave users before you can add them to a queue. For Wrap up time in seconds, accept the
default or enter adifferent wrap-up time.

Agents can terminate their wrap-up period early and make themselves ready to receive
cals.

4 For overflow tier, leave the default value of 0 unless you want the agent to be an overflow
agent. See “ Setting up overflow agents’ on page 3-14.
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5 For This agent is an observer, not shown in Queue Monitor, check to make this agent an

observer who can monitor queue activity without being seen by other agentsin the queue. If
checked:

» Other agents cannot see the agent in ViewPoint in the Agents pane in the Queue
Monitor (see “Viewing queue statistics in the Queue Monitor folder” on page 9-3) or
the queue’s tab in the Extensions list.

» Theagent is automatically signed out and cannot sign in, so that the agent does not
receive calls from the queue (see the next step).

e The agent cannot be given the permission Queue Sign In/Out.

The observer agent can view queue activity in the Queue Monitor and Call Monitor,
supervise other agents' calls and perform other supervisory actions. The observer agent can
also take queue calls manually by using the Take Call command in the Call Monitor.

If the checkbox is cleared, the agent appears in the Agents pane in the Queue Monitor, and
can be signedin or out.

For This agent is signed in, select the check box if the agent receives calls from the queue
when the agent is ready. Clear the check box to define a supervisor who can monitor the queue
but does not receive calls from the queue.

When the check box is cleared, calls from this queue are not sent to the agent, even when
the agent is ready. However, the agent still seesthe tab for this queue in the Call Monitor
and can answer gqueue calls using the Take Call command.

Note: To receive calls from a queue, an agent must be both signed in, available for queue
cals, and ready. See “How and when does an agent receive a queue call?’ on page 1-2.

You can use this check box to switch an agent from one queue to another, by signing the
agent in for one queue and out for the other queue.

You can also give agents the permission to sign themselves in and out of a queue. See
“Agent permissions’ on page 3-9 and “ Signing in and out of aqueue” on page 10-5.
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1 To change the agent’s permissions from the queue’ s default permissions, click the Permissions

tab.

Change the Persar another agent

Jain anather agent's call
Coach an agent

Monitor Agent calls

Monitor Queue statistics
Queue Sign In/Out

Sign In/0ut other agents
Wiew agents being monitored
Access Queue call log
Access Queue call monitor
Access Queue mailbox

Walue

Use default | i14)
Usze default [Dizallow)]
Usze default [Dizallow)]
Usze default [Dizallow)]

Usze default [Dizallow)]

Usze default [Dizallow)]

Usze default [Dizallow)]

Usze default [Dizallow)]

Usze default [Mo access)
Usze default [Mo access)
Usze default [View and Edit)

0K

| Cancel | Help |

8 Click the permission, click the arrow in the Value column, and then select avalue for the
permission. If you choose “Use Default,” the value for this user will change whenever you
change the default permission for the queue (see “ Changing wrap-up time and permission
defaults’ on page 2-13). For an explanation of permissions, see “ Agent permissions’ on

page 2-18

Note: You do not need to use the Skills tab unless you are using skills-based routing,

described in Chapter 7.

9 To set automatic call recording for this agent, check Automatically record this agent’s
calls. Seethe next section, “ Automatically recording an agent’s calls’ for details.

10 When you have finished defining the agent, click OK. The Agent dialog closes and you return to
the Agents tab in the Queue dialog.
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Automatically recording an agent’s calls

You can have Wave automatically record an agent’s queue calls on a periodic basis. The
recorded calls appear as new voice messages in the voice mailbox that you select. The system
records both inbound and outbound queue calls.

If you want to record all user calls, use system call recording instead.
Privacy issues with queue call recording

Caution: /t is the license-holder’s responsibility to comply with any federal, state, or
other applicable statutes regarding the recording of phone calls. Vertical
Communications, Inc. disclaims any responsibility for failing to comply with such
regulations.

Some countries, states, or other locations require that you announce to callers that their calls
may be or are being recorded.

» If you are using Wave in such alocation and record some or al calls, your queue's
Welcome prompt should inform callers that their calls may be recorded. See “Using the
Welcome prompt to inform callersthat their calls may be recorded” on page 2-11.

*  Waveincludes a system prompt, MayBeM onitored.wav, that says, “Your call may be
monitored or recorded,” which you can play as needed (for example, by using an auto
attendant or Contact Center queue greeting).

*  Wave allowsyou to play aregular “reminder beep” while recording queue calls which
alerts agents and callers that their calls are being recorded.

Important: Be surethat all Contact Center queue understand how to comply with call recording
privacy requirements.

To automatically record an agent’s inbound queue calls

1 Click the Agentstab in the Queue dialog.

2 Click the General tab in the Agent dialog.

Wave Contact Center Administrator Guide
Wave 5.0 July 2016



Adding primary agents to a queue 3-8
Chapter 3: Adding Agents to a Queue

3 Check Automatically record this agent’s calls.

General | Permissionsl Skills I

This agent is the following user: Iaaa bbb j
Wrap up time in seconds: I‘I 5
Owerflow tier: ID

[~ This agent iz an observer, not shown in Queus Monitor

[¥ This agent is signed in

[+ Automatically record this agent's calls

Becord 1 call out of every: |5

Recarding direction: | Inbound and outbound

Send agent call recordings to: Ithis Agent

K1 {ENJEY

when mailbox is full: IDeIete aldest call recording

QK I Cancel | Help |

4 InRecord 1 call out of every, enter anumber. Enter 1 to record every call to thisagent, 2 to
record every other call, 3 to record every third call, and so on.

Note: All callsthat an agent handles count for purposes of counting that agent’s calls.

5 From the Recording direction drop-down list, select whether to record inbound calls only,
outbound calls only, or both. Selecting both means that you get one recording per n calls
regardless of the calls' direction.

6 From the Send agent call recordings to drop-down list, select the mailbox that will receive
the call recordings as new voice messages.

1 FromtheWhen mailbox is full drop-down list, select what happensif the destination mailbox is
full when Wave attempts to store a new call recording there:
» Discard new call recording. Wave deletes the new call recording instead of storing it.

e Delete oldest call recording. Wave deletes the oldest call recording in the mailbox to
make room for the new recording. Only call recordings can be deleted by this method.
Wave never deletes voice messages in this way.

8 Click OK. The Agent dialog closes.

Note: You can also record a general sampling of calls to the queue, regardless of which agent
answers them. See “ Automatically recording queue calls’ on page 6-6.
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Agent permissions

You can give agents the following permissions:

Permission Description Default value

Disconnect queue callback call The agent can disconnect a queue callback  Disallow
cal in the Call Monitor. See “Disconnect-
ing a queue callback call” on page 5-17.

Change the Per sonal The agent can manage other agents' work-  Disallow
Satus of another user flow by changing their personal status. See
“Changing an agent’s personal status’ on
page 9-24.

If agents are prevented from changing their
own personal status, you must create a
supervisor with this permission to manage
their workflow is. See “Preventing agents
from changing their personal status’ on
page 3-11.

Join another agent’s call The agent can enter another agent’s call, Disallow
such that all partiesin the call hear each
other. See " Supervising other agents' calls’
on page 9-18.

Coach an agent The agent can enter another agent’scall and Disallow
be heard by the coached agent but not by
the caller. See “ Supervising other agents
calls’ on page 9-18.

Monitor Agent calls The agent can listen in on other agents’ Disallow
calls without being heard by the monitored
agent or the callers. See “ Supervising other
agents’ calls’ on page 9-18.

Monitor Queue statistics The agent can view real-time queue statiss  Disallow
ticsin ViewPoint's Queue Monitor folder
or listen to statistics using the phone com-
mand *55. See “Monitoring queue statis-
tics’ on page 9-2.

Wave Contact Center Administrator Guide
Wave 5.0 July 2016



Adding primary agents to a queue 3-10

Chapter 3: Adding Agents to a Queue

Queue Sign In/Out The agent can sign in or out of individual Disallow
gueues. See “Signing in and out of a
queue” on page 10-5.

Note: If an agent has the general Wave per-
mission Access Queuesfolder set to
“View and Edit,” and is not an observer
agent, the agent can sign in and out of all
queues regardless of how this queue per-

mission is set.
Sign In/Out other agents The agent can sign other agentsinand out  Disallow
of queues from the Queue Monitor.
View agents being The agent can see when agents’ calls— Disallow
monitored including their own—are being monitored.

With this permission, agents whose calls
are being monitored display in the Call
Monitor with the monitoring party attached
as an indented line. See “Viewing when
agents are being monitored” on page 9-20.

Access Queuecall log The agent can view arecord of callstothe  No access
gueue. With “View and Edit,” the agent can
perform al actionsin the folder.

Access Queue call monitor The agent can see queue callson atab in No access
ViewPoint's Call Monitor folder. With
“View and Edit,” the agent can perform all
actionsin the folder. See “Using the Call
Monitor tabs’ on page 10-8.

Access Queue mailbox The agent can view and play voice mes- View and Edit
sages in the queue’s voice mailbox. With
“View and Edit,” the agent can perform all
actionsin the folder. See “Managing queue
Vvoice messages on the phone” on page
9-25.
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Permissions are granted to Contact Center agents using the following levels:

* Use default. The agent’s permission level iswhatever the default is for that permission.
The current default is shown in parentheses. If the default changes, the agent’s permission
changes with it. See “ Setting default wrap-up time and permissions for agents” on page
3-2.

* Allow. The agent can perform the specified operation.
* Disallow. The agent cannot perform the specified operation.
* No access. The agent cannot view this part of the ViewPoint interface.

» View only. The agent can view the information in ViewPoint, but cannot perform any
commands on an item. For example, if Access queue call monitor iS set to View only, the
agent can see queue calls but cannot answer or transfer them.

* View and Edit. The agent can view the information and perform all commands.

Preventing agents from changing their personal status

By default, Wave allows agents (and all users) to change their own personal status. If you want,
you can prevent agents from changing their personal status by setting their user permission

Change Personal Status to Disallow. When on duty, such agents are unable to select a personal
status to stop receiving queue calls, for example Do Not Disturb or On Break. Supervisors can
still change the agents’ personal status to start and end their workday and let them take breaks.

About the Skills tab

The Skillstab inthe Agent dialog isused only if you are using skills-based routing. See Chapter
7.
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Changing the order of agents

Once you have added primary agentsto aqueue, you can reorder them. If you are using thetop
down or round robin algorithmsto distribute calls to agents, the order of agentsin the queueis
especially important, because it determines the order in which agents receive calls.

The order of agents can a so be important when using other distribution algorithms. For
example, if you are using the fewest calls algorithm, and three agents are tied for the fewest
calls, the topmost of those agentsin the order gets the next call. Note that at the end of a shift
all statistics are reset to zero, so al agents aretied in statistical categories, and agent order
briefly becomes the method of distributing calls, until new statistics are accumul ated.

For adescription of the distribution algorithms, see “ Queue call distribution methods’ on page
4-1.

To change the order of agents in a queue
1 Click the Agentstab in the Queue dialog.

E51MT Queue - Queue

Category

- Hueue Default wrap up for new agents in seconds: |1 5

EIM [~ If an agent does nat answer, set that agent to On Break

i Permissions |2—

L After how many unanswered calls:
- Distribution

- Redirection
#-Hald

- Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

|Agent Overflow Tier ~ |

Mike Amodio 0 - |
Eric Kaczoronic 1]

add. |

o]

Edi. | Delte |

Cancel | Help |

2 Click an agent name, and click the up and down arrows to move the agent to a different

place in the queue.

3 Click OK to save the queue.
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Using remote agents

If you have Contact Center agents who work primarily at a remote phone (for example, from
their home or cell phone, or from a SIP phone), you should assign each of them a mobile
extension. If they mostly work on ainternal office station but occasionally work from home,
you should assign them an internal station but make sure they usethe “Imitate astation” feature
and turn on call forwarding while working at home.

Using roaming agents, or hot-desking

If your Contact Center agents frequently move from desk to desk, or take calls at whatever
internal phone happensto be nearest, you can set up your Contact Center to ensure the accuracy
of statistics and reports, as follows:

» Giveal agentsastation ID of 0.

» For each desk, create a placeholder user with the station 1D of the desk’s phone. Name the
user after the desk, for example, “Cube 101" or “Desk 5.”

» Tell agentsto add the following stepsto their routine for beginning and ending their
shifts. Following these steps ensures that Wave correctly displays and reports on agent
activity no matter what phones they use.

*  When agents first sit down at a new phone to receive calls, before they mark
themselves as ready, they should log in and forward their calls to their current
location. They can use either of the following methods:

e To use the phone commands, pick up the phone and log in by pressing #
<extension> # <password> #. Once logged in, press 5 1 to forward callsto
their current location.

e Touse ViewPoaint, start ViewPoint. The Select Station dialog appears. Select
the second login option, Use station <x> to place and answer calls as <name>.
Check Forward my calls to this station.

*  When agents are finished using a phone, log out from it. This ensures that
subsequent calls from that phone are not added to the agent’s record. To log out
from a phone, either pick up the phone and press *0 0, or choose the ViewPoint
command File > Exit and Log Off.

For more information, see “Working at different phones’ on page 10-4.
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Setting up overflow agents

Overflow agents receive calls from a queue only if the queue's primary agents are al busy for
a certain number of minutes. Overflow agents can be users whose main focus is another task,
but who are available to take queue calls if needed. You can set up multiple tiers of overflow
agents, so that tier 1 agents receive calls only when all primary agents are busy, tier 2 agents
receive calls only when all primary agents and tier 1 agents are busy, and so on.

Calls are distributed among each tier of overflow agents according to the queue’s distribution
algorithm. For example, if the algorithm is Top Down, the call rings the topmost ready primary
agent. If al primary agents are busy, the call rings the topmost ready tier 1 agent. If all primary
and tier 1 agents are busy, the call rings the topmost ready tier 2 agent, and so on.

Note: With the Simultaneous Ring algorithm, if the overflow wait time has been exceeded, the
phones of all primary and overflow agents ring regardless of overflow level.

Setting up overflow agents consists of the following tasks:
» Assigning an overflow tier to agents, as described in the next section.

» Setting up the overflow wait time and options for the queue, as described on page 3-16.
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Assigning an overflow tier to agents

To assign an overflow tier to agents

1 First, add the overflow agents to the queue the same way that you add normal agents (see
“Adding primary agentsto aqueue”’ on page 3-4).

2 Onthe Agentstab in the Queue dialog, click the Overflow tier value for the agent, and then
enter the agent’stier level.

£51MT Queue - Queue

Catogory e

-- Queue Default wrap up for new agents in seconds: |1 5

EM [~ If an agent does nat answer, set that agent to On Break

F.'E[I'I?ISSIDnS After how many unanswered calls: |2
- Distribution

£
[#- Redirection
£
£

Overflow Tier

- Hold
£-Yoice Mail
- Caller Entry 1] Ll
- Dial-by-name Directory Eric K.aczoronic 1]

- Sacurity
- Audio

- Recording
[#- Statistics

add. | Edt. | Deete |

QK I Cancel | Help |

Note: Tier O identifies a primary agent. You do not have to number overflow tier levels
sequentially—only the order isimportant. For example, you could have overflow tier levels 1,
5, 6, and 10. See the Note on page 3-17 for more about how you can use overflow tier valuesto
control when calls are sent to overflow tiers.
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Setting up the overflow wait time and options

Before you can use overflow agents, you must configure the queue according to the following
steps:

To set up overflow wait time and options for a queue

1 Click the Distribution \ Agent Filtering (Overflow) tab in the Queue dialog.

2 Select the Certain agents are only called when other agents are busy checkbox.

%] Untitled - Queue

Category Distribution % Agent Filtering [Dverflow]
- Queue |w iCertain agents are only called when other agents are busiyt
- Skillz
[ Agents Callz are distributed to overflow agent tiers after waiting IBDD seconds
=1 Distributi . . . . . . ’
& ;IS'; v |0ns . r If no agents in the current tier are signed in and available then immediately
Agent Searing offer calls to the next tier

-Call Scoring

-Agent Filtering (Skills) {* Calls should wait a fixed amount of time for any available overflow agent
-Agent Filkering [Dverflow)
-Expected Wait Time = Calls should wait longer for agents in higher tiers

i Last Agent Routing
- Redirection

[+ Hold

[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

QK I Cancel | Help |

Note: If this checkbox is not selected, overflow tiers are ignored and all agents are treated
as primary agents.

3 Set any of the following overflow options:

» Calls are distributed to overflow agent tiers after waiting __ seconds. Thisfield
determines how long (in seconds) calls wait for a primary agent before being sent to
an overflow agent. B default a call must wait for 5 minutes (300 seconds) without
being answered by a primary agent before it is sent to an overflow agent.

You use the Calls should wait... options (described below) to specify how the wait
timeis applied to different overflow tiers.
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If no agents in the current tier are signed in and available then immediately offer calls
to the next tier. If checked, the queue bypasses the overflow wait time if no primary
agents are signed in and available, and calls are sent immediately to overflow agents.
Note that in this case, a primary agent in On Break status is considered to be
available. For the bypass to occur, primary agents must all be either signed out or
signed in with a personal status other Available, Available (Queue Only), or On
Break.

The bypass a so occurs between overflow tiers. For example, if al primary and tier 1
agents are signed out, calls are immediately sent to tier 2 agents. If all primary, tier 1,
and tier 2 agents are signed out, calls are immediately sent to tier 3 agents.

If this checkbox is not selected, the wait time will be used in all cases, even when a
tier issigned out. For example, in the changeover between shifts there might be a
moment when all primary agents are signed out, but you might still want calls to wait
rather than ringing overflow agent phones.

Calls should wait... This choice determines whether the overflow wait timeis applied
once, or applied differently for each overflow tier. Choose one of the following:

* Calls should wait a fixed amount of time for any available agent. Select this option
to apply the overflow wait time only once. If no primary agents answer during the
wait time, the call is sent to the lowest-tier ready overflow agent, regardless of
what tier that might be. For example, if al tier 1 agents are On Break when the
overflow wait time expires, the call is sent to atier 2 agent.

* Calls should wait longer for agents with higher skill values. Select this option to
have calls wait longer before being sent to higher overflow tiers. With this option
selected, the wait time is multiplied by the tier level to determine how long a call
must wait before being sent to that tier. For example, if thewait timeis 5 minutes,
acall must wait 5 minutes before being sent to tier 1, 10 minutes before being sent
to tier 2, 15 minutes before being sent to tier 3, and so on.

Note: By changing the overflow tier value, you canincreasethewait timefor atier,
allowing you to fine-tune when an overflow tier will be pulled into queue activity.
For example, if you define three overflow tierswith tier values of 1, 2, and 3, then
thewait timesfor the tierswould be 5 minutes, 10 minutes, and 15 minutes. If you
define three overflow tierswith tier values of 1, 3, and 10, then the wait times for
the tiers would be 5 minutes, 15 minutes, and 50 minutes.

4 Click oK.
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This chapter describes the ways in which you can distribute incoming queue calls to agents.

Queue call distribution methods

You can use any of the following methods to distribute incoming queue calls to agents:

Top down. The call moves through the list of agents—from the top of thelist
downward—until it reaches aready agent. For this algorithm, the order of agentsin the
gueue isimportant. (See “Changing the order of agents’ on page 3-12.)

Round robin. Agents receive calls in the same sequence as with Top Down, but starting
with a different agent each time. Each call starts with the agent after the one who
answered the previous call.

Longest idle agent. The ready agent who has waited the longest time for acall receives
the next call. This algorithm is calculated by determining which agent has gone the
longest period of time without being in an Active state. Non-queue calls count as being
“idle,” because they put an agent in the Standby state. (See the Agent State column under
“ Agents Pane Information” on page 9-4.)

Fewest calls. The ready agent who has answered the fewest calls from this queue since
beginning the agent’s work shift receives the next call.
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* Least talk time. The ready agent who has spent the least amount of time on calls from this
gueue since beginning the agent’s work shift receives the next call. This agent may be
someone other than the agent who has handled the fewest calls.

* Simultaneous ring. All agents’ phonesring at the sametime. The agent who answers first
takesthe call. Thisfeature is especialy useful for small offices or departments.

* Skills-based or custom routing. This option lets you construct your own distribution
algorithm, using agent skills and other attributes. It is more complex to set up, but can be more
flexible.

Note: No matter what method you specify, calls are distributed only to agents who are both
signed in and ready. (See “How and when does an agent receive aqueue call?’ on page 1-2 and
“Starting your shift” on page 10-2.)

To specify how queue calls are distributed to agents
1 Click the Distribution \ Agent Scoring tab in the Queue dial og.

%] Untitled - Queue

[#- Queue Agent zcoring algarithm: ITop down j
- Skills
[+-&Agents

=- Distribution
t Scoring:

- Call Scoring

- Agent Filtering [Skillz)
- Agent Filtering [Overflow]
- Ewpected Wait Time
i Last Agent Routing
- Redirection

[+ Hold

[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

QK I Cancel Help
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2 Fromthe Agent scoring algorithm drop-down list, select one of the following methods. For a
description of each method, see page 4-1.

If you select any of the following methods, no further configuration is required here—go to
step 4.

* Top down.

* Round robin.

* Simultaneous ring.

If you select any of the following methods, go to step 3.
* Longest idle agent.
* Fewest calls.
* Least talk time.

* Skills-based or custom routing.

3 Choose the following options under Distribution calculations are based on...

* Time period. Choose whether to distribute calls based on totals for the current Shift or
the current Day (since midnight). For more information about shifts, see “ Collecting
gueue statistics” on page 6-9.

» Direction. Choose whether the algorithm counts Inbound only calls, or both Inbound
and Outbound calls.

4 Click OK to save the queue.

Call distribution when the score is tied

When two or more agentstiefor the same score (for example, with the” Fewest calls’ algorithm,
three agents have 0 calls each), the call aways goes to the longest idle of the tied agents.
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About simultaneous ring

Simultaneous ring does not ring the phones of overflow agents unless the overflow wait time
has been exceeded. At that point it rings the phones of all agents. See “Using and improving
expected wait time for callers’ on page 6-1.

When an agent answers a call with simultaneous ring, it does not count as an unanswered call
for the other agents, for purposes of putting the agent automatically in On Break status.
However, if all agentsfail to answer the call whileit isringing, it counts as an unanswered call
for al of them. See “Placing agents on break if they do not answer calls’ on page 4-6.

About the longest idle agent

Theal gorithm treats newly logged in agents as being idl e since the beginning of the day or shift.
This may result in those agents receiving calls ahead of agents who have been idle longer.

Using Last Agent Routing

With Last Agent Routing, callers are routed straight to the agent who last handled their call, as
long as:

» Thecaleriscalling from the same Caller ID as before.

» Theagentissigned in and available. If the agent is signed in but unavailable, you can
have the call wait a specified amount of time for him or her. If the wait time expires with
the agent till unavailable, or if the agent has signed out, the call is routed according to
the queue’s normal distribution algorithm.

» The agent has remained signed in since the caller’s previous call. Once an agent signs
out, his or her history of previous calsisreset.

Note: Last Agent Routing overrides skill requirements and overflow levels. For example, if a
tier 3 overflow agent took acaller’sfirst call, he or shewill receive the caller’ssecond call even
if primary agents are available.
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To enable Last Agent Routing:

1 Click the Distribution \ Last Agent Routing tab in the Queue dialog.

%] Untitled - Queue

Distribution % Last Agent Routing
- Hueue [~ Enable Last Agent Routing
- Skillz
[ Agerts I~ Interupt if last caller calls back during wiap up
& D;-Ift.;‘;:r:?gcoring [ it IBD seconds for last agent if agent is busy
- Call Scoring

- fgent Filkering [Skillz]

- fgent Filkering [Overflow)
- Enpected Wait Time
Agent Fouting

- Redirection

[+ Hold

[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

o]

Cancel

Help

2 Check Enable Last Agent Routing.

3 Choose any of the following Last Agent Routing options:

* Interrupt if last caller calls back during wrap-up. If checked, the queue interrupts an
agent’swrap-up period only if the caller he or sheiswrapping up calls back.

e Wait __ seconds for last agent if agent is busy. This checkbox determines what
happens if the last agent is signed in but unavailable (for example, on another call)
when the caller calls back. If unchecked, the call isimmediately routed according to
the queue’ s distribution algorithm as selected in “Queue call distribution methods” on

page 4-1.

If checked, the caller waits for the number of seconds you enter. If the agent becomes
available during that time, the call is routed is routed to the agent. If the wait times
expires without the agent becoming available, the call isthen routed according to the

gueue’s normal distribution algorithm.
4 Click OK.
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Last Agent Routing and Expected Wait Time

With Last Agent Routing enabled, the queue's Expected Wait Time prompt will often be
inaccurate (see“ Using and improving expected wait timefor callers’ on page 6-1). A caller who
iswaiting for alast agent will jump to the “head of the queue” if that agent becomes available,
making other callers wait longer than advertised by the prompt. For that reason, queues with
Last Agent Routing enabled should avoid using the Expected Wait Time prompt.

Placing agents on break if they do not answer calls

You can have Wave automatically place agentsin the On Break personal statusif they fail to
answer one or more consecutive queue calls. Placing amissing agent On Break ensures that the
gueue does not send calls to that agent and provides the caller with a smoother waiting
experience. Thisfeature is a safeguard against agents leaving their phones and forgetting to
place themselves in the On Break personal status.

To automatically place missing agents on break

1 Click the Agentstab in the Queue dialog.

%] Untitled - Queue

Category e

- Hueue Default wrap up for new agents in seconds: |1 5

EIM [~ If an agent does nat answer, set that agent to On Break
- Permissions |2—

- Distribution

- Redirection

#-Hald

After how many unanzwered calls:

Agent

- Yoice Mail

| Ovwerflow Tier | |

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

Edi. |

Fs
v

hd

Delete |

Cancel |

Help
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2 Check If an agent does not answer, set that agent to On Break.

3 InAfter how many unanswered calls, enter the number of consecutive unanswered queue
calls that must occur for Wave to automatically place an agent in the On Break personal
status.

4 Click OK to save the queue.

You can keep track of how often the queue automatically puts agentsinto On Break status, using
the Queue Monitor statistics Away, No Answer, and Forced Break. See “ The Agents pane” on
page 9-4.

Note: Supervisors can also manually place agentsin the On Break personal status or in any
other personal status. See “Changing an agent’s personal status’ on page 9-24.

Using call scores to distribute calls to agents

When several calls are waiting in the queue, the queue scores each call to determine the order
inwhich they will be sent to agents. The call with the highest scoreisthe next one sent when an
agent becomes available.

Defining how calls are scored

By default, acall’sscoreisthe number of secondsit hasbeen waiting inthe queue. The call with
the highest score is the one that has been waiting the longest and will be the next one sent to an
agent. However, you can manipulate call scoring to give certain calls a higher score, bumping
them closer to the front of the queue so that they will be answered sooner.

Choosing by how much to increase a call’'s score

A call’s scoreis based on itswait time in seconds, so it's helpful to think in terms of seconds
when deciding by how much to increase acall’s score. For example, if you want ahigh-priority
call to jump ahead of acall that has been waiting for a minute, you would want to add 60 to its
score. To have it jump ahead of acall that has been waiting 5 minutes, you would want to add
300.
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You can increase a call’s score using the following methods:

» Basing acall’s score on the length of time that the call has spent in queue or time in the
Wave system. See page 4-8
» Giving some calls higher priority. See page 4-9.

* Increasing acall's score for skill matches. See page 4-12.

Basing a call’'s score on time in queue or time in system

You can choose whether acall’s score is based on the length of time (in seconds) it has spent in
that queue or in the Wave system as awhole. If based on time in queue, then acall transferred
between queues starts waiting in the new queue with a score of 0. You may want to base call
score on time in system if calls are often moved from queue to queue, or are returned to the
gueue after talking to an agent or leaving voicemail.

To base a call’s score on time in queue or time in system

1 Click the Distribution \ Call Scoring tab in the Queue dial og.

%] Untitled - Queue

Distribution % Call Scoring

GQueue A call's score iz bazed or:

* Time in this queue, in seconds

L Permissions = Time in the spstem, in seconds
[=- Distributian

Agert Scoring [~ Certain calls have a higher priority than other calls
ng; .
Agent Filtering (Skills) Priarity iz stared in custom wariable: |< no variables > j ;?I
Agent Filkering [Overflow)
Expected Wait Time Far each unit of the variable's value add ID ta the call's score
----- Last Agent Routing
[#- Redirection For all zkills required by the call:
[#-Haold - ;
- Voice Mai [~ Add the agent's average proficiency times Is ta the call's score
- Caller Entry
- Dial-by-name Directory
- Sacurity
- Audio
- Recording
[#- Statistics

QK I Cancel Help

2 Click Time in this queue, in seconds Or Time in the system, in seconds.
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Giving some calls higher priority

You can give some queue callsahigher priority than other queuecalls. Callswith higher priority
get ahigher call score and advance to the head of the queue quicker than other calls.

To assign priority to calls, perform the following tasks:

1 Define acustom data variable to use for call priority (the “priority variable”), and set a
“priority multiple” that determines the weight priority carriesin the call score. See
“Configuring aqueue to use call priority” on page 4-10.

2 ldentify high-priority calls when they enter the queue and assign priority appropriately
using the priority variable, as described in “Assigning priority to calls’ on page 4-12.

Thevalue of acall’s priority variableis multiplied by the priority multiple and the result is added to
the call’ s score. The higher the priority multiple, the greater the effect of a high priority number. For
example, if the priority multipleis 60, each unit of priority isworth aminute, so acall with priority
5isequal to 5 minutes of wait time. If the priority multiple is 480, each unit of priority isworth 8
minutes, so acall with priority 5 is equal to 40 minutes of wait time.

Examples

The following tablesillustrate how priority changes the order in which calls are answered.

Priority Multiple = 120 (Each unit of priority = 120 secondsor 2 minutes)

First 900 0 0 900 Second
Second 600 0 0 600 Fourth
Third 300 5 600 900 Third

Fourth 60 2 240 300 Fifth

Fifth 30 10 1200 1230 First

Sixth 10 1 120 130 Sixth
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Priority Multiple = 500 (Each unit of priority = 500 seconds or 8 minutes 20 seconds

First 900 0 0 900 Fourth
Second 600 0 0 600 Fifth
Third 300 5 2500 2800 Second
Fourth 60 2 1000 1060 Third
Fifth 30 10 5000 5030 First
Sixth 10 1 500 510 Sixth

Note: Redirection overridescaller priority. If the queueis currently redirecting callers based on
the criteriayou defined, calls are redirected no matter how high their priority would have been.

(See “Redirecting calls’ on page 2-17.)

Configuring a queue to use call priority

To configure aqueue for cal priority, you must specify the custom data variable to use for

priority (or create a new one) and specify the priority multiple.
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To configure a queue to use call priority
Click the Distribution \ Call Scoring tab in the Queue dialog.

%] Untitled - Queue

1

Category Distribution % Call Scoring
- Hueue A call's score iz bazed or:

* Time in this queue, in seconds

- Permissions = Time in the spstem, in seconds
- Diigribution

~Agent Scoring [~ Certain calls have a higher priority than other calls
- Agent Filtering [Skills) Friority iz stored in custom variable: |< ho variables > j ;?I
- Agent Filtering [Overflow]
- Expected Wai Time Far each unit of the variable's value add ID ta the call's score
i Last Agent Routing
[#- Redirection For all zkills required by the call:
[+ Hold - ;
- Voice Mai [~ Add the agent's average proficiency times Is ta the call's score
- Caller Entry
- Dial-by-name Directory
- Sacurity
- Audio
- Recording
[#- Statistics

QK I Cancel | Help |

Select the Certain calls have a higher priority than other calls checkbox.
Under Priority is stored in custom variable, specify the queue’s priority variable by doing
one of the following:
» Select an existing custom data variable from the drop-down list.
« Click 2 to create anew custom data variable. For instructions see “ Creati ng a
custom data variable” on page 6-13.

The custom variable that you specify must be a variable of Data Type Long and must have
aDefault value of 0.

In For each unit of the variable’s value add __to the call’s score, enter the priority
multiple. This number ismultiplied by the value of acall’s priority variable to determine by
how much the call’s score is increased.

Click OK to save the queue.
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Assigning priority to calls

You assign priority to anincoming call by assigning avalueto the custom data variable that you
selected in the previous procedure. You can assign value to the variable using any of the
following methods:

* With an auto attendant. Callers receive priority based on the phone number that they dial
or menu choice they select. You could have a special phone number that you give out to
your premier customers that gives them a high priority when they call that number.

You can aso use the Call Classifier as part of auto attendant configuration to benefit
Contact Centersin many ways. For example, you can automatically assign priority to calls
based on issue number, Caller ID, or caller identification against your company database.

* With queue data entry. The queue can assign priority directly from a number that the
caller enters (for example, you could give out customer numbers that range from 1 to 10
and have the queue prompt callers to enter them). See “ Setting up caller dataentry” on
page 5-2 for more information.

Increasing a call’s score for skill matches

If you are using skill-based routing, you can increase a call’s score based on the available
agents' appropriate skills. See“Reducing wait timefor callswith skill requirement matches’ on
page 7-17.
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You can customize a queue to provide additional featuresto your callers while they are waiting
for an agent to answer their call or if an agent parkstheir call or putsit on hold:

» Prompt acaller to enter a customer 1D or account number when they enter a queue, then
use that information to customize subsequent prompts.

Note: If you need more sophisticated validation or dataentry options, use the Wave Call
Classifier, which can prompt callersfor any numeric information, validate it based on any
ODBC database, then send the resulting profile information to the agent along with the
cal.

» Provide queue-specific music on hold, or play another recording such as special offers.
» Announce the expected wait time as a courtesy to calers.

» Offer calersthe option to opt out of waiting and transfer to another number, leave a
message in the queue’s voice mailbox, or request a callback when an agent is available.
(Depending on how you configure callback for aqueue, you can ensure follow-up for any
callbacks that are not completed.)

Reducing the length of hold time for individual callers aswell as the simultaneous number of
callers on hold can enhance the customer experience, improve hold time statistics, and
potentially reduce the number of trunks or agents required to handle the same number of
customers with the same or better level of customer satisfaction.
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Setting up caller data entry

You can set up the queue to prompt callersto enter data by using the keys on their phones. Data
entry prompts play immediately after the Welcome prompt. You can, for example, prompt
callersto enter their customer ID numbers. The data entered is stored in a custom data variable
that you define. The dataaccompaniesthecall (if it istransferred, for example), and you can use
the datain the following ways:

» Asacondition for aHold prompt to play. See “Using custom data variables to play
conditional Hold prompts’ on page 5-15.

e Asacolumn displayed in agent Call Monitors.
You can create as many caller data entry prompts as you want. They play in the order that they

arelisted on the Caller Entry tab in the Queue dialog. To move adata entry prompt up or down
inthelist, select it and then click the Up and Down arrows to the right of thelist.

- Queue Mame :l
sk T ———
[ Agents Azcount Mumber Ll
[ Diigtribution Order Murmber
[#- Redirection
[+~ Hald
[-Yoice Mail
- Caller Entry
- Dial-by-name Directory
- Security
- Audio
- Recording
[#- Statistics

Edi. | Delte |

QK | Cancel | Help |
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To prompt the caller to enter data

1 Click the Caller Entry tab in the Queue dialog.

%] Untitled - Queue

Chapter 5: Customizing the Caller Experience

[#- Queue Name

- Skillz
[+-&Agents

[#- Distribution
- Redirection
[+ Hold
[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

=

QK | Cancel | Help |

2 Click Add. The Queue Entry dialog opens.

Untitled - Queue Entry

Mumber entry | Walidation I

Mame: ||

Frompt that explains the digits to enter:

o || A=
| Fieady to play
[~ Teminate after an exact number of digits: |D
[ The following digit will terminate input: Itt j
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3 Enter aName for the datathat you are collecting, for example Customer ID or Account
Number.

4 Under Prompt that explains the digits to enter, type the text of the prompt or a description
of it.

5 Using the audio controls, record a prompt that tells the caller to enter data, for example,
“Please enter your customer |D number followed by the pound key. If you don’t have a
customer | D number, just pressthe pound key.” See “Using the audio controls’ on page 1-8
for instructions.

Note: While callers are entering data, they can press * and they will return to the previous
dataentry prompt. If callerspress* during thefirst dataentry prompt, they can chooseto end
the call or stay on theline. If they choose to stay on the line, they are transferred either to
the auto attendant (if they started there) or to the queue operator (if they dialed the queue
directly). You can optionally describe these optionsin your data entry prompts.

6 Specify the following optional information about the caller data entry:

e Terminate after an exact number of digits. If the data must be an exact length, check
this box and enter the number of digits.

* The following digit will terminate input. To speed up data entry, check this box and
select akey for callersto presswhen they have finished entering digits. The terminate
key isusualy #. Be sure to mention this key in the prompt that you record. If you do
not specify aterminate key, Wave assumes the data is complete whenever the caller
exceeds the Maximum number of seconds between digits Setting.

e Number of seconds allowed for input. Specify the length of time within which the
caller can enter the data. If the caller does not complete data entry within that time,
Wave attempts to validate the data. If you are not validating the data (see “Validating
caller dataentry” on page 5-5), the call proceeds into the queue without any data.

e Maximum number of seconds between digits. Specify how long callers can pause while
entering digits. If the caller exceeds that pause, Wave assumes that the data entry is
complete.

1 Store digits in custom variable. Select the custom variable to hold the data entered by
callers from the drop-down list. To create a new custom variable, click 2 next to the list.
For instructions see “ Creating a custom data variable” on page 6-13.
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8 Click the Validation tab to set up data validation for this caller data entry. For details, see
the next section.

9 Click OK to return to the Caller Entry tab in the Queue dialog.

10 Click OK to save the queue.

Validating caller data entry

The queue can validate the data or accept it exactly as the caller entersit. When you validate
data, you are checking it for accuracy.

To set up validation for data entry
1 Click the Caller Entry tab in the Queue dialog.

2 Click Add to add a new caller data entry, or select an existing caller data entry and then
click Edit to add validation criteria
3 Click the Validation tab in the Queue Entry dialog.
Number entry Validation |

| Ask the caller to confirm the digits entered

Minimum number of digits: ID
M aximum number of retries: |3

 |v Walidate digits according to range

The minimum value allowed is: |1

The maximum value allowed is: |1 uli}

— After the masimum nurnber of retrie
(+ Continue

(" Hangup

(" Transfer to: IDperator[xU] j

Cancel | Help |
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Select the Ask the caller to confirm the digits entered checkbox to have Wave repeat the
caller's entry back to them and prompt the caller to confirm that the entry is correct. If the
entry isincorrect, the caller can reenter it.

Enter the Minimum number of digits that the caller must enter. If the length of the data that
the caller entersis less than the number specified here, the caller will be prompted to
reenter the data.

Enter the Maximum number of retries, the maximum number tries that the caller hasto
enter the data successfully.

Select the Validate digits according to range checkbox to compare the data entered by the
caller to an acceptable range of vaues, then define the range of values:

e The minimum value allowed is. Enter the minimum acceptable value.

* The maximum value allowed is. Enter the maximum acceptable value.

If the data entered falls within the range, it is validated. If it falls outside the range, the
caller is prompted to enter it again.

Specify how to handle callers whose data does not validate successfully After the maximum
number of retries that you specified previously. Choose one of the following options:

e Continue. Continue with the next data entry prompt. If thisisthe last data entry
prompt, place the caller on the queue without any data associated with the call.

* Hangup. Terminate the call.
* Transfer to. Select the destination to which the caller is transferred.

Click oK to return to the Entry tab in the Queue dialog.

10 Click OK to save the queue.

Note: If you need more validation or data entry options, use the Wave Call Classifier, which
can prompt callersfor any numeric information, validate it based on any ODBC database, then
send the resulting profile information to the agent along with the call.

Wave 5.0

Wave Contact Center Administrator Guide
July 2016



Customizing the caller hold experience 5-7

Chapter 5: Customizing the Caller Experience

Customizing the caller hold experience

You can configure the following aspects of the caller’s experience while he or sheiswaiting on
the queue:

e Setting up hold music. See page 5-7.

e Configuring hold and park ringback. See page 5-9.

» Offering options while a caller is waiting on a queue. See page 5-10.
» Creating Hold prompts. See page 5-11.

Setting up hold music

By default, callers waiting on this queue hear the hold music that you have specified for the
system as awhole. Optionally, you can have each queue play hold music or another recording
from a different music-on-hold source.

To set up hold music for callers on hold
1 Click the Hold tab in the Queue dialog.
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2 Select the Music on hold source you want to use for this queue from the drop-down list.

* (Use system default)y—Use the system-wide hold music source as specified in the
General Settings applet.

» Disabled—Do not play music to callers on hold.
Hint: It is highly recommended that you specify a music-on-hold source or use the

system default so that a caller does not hear extended ringing or silence, which may
result in a hang-up.

» External (Audio Input Jack)—Play hold music from an external device, typically aCD
player, radio, or specialized music-on-hold device.

e Song n (<song title>)—Play the selected WAV file to callers on hold.

Note: The system default music-on-hold source (if specified) as well as the other items
listed in this drop-down list are set up viathe General Settings applet.

3 Click OK to save the queue.
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If an agent places aqueue call on hold or parks it, you can have Wave automatically ring the
agent’s phone after a certain amount of time to reconnect him or her with the call. To do so:

To hold and park ringback for a queue
1 Click the Hold tab in the Queue dial og.

%] Untitled - Queue

[#- Queue

- Skillz

[+-&Agents

[#- Distribution

- Redirection

= R

-Special Keys
-Prompts

- Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

Music on hold: IDisabIed j

[ Ring back if an agent leaves a call on hold or park far aver |45 seconds

QK I Cancel Help

2 Check Ring back if an agent leaves a call on hold or parked for over __seconds, and enter

the number of seconds before ringback occurs.

3 Click OK to save the queue.
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Offering options while a caller is waiting on a queue

You can give waiting callers the ability to redirect themselves out of the queue to another
extension or voicemail.

To offer options while a caller is waiting on a queue
1 Click the Hold \ Special Keystab in the Queue dialog.

%] Untitled - Queue
- Dueue [ Leave voice-mail key: m
- Skillz
- Agents [ Transfer out of queue key: IS 'l
[#- Distribution ; ¥ -
The call will be transfered to: |-, -
- Rediection he cal vill be bansferred to: | ~acoount Receivable [x 5302) =l
=+ Hold F# Hequest callback Key: E =] _Calback Setiings.. |
~Special Keys
‘- Praompts
[#-Yoice Mail
- Caller Entry
- Dial-by-name Directory
- Sacurity
- Audio
- Recording
[#- Statistics
QK | Cancel | Help |

2 Choose any of the following options to offer them to callers on hold.

Note: If you offer callersthese options, you should mention them in your queue's Welcome
prompt or in aHold prompt.

» Leave voice-mail key. Available only if the queue has avoice mailbox (see* Setting up
aqueue’s voice mailbox” on page 5-21). Callers can press akey to stop waiting and
be transferred to the queue’s voice mailbox. Select the key that you want callersto
press from the drop-down list.
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» Transfer out of queue key. Callers can transfer out of the queue to a destination you
specify. This destination can be a supervisor’s voice mailbox, an auto attendant,
another queue, or any other extension. Select the key that you want callersto press
from the drop-down list, and then select the transfer destination from The caller will
be transferred to drop-down list.

» Request callback. Select this checkbox to offer the caller on hold the option to enter a
phone number and receive a callback when an agent is available. See “ Contact center
gueue callback” on page 5-16 for details.

3 Click OK to save the queue.

Creating Hold prompts

You can make one or more recordingsfor callersto hear while waiting, for example, to reassure
them that they are till in the queue. You can choose to have aHold prompt play only once, play
on arepeating basis, or play only when a certain condition has been met. A Hold prompt might
say, “Your call isvery important to us. Please wait for the next available representative.”

Hold prompts are listed on the Hold tab under Hold prompts. They are listed in the order that
they play to callers. While the caller is waiting, Wave plays the Hold prompts from the top to
the bottom of the list—with customizable pauses between them—and then repeats the cycle,
starting at the top again. The cycle of Hold promptsrepeats aslong asthe caller remainswaiting.

You can choose whether a Hold prompt is part of the repeat cycle or whether it is played to the
caller only once. If it is played only once, Wave playsit the first time through the cycle and then
sKips it on subsequent cycles.

For instructions on recording a Wel come prompt, which is played to callers once when they first
enter the queue, see “ Creating a Welcome prompt for a queue” on page 2-10.
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1 Click the Hold \ Prompts tab in the Queue dialog. The tab shows existing Hold promptsin

the order that they play to the caller.

%] Untitled - Queue

- Dueue Mame |W’ait time |F|epeat |E0nditi0n

- Skillz

[+-&Agents

[#- Distribution

- Redirection

[=-Haold

Special Keys

mpks:

[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory

- Sacurity

- Audio

- Recording

[#- Statistics

Delete |

Cancel | Help |

2 Click Add. The Hold Prompt dialog opens.

Hold Prompt

o |
General

Prompt nhare: ||

C—

[~ Play this prompt every repeat cycle

Seconds before this prompt:

— Play thiz audio
* Prompt: ;I
E
ofv]of glg —————
(" Sentence: IQueue length j

[ Use the fallowing condition

Condition variable: IExpected wait tirme

Minirum variable or value: I

b aximum wariable or walue: I

Ll L L
2o le

L

Cancel | Help |
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3 Under General, enter the following information about the Hold prompt:

Prompt name. A descriptive name for the prompt.

Seconds before this prompt. The amount of time between the end of the previous
prompt and the playing of this prompt. If you set thisto O, callerswill not hear hold
music before this prompt, even if it isthe first prompt.

Play this prompt every repeat cycle. Select this checkbox to have this prompt play every
timein the repeat cycle. Deselect it to have the prompt play only once. If deselected, the
prompt will play only thefirst time through the cycle, unlessit isaconditional prompt that
does not play at all because the required condition has not been met.

4 Under Play this audio, choose one of the following options for the Hold prompt recording:

Prompt. Choose this option to record a prompt to play to callers on hold. Record the
Hold prompt using the audio controls. See “Using the audio controls’ on page 1-8 for
instructions. Enter the text of the prompt or adescription in the text field for
reference.

Note: If you are offering special-key optionsin this queue, with the special keysactive
only during prompts, then you should record afew seconds of silence at the end of each
Hold prompt to give callerstimeto pressthe special keysbefore they becomeinactive.
See “Offering options while a caller iswaiting on aqueue’ on page 5-10.

Sentence. Choose this option to play a pre-recorded message to callers on hold.
Select one of the following from the Sentence drop-down list:

* Queue length. Choose this option to play the prerecorded message: “There are
<number> callers waiting ahead of you,” where <number> is the number of
callersthat Wave detects are ahead of acaller inthe queue. If thereisno one ahead
of the caller in the queue, the message changes to: “ Your call will be handled by
the next available agent.”

* Sentence: Wait time. Choose this option to play the prerecorded message: “The
expected wait time is <number> minutes’ where <number> is the number of
minutes that Wave estimates will elapse before the call is answered. For
information on how Wave calculates this number, and how to make it more
accurate, see “Using and improving expected wait time for callers’ on page 6-1.

Note: You can announce the expected wait timein minutesand seconds, instead of just
minutes. See “ Announcing expected wait time in minutes and seconds’ on page 6-5.
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5 Optionally, select or create acondition under which thisHold prompt plays, asdescribed in
“Creating conditional Hold prompts’ on page 5-14.

6 Click oK to add the Hold prompt to the list on the Hold \ Prompts tab.

71 Click OK to save the queue.

Creating conditional Hold prompts

You can create Hold prompts that play only when acertain condition is met. For example, if the
estimated wait time on the queue is 10 minutes or longer, you could play a prompt that says,
“We are currently experiencing aheavy volume of calls. We recommend that you call back later
or leave avoice message.”

Conditional Hold prompts can either repeat in the repeat cycle or play only once. If they repeat,
the condition is checked each time through the cycle. For example, a prompt that played when
the estimated wait time was over 10 minutes would repeat until the wait time dropped below 10
minutes and then stop playing.

To create a conditional Hold prompt

1 OntheHold\ Prompts tab in the Queue dialog, click Add. The Hold prompt dialog opens.

2 Enter the general information and create the audio for the Hold prompt as shown in the
previous section, “Creating Hold prompts’ on page 5-11.

3 Select the Use the following condition checkbox

Wil
Condition variable: IExpected wait tirme: j "_::‘.-’l
Minimum variable or walue: I j '-_::‘_.;l
b aximum wariable ar value: I j '-_::‘_.;l

QK I Cancel | Help |
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4 From the Condition variable drop-down list, select the custom data variable whose value the
system will use to determine if the prompt plays.

Wave comes with two predefined custom data variables that can be used as Hold prompt
conditions:

* Expected Wait Time. Returns the estimated number of seconds until the call is
answered. For information on how Wave cal cul ates this number, and how to make it
more accurate, see “Using and improving expected wait time for callers’ on page 6-1.

* Number of people ahead. Returns the number of waiting callers who entered the
gueue before the current caller.

You can also create your own condition variable by clicking 24 next to the Condition variable
field. See the next section, “Using custom data variables to play conditional Hold prompts.”

5 In Minimum variable or value and Maximum variable or value, enter the minimum and
maximum values that will cause the prompt to play. The prompt playsif the valueis >= the
minimum and <= the maximum.

For example, to play the prompt when the expected wait time is 10 minutes or more, select
Expected wait time and set Minimum variable or value to 600 (600 seconds=10 minutes). If
you are using a custom variable of Account Number (see the examplein the next section),
you could set the prompt to play for callers with a Account Number value within a specific
range.

6 Click OK to savethe queue.

Using custom data variables to play conditional Hold prompts

Whatever variableyou select in the Condition variable field of the Hold prompt dialog isthe one
whose value is used to determine whether the prompt plays. You can create your own custom
data variables and use them to trigger Hold prompts. For instructions on creating a custom data
variable, see “Creating a custom data variable” on page 6-13.

Example: By creating avariable called Account Number, you can play aHold prompt only for
certain customers, such as your newest customers. First, you prompt callersto enter their
account numbers, which you store in the Account Number variable (see“ Setting up caller data
entry” on page 5-2). Then you create a conditional Hold prompt that plays only if Account
Number is within a certain range. A range of 1000 to 2000 might represent your newest
customers, and you could specify that range for your Hold prompt, which would play only for
your newest customers.
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Note: Text variables are sorted alphabetically and so can have a“range,” for example A-E. A
range of A-E meansthat the Hold prompt will play if the variable value beginswithan A, B, C,
D, or E.

Y ou can al so use auto attendant menu choicesto pass custom variablesto a queue and use those
variables as Hold prompt condition variables.

Contact center queue callback

For customers who are waiting on hold in a queue, you can offer them the option to enter a
phone number and receive a callback when an agent is avail able, rather than stay connected
listening to hold prompts. The queue will maintain a*“phantom” call that holds each caller's
placein the queue order. Thiscall will be displayed in the ViewPoint Call Monitor just like any
other call.

Note: You can also offer acallback option to customers who are in the process of leaving a
message in a queue’s voice mailbox. See “Enabling callersto leave a callback phone number
viavoicemail” on page 2-13.

How queue callbacks work

After acustomer presses the “ Request Callback” key (available when configured for a queue),
Wave prompts the caller to say hisor her name, which isthen recorded asthe voicetitle for the
cal. If available, Wavewill usecaller ID, or prompt the caller for acallback number. (Caller ID,
if available, will be used by default if the caller hangs up during the prompt process.)

Wave plays the callback information back to the caller for confirmation, and then ends the call

Important: Whether a callback number or caller ID is specified, if it does not meet dialing
format rules for an outbound call, the callback will be deleted.

The call will continue to appear in the Call Monitor, retaining its position in the queue order,
and will be offered to an agent at the appropriate time (any queue skills or scoring rules will be
applied as usual). Agents can use Take Call in the Call Monitor to take a callback call.

When the call is presented to the agent (either because the call reaches the top of the queue or
the agent takes call in the Call Monitor), the call rings the agent and plays “ Thisis a queue
callback. Please wait to be connected to <caller’s recorded voice title>".
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Disconnecting a queue callback call

If you want to terminate a queue callback call for any reason, you can disconnect the call in the
Call Monitor.

This feature requires that the queue supervisor or agent has the queue permission “ Disconnect
queue callback calls’.

Adding the callback prompt to the Hold menu

You add callbacks to a queue via the Hold > Special Keys section of Queue Settings. Specify
the dialpad key that the caller should press to select a callback, for example, “To receive an
automatic callback, press 6”. (See“ Creating Hold prompts’ on page 5-11.)

Make sure to click on Callback Settings to specify the details of how the callback works.

Callback statistics

Inthe ViewPoint Call Monitor, Wait time for acallback call isbased on the actual timethe caller
is on the phone-it does not include idle time between the time the callback is created and when
the actual callback occurs.

In the ViewPoint Queue Monitor, the Inbound Statistics tab now includes a Callbacks section
that displays the following:

» Cadlbacks. Total number of callbacks created during the indicated interval (shift, period,
or day).

o Callbacks Failed. Number of callbacks that did not compl ete.

» Average Timeto Callback. Average time from the callback being created to the callback
being placed (to the caller, not to the agent).
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Setting up contact center queue callback

To set up callback for a queue
1 In User/Group Management, edit an existing queue or create a new one.
2 Intheleft pane, choose Hold > Special Keys.

3 SeecttheRequest callback key checkbox to turn on the callback feature for the queue, and
then select the phone key that the caller should press to request a callback from the

drop-down list.
251 Untitled - Queue
[l Queue I~ Leave voice-mail key: IS 'l
- Skillz
- Agents [ Transfer out of queue key: IS 'l
[+ Diigtribution ; ¥ -
The call will be transfered to: |-, -
5 Rediestion he cal vill be bansferred to: | ~acoount Receivable [x 5302) =l
i=-Hold F# Hequest callback Key: E =] _Calback Setiings.. |
~Special Keys
‘- Praompts
- Yoice Mail
- Caller Entry
- Dial-by-name Directory
- Security
- Audio
- Recording
[+ Statistics
QK Cancel Help
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4 Click callback Settings to edit specific settings for this feature.

[ iLimit callback wait time o |1 hiours |U mirLtes

(* Agent answers first = Customer answers first

Flay when customer answers: ililil EIEI ,|—
Limnit weait for rezponse to: |15— zeconds

Fietry call exveny: |5— minutes

M aximum number of retries: I‘]U—

‘Wwhen wait time expires or the maximum number of retries iz reached:

* Hangup
" Send to voice mail I_Ac:c:ount Receivable [x 24702) j
= Transfer to queue: I_Atl Dial 0= 63732 j

QK I Cancel | Help |

b For Limit callback wait time to, specify the maximum length of time (in hours and minutes)
to wait for the callback to occur. If thistime elapses without the callback taking place, the
callback will be cancelled. The callback will appear in reports as “ callback failed”.

6 Select one of the following answer modes:

Agent answers first. Choose this option to maximize customer convenience.
Customer will be prompted with the confirmation dialog. When they confirm who
they are, the call is connected to the agent, who then waits while the customer is
alerted. Since the customer may have stepped away from the phone, the callback may
fail, leaving the agent idle for a period of time.

Important: Agent answers first isnot supported if aqueue’scall distribution method
iS Simultaneous ring.

Customer answers first. Choose this option to minimize agent downtime. Wave calls
the customer and prompts the customer to confirm his or her identity. When
confirmed, the call will be the next one handled by the agent. Since that agent may
have become busy between the time that the customer answered the callback, and the
time that call was routed back into the queue, the customer may still end up waiting a
bit longer.
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7 Usethe Play when customer answers audio controls to record a message to be played to
the customer. The customer will be prompted to confirm his or her identity. When
confirmed, the call is connected to the agent. (The same message is played whether you
select Agent answer first OF Customer answers first.)

Important: When you record your message, be sure to tell the customer how to connect to
the callback, for example “ This the office of Doctor Deborah Holmes returning your call.
Press 1 to connect”.

For either answer mode, specify the following:

Limit wait for response to ___ seconds. Enter the number of secondsto wait for a
response to the played message.

Retry call every ___ minutes. Enter the number of minutes to wait before retrying a
callback that was not answered by the customer. If you selected the Limit callback
wait time above, the call will be retried until the wait time elapses.)

Maximum number of retries. Enter the maximum number of timesto retry a callback.

8 Sdlect one of the following actions to occur When wait time expires or the maximum
number of retries is reached:

Hang up. When this option executes, it will be logged as afailed callback.

Send to voicemail. Select an extension from the drop-down list. When this option
executes, the voice title recorded for the callback is sent to that voice mailbox asa
new message for follow-up. Thiswill be logged as failed callback.

Transfer to queue. Select aqueue from the drop-down list. When this option executes,
the callback istransferred to the queue that you specify.

9 Saveyour changes.
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Setting up a queue’s voice mailbox

A queue can have its own voice mailbox and can receive voice messagesif you give callersthe
option of leaving voicemail instead of waiting in the queue.

With the proper permissions, agents can see the queug’s voice mailbox, in addition to their own
mailboxes, using ViewPoint’s voicemail folders. Users can also log on to the queue's account
over the phone by using the phone commands.

To accessthe queue’ s voice mailbox, agents must havethe Access queue mailbox privilege. See
“Agent permissions’ on page 3-9.

Setting up avoice mailbox for a queue is optional—if you do not need to provide away for queue
calerstoleave voice messages, select No mailbox on the Voice Mail tab according to theinstructions
bel ow.

Important: Voicemail and call recordings take up disk space on the Wave Server. Once
available disk space becomes scarce, system performance can suffer. To avoid this problem,
archiveyour queues' voice messages (and call recordingsthat are saved in the queue’s mailbox)
regularly.
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To set up a queue’s voice mailbox
1 Click the Voice Mail tab in the Queue dialog.

%] Untitled - Queue

- Hueue (+ Mailbox with |2D minute max size [9.2 ME]
- Skillz

[ Agents " No mailbox

[#- Distribution

- Redirection I awimurn meszage length [seconds): |1 a0

[+ Hald

= [ Sunchranize with Exchange server mailbog: I

- E-mail Motification
-Pager Motification [ Allow voice mail logon during greeting by pressing 9

Ea||§?g:,o},tmcahon [ Periodically remove items older than |3 days
- Dial-by-name Directory

- Sacurity

- Audio

- Recording

[#- Statistics

QK I Cancel | Help |

2 To givethe queue avoice mailbox, click Mailbox with __ minutes max size, and enter the
size of the mailbox in minutes. Note that a minute of voice recording occupies roughly .5
MB of disk space. If the voice mailbox isfull, it cannot accept new voice messages.

Note: If you expect to keep thousands of voice messagesin the queue's mailbox you should
configure Wave to automatically archive the recordings in the queue mailbox, and use the
Archived Recording Browser instead of ViewPoint to manage and listen to the recordings.

To have a queue without a voice mailbox, click No mailbox.

3 Enter the Maximum message length (seconds) for an individual voice message. When a
voice message reaches the maximum length specified, message recording is cut off and the
caller hears the message option prompts. The maximum message length is 999 seconds
(about 16 minutes).
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4 Select the following options:

* Allow voice mail logon during greeting by pressing 9. Select thisoption to allow a
caller to go directly to voice mail by pressing 9 while listening to the voice mailbox
greeting.

* Periodically remove items older than ___ days. Select this option, to automatically
delete items (voice messages and call recordings) after the number of daysthat you
specify.

Note: If theseitems areimportant to you, be sure to archive them before the specified
time period elapses.

* Synchronize with Exchange server mailbox. Thisfeature is not currently supported.

b Click OK to save the queue.

Setting up voicemail notifications

Wave can automatically send a notification you by e-mail, pager, or call whenever the queue
receives a new voice message. Click the Voicemail \ Notification tabs to set up notification of
new gueue voi ce Messages.

Voicemail notification worksthe sasmeway for queues asthe notification featurefor users' voice
messages does.
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Managing a Queue

CHAPTER CONTENTS
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This chapter covers waysto further customize and manage a queue.

Using and improving expected wait time for callers

The queue continuously cal culates the expected wait time for each caller. You can use expected
wait time in the following ways:

Announce the expected wait time as a courtesy to callers. See “ Creating Hold prompts”
on page 5-11.

Use expected wait time to determine whether or not a conditional Hold prompt is played
to acaller. See “Creating conditional Hold prompts’ on page 5-14.

Automatically redirect new callers when the expected wait time istoo high. See
“Redirecting calls when the queue is too busy” on page 2-17.

Wave 5.0

Wave Contact Center Administrator Guide
July 2016



Using and improving expected wait time for callers 6-2
Chapter 6: Managing a Queue

About the expected wait time estimate

Expected wait time is an estimate based on how many agents are currently ready to take queue
calls and the average length of acall. The formulais asfollows:

6 + MinWaitTime + AvgCallLnth * (CallerPosition -1) / (max(AgentsAvailable,
MinimumA gents))

Note: The formula uses whichever islarger, AgentsAvailable or MinimumAgents.

MinWaitTime Minimum wait time
AvgcCallLnth Estimated average call length
CallerPosition Position of the caller in the queue (includes priority)

Number of agents currently signed in and in the personal status Available or

AgentsAvailable Available (Queue Only).

MinimumAgents Minimum agent count

Example: For a queue with 10 available agents and an estimated average call length of 300
seconds, with MinWaitTime of 60, the expected wait time for the fifth caller would be;

6+ 60+ 300 * (4/10) = 186 seconds (about 3 minutes).

This calculation ismost reliable for a Contact Center with many agents and short calls, and in which
agents take calls from only one queue at atime. Though you can improve the estimate (see
“Improving the expected wait time estimate” on page 6-3), you should consider not using
expected wait time if your Contact Center has very few agents and long calls, or if most of your
agents work in multiple queues at once.
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When calculating the expected wait time, Wave includes overflow tiersif the wait time among
primary agents only islonger than the overflow wait time. For example, if the expected wait
time among primary agentsis 5 minutes, and tier 1 overflow agents are activated after 3
minutes, Wave recal cul ates the expected wait time including primary and tier 1 agents. The
process is then repeated for each overflow tier until the expected wait timeis less than an
overflow wait time or until all overflow tiersareincluded. The final expected wait timeisthen

presented to the caller.

Improving the expected wait time estimate

You can improve the expected wait time estimate, and fine-tune queue behavior based on the

expected wait time estimate.

To improve the expected wait time estimate for a queue

1 Choose the Distribution \ Expected Wait Time tab in the Queue dialog.

%] Untitled - Queue

Distribution % Expected Wait Time
- Hueue Minimum agent count: I‘I
- Skillz
[ Agents Estimated average call length: IBDD seconds
B Distribution Minirnum wait time: IBD seconds

- hgent Scoring
- Call Scoring
- fgent Filkering [Skillz]
- fgent Filkering [Overflow)
cted W ait Time:
i Last Agent Routing
- Redirection
[+ Hold
[#-Yoice Mail
- Caller Entry
- Dial-by-name Directory
- Sacurity
- Audio
- Recording
[#- Statistics

Cancel

o]

Help
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2 Enter the following parameters:

Minimum agent count. If you enter aminimum agent count, the expected wait time
estimate will never be based on fewer available agents than this number, even if there
arein fact fewer available agents. A minimum agent count makes the calculation
more accurate over brief dropsin agent availability.

For example, if the queue isredirecting calls based on expected wait time, it can be
vulnerable to agents taking short breaks or a genera shift changeover. With fewer
available agents, even for amoment, the expected wait time rises and incoming calls
may be redirected when there would have been agents available in afew minutes to
take them. Entering a minimum agent count overcomes that problem.

Estimated average call length. This number is crucial to the accuracy of the expected
wait time calculation. Enter the average length of acall in this queue, in seconds.
Include only the talk time plus wrap-up time, not the wait time.

To get the best estimate, use the Queue Monitor’s Avg. Talk Time statistic at the end
of aperiod or shift (see“ The Queue Statistics pane” on page 9-8), and the Activity
History by Queue report (see “Activity History by Queue report” on page 11-22).
More importantly, base the number on your overall experience with the queue.

If you have agents who work in multiple queues, make this number higher to account
for the time they spend in calls from other queues. In general, you can adjust this
number to correct for expected wait time inaccuracies, as described in“ Correcting
expected wait time inaccuracies’ on page 6-5.

Minimum wait time. If you enter a minimum wait time, the calculated expected wait time
will never be less than this number, even when it otherwise would have been. Using a
minimum wait time can avoid inaccurate resultsfor the first callersinto a queue. Note that
if an agent is ready when a call enters the queue, the expected wait timeis still 0 and the
cal is sent immediately to that agent.

3 Click OK to save the queue.
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Correcting expected wait time inaccuracies

Various factors may cause the expected wait time cal culation to consistently be too high or too
low. For example, agents working in multiple queues at once can cause it to be too low.

You can easily adjust the expected wait time result by adjusting the Estimated average call
length number. See the previous section, “Improving the expected wait time estimate” on page
6-3. Raising this number makes the expected wait time result higher; lowering it makes the
result lower.

You can a'so adjust the 6 seconds that is added to the expected wait time (displayed at the
beginning of the expected wait time cal culation on page 2). To do so:

1 Add the following registry key to the Wave Server:

HKEY_LOCAL_MACHINE\SOFTWARE\Artisoft\Televantage\Server\Settings\E
xpWaitRingCycleLength

2 Specify the added time in milliseconds.

Announcing expected wait time in minutes and seconds
By default, the expected wait time prompt announces the wait time in minutes only. To have
Wave announce the expected wait time in minutes and seconds:
1 Add thefollowing registry key to the Wave Server:

HKEY_ LOCAL_MACHINE\SOFTWARE\Artisoft\TeleVantage\Server\Settings\P
layExpWaitTimeInSeconds

2 Setthevaueto 1.
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Automatically recording queue calls

Automatically recording queue calls

You can have Wave automatically record a queue’s calls on aperiodic basis. The recorded calls
appear as hew voice messages in the voice mailbox that you select. The system records both
inbound and outbound queue calls.

To automatically record all calls (including queue calls) in the Wave system, use Wave system
call recording instead.

Note the following important information:

» Insomelocations, itisillegal to record acall without notifying the caler. If you are using
Wave in such alocation, your queue’s Welcome prompt should inform callers that their
calls may be recorded. See “Using the Welcome prompt to inform callers that their calls
may be recorded” on page 2-11.

» If you expect to keep thousands of voice messages in the queue's mailbox you should

configure Wave to automatically archive call recordings out of the queue mailbox, and
then use the Archived Recording Browser instead of ViewPoint to manage and listen to

them.
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To record a queue’s calls
1 Click the Recording tab in the Queue dialog.

2 Check Automatically record queue calls.

%] Untitled - Queue

- Queue v Automatically record queue calls
- Skillz
[ Agerts Becord 1 call out of eveny: |5
£ Distribution Recarding direction: [Inbound and autbound =l
[+ Redirection -
[#-Hold Send queue call recordings to: |< this queue > j
[#-Yoice Mail
- Caller Entry ‘wihen mailbos is full IDeIete oldest call recording j
- Dial-by-name Directory
- Sacurity
- Audio
- Recording
[#- Statistics

QK I Cancel | Help |

3 InRecord 1 call out of every, enter how frequently to record queue calls. Enter 1 to record
every call, 2 to record every other call, 3 to record every third call, and so on.

Note: A cal isconsidered a*“ queue call” for counting purposes only if the call was placed
or answered by an agent in that queue. Callstransferred into the queue, for example, are not
counted.

4 Select the Recording direction from the drop-down list. You can record inbound calls only,
outbound calls only, or both. Selecting both means that you get one recording per n (the
value that you entered in step 3), calls regardless of the direction of the calls.

5 From the Send queue call recordings to drop-down list, select the voice mailbox where
call recordings will be sent as new voice messages.
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6 From the when mailbox is full drop-down list, select the action to occur if the destination
mailbox is full when Wave attempts to store a new call recorded there:

» Discard new call recording. Wave del etes the new call recording instead of storing it.

* Delete oldest call recording. Wave deletes the oldest call recording in the mailbox to
make room for the new recording. Only call recordings will be deleted by this
method—voice messages are never deleted this way.

7 Click OK to save the queue.

You can also automatically record an individual agent’s calls. See“ Automatically recording an
agent’s calls’ on page 3-7.

Stopping recording for calls transferred out of a queue

By default, when the queue is set to record calls, incoming queue calls that are then transferred
out of the queue continue to be recorded. You can change this behavior so that recording stops
as soon asthe call leaves the queue.
To stop recording calls when they leave a queue
1 Onthe Wave Server, add the following new (DWORD) registry key:

HKEY _LOCAL_MACHINE\SOFTWARE\Atisoft\Tel eVantage\Server\Settings\6E23WK
2 Set thevalue of thiskey to 1.
3 Restart the Wave Server.
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Collecting queue statistics

Wave records awide variety of Contact Center statistics that measure caller experience and
agent effectiveness. Agentswith the required permission can view real-time queue statistics by
using ViewPoint’s Queue Monitor. See “Monitoring queue statistics’ on page 9-2.
This section describes how to set the following options for how statistics are displayed:

e Statistics period

» Shifts
Both are used for display purposes only, to compare previous performance with current performance.

The Queue Monitor displays statistics for the previous and the current periods, and for the previous
and current shifts.

Defining the statistics period

The statistics period defines alength of time that you use to compare performance throughout
the day. For example, if you set the statistics period to one hour, the Queue Monitor displays
totals for the previous hour and the current hour.

Wave 5.0

Wave Contact Center Administrator Guide
July 2016



Collecting queue statistics

6-10

To define the statistics period
1 Click the Statistics tab in the Queue dialog.
2 Select the Statistics period from the drop-down list.

%] Untitled - Queue

Category swtisties |

Chapter 6: Managing a Queue

[#- Queue

) Statistics period: I
- Skills

H- Agents
- Distribution

30 mirutes
1 hour

#-Hald

- Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[=]- Statistics

- Shifts

£
£
- Redirection
£
£

Cancel Help

3 Click OK to close the Queue dialog.

Defining shifts for statistics display

ViewPoint displays agent statistics for the current shift and the previous shift. These shiftsare
arbitrary divisions of the workday that you define for the sole purpose of grouping statistics for
display. For example, you can break the workday into a morning shift and an afternoon shift.
During the afternoon you can then view the statistics for the ongoing afternoon shift and

compare them to the statistics for the morning shift.

Note: Defining shiftsisunrelated to scheduling agent work periods, which is something you do
outside of Wave. It may be helpful to define shiftsthat govern statistics display according to the
following instructions so that they match your company’s actual work schedules, but it is not

required.
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To define shifts for statistics display
1 Click the Statistics \ Shifts tab in the Queue dia og.

%] Untitled - Queue

- Dueue Start tirne | End time |
- Skills

[+-&Agents

[#- Distribution
- Redirection
£
£

#-Hald

- Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[=1- Statistics

aid. | Ea. | e |

QK I Cancel | Help |

2 Click Add. The Shift dialog opens.

Start time: |3:00 &m
End time: |5:00 P

QK I Cancel | Help |

3 Enter the Start time and End time for the shift.
Note: The duration of a shift must be greater than the statistics period of the queue.
4 Click oK.
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5 Repeat to add as many shifts per day as you need, for example to cover particularly busy
periods during your workday.

Note: If you define multiple shifts, you should configure one shift to begin on the same
minute that another one finishes, for example a9:00 AM - 12:00 PM shift followed by a
12:00 PM - 5:00 PM shift. If you leave a gap between shifts, callsthat begin and end in the
gap will not be included in the Queue Monitor totals.

6 When you are done defining shifts, click OK to close the Queue diaog.

using custom data variables

Custom data variables let you attach any kind of information to incoming calls. Each custom
data variable represents a different field of information—for example, caller priority—and the
value of that variable can be set individually for each incoming call—for example, each call can
have a different priority value.

You can use custom data variables with a Contact Center queue in the following ways:

» To determine whether a Hold prompt plays. See “Creating conditional Hold prompts’ on
page 5-14.

» Togive high-priority calerslesswait time. See “ Giving some calls higher priority” on
page 4-9.

» To prompt callersto enter information that is then displayed to agents. See “ Setting up
caller dataentry” on page 5-2.
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Creating a custom data variable

Use the following procedure to create a custom data variable for any of the purposes listed
above:

To create a custom variable

1 Choose Tools > System Settings. The System Settings dialog opens.
2 Choosethe Call Data\ Custom Datatab. The tab shows any existing variables.

--Server Data type | Default | System| Description
El-Call Data Long ooop
Customer [0 Shing O
Expected wait time Laong 1] The expected wait time
B Mumber of people ahe: Long 1] The number of callers a
- Business Hours
.- Dial-by-name Directary Order Mumber Long oooo [
[#- E-mail Motification
[+ Security
- &udio
[#-Call Log
- |nternal Dialing
- External Dialing
[#-Recordings
- Hueue 1| | |
[+- Storage
Add... | Edit... | Delete |
QK I Cancel | Help |

Note: Wave comes with two pre-defined custom data variables, Expected wait time and
Number of people ahead. For instructions on using them with conditional Hold prompts, see
“Creating conditional Hold prompts” on page 5-14.
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3 Click Add. The Custom Data dialog opens.

Mame: I
Description: |
[rata type: I Long j

Drefault walue: |

QK I Cancel | Help |

4 Enter the following information:
* Name. Enter the variable's name. Variable names are case-sensitive.
» Description. Enter a description that helps you remember the purpose of the variable.
* Data type. Choose one of the following:

* Long. Thevariable holdsinteger numbers only. If you are creating a custom data
variable to set caller priority, select data type Long.

* Double. The variable can hold integer numbers or decimal point numbers.
* Boolean. The variable can hold the numbers 0 or 1 only.
e String. The variable holds text.
» Default value. The variable will be set to the value you enter for every caller that
enters the queue, if it has not received a value elsewhere.
5 Click oK. The new custom variable appearsin the list.

6 Click OK to close the System Settings dialog.
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Closing a queue

You can close aqueue and prevent new incoming calls from being routed to agents, for example
after business hours when your department is closed. When aqueueis closed, incoming callsto
it are automatically handled according to the selections you make on the Redirect tab (see
“Redirecting calls when the queueis closed” on page 2-21).

To close a queue

1 Click the Queue tab of the Queue dialog.

2 Select the Queue is closed checkbox.

3 Click OK to save the queue.

Note: You can have the queue closeitself automatically when there are no agentssignedin. See
“Redirecting calls when the queueis closed” on page 2-21.

Queue status when closed

Queue status displaysin ViewPoint’s Extensions List in the Personal Status Name column, and
letsyou see at aglance whether the queueis currently accepting calls or not. The queue statuses
are:

» Open. Thequeueisdistributing to its calls to ready agents as normal.
* Closed. The queueisredirecting calls as specified on the Redirect tab.

* Closed - No agents. All agentsin the queue are currently signed out or unavailable, so the
gueue is automatically redirecting calls as specified on the Redirect tab.
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Deleting a queue

To delete aqueue, in the User/Group Management appl et, right-click the queue and then select
Delete.

Important: A warning is displayed if you try to delete queue that is currently being used as a
target location of any kind, for example “This queueis currently being used as arouting list
target: [Name] (extension). Edit or delete these locations before deleting this queue.”

Thiswarning is displayed if you try to delete a queue that is currently being used as any of the
following:

» Forward-to extension: [Name] (extension)

» Intercept destination: [Name] (Trunk Group)

» Alsoring extension: [Name] (Trunk Group)

» Cdl notification: [Name] (extension, Cascading Notification Rule: [Rule Name])
» Cadll notification: [Name] (extension)

* Routing List target: [Name] (extension)

* Menu choice for Auto Attendant: [AA Name] extension)

» ViewPoint group member: [Group Name]

» Operator: [Name] (extension)
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Skills-based and custom routing are optional features that let you go beyond the predefined
algorithms used to distribute calls to agents. Using skill-based and custom routing, you can
define your own system for how a queue chooses an agent for a given call, based on any
combination of the following:

Skills. Calls have varying skill requirements attached and are routed to agents with the
matching skills. For example, Spanish callers within a queue are routed to
Spanish-speaking agents. Skills are a powerful way to maximize your Contact Center
resources by making sure calls go to the agents who are best equipped to handle them.

Cost. You can factor the cost of an agent into call distribution. For example, you may
want your most expensive agents to take fewer calls, freeing them to work on other tasks.
Alternatively, you may want your most expensive agentsto take the most calls, since they
have the most expertise.

Other agent attributes. You can define custom attributes for agents that affect call
distribution. For example, you can have an attribute that represents “ Time with company”
so that your newest agents take fewer calls, giving them space to learn the workflow.

Predefined distribution algorithms. You can blend your custom distribution choices with the
predefined algorithms. For example, you can use the Least talk time a gorithm while factoring
in Cost.
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Do I need to use skills-based or custom routing?

The predefined distribution algorithms are easier to use and in many cases will be sufficient for
your Contact Center needs. You should use skills-based or custom routing only if you want to
distribute calls based on the following characteristics:

e Two or morecaller requirementswithin a single queue. For example, you send both
Spanish and English calls to one queue staffed by both your Spanish-speaking and
English-speaking agents. Skills-based routing allows you to send each call to the
appropriate agent in the queue. (If you have a separate queue for each language, you do
not need to use skills-based routing because each queue is staffed only by the
appropriately-skilled agents, and your auto attendant sends each call to the right queue.)

e Two or morerelevant agent skillsor attributeswithin a single queue. For example,
some callers require either Spani sh-speaking agents, or expertsin South American travel,
or both. If only one skill was relevant—for example, South American travel—you could
create a separate queue for South American travel that uses the top-down distribution
algorithm to reflect agents' skill.

How skills-based routing works

When acall arrives, you can attach skill requirementsto it at the auto-attendant level before
sending the call to the queue. The queue then tries to route the call to the available agent with
the best matching skill. You define to what degree skill isemphasized in the routing algorithm—
you can have the call wait indefinitely for an agent with the right skill, or be eventually routed
to aless-skilled or unskilled agent.

You can attach multiple skill requirements to calls, and agents can have multiple skills at
different values. You define how important each skill isin routing calls.

Example: Your queue routes calls based on two skills; Spanish and Product Expertise. Your
auto attendant has menu prompts separating Spanish from English callers; callsthat choose the
Spanish prompt have a Spanish skill requirement attached to them. Also, all calls start with a
high Product Expertise requirement. You have defined that calls requiring Spanish can never be
routed to an agent without the Spanish skill. However, the longer a call waits, the lower the
Product Expertise requirement becomes, so that after 15 minutes of waiting a call can be sent to
agents with the lowest Product Expertise skill.
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Setting up skills-based routing

Setting up skills-based routing involves the following tasks:

1
2
3

Define one or more skills. See page 7-3.
Assign skills and attributes to users. See page 7-5.

Set up an auto attendant to define skill requirements for incoming calls. See “ Adding skill
requirementsto calls’ on page 7-6.

Select which skills are relevant to the queue. See page 7-8.

Configure the queue to use skills-based routing based on settings you define. See “ Setting
up skills-based routing for a queue” on page 7-9.

Tools to prepare for and analyze skills-based routing

Wave providesan Excel spreadsheet that you can useto quickly seetheimpact of using different
skills and weights, and cal culate what would happen to callsin various scenarios.

Wave's easy-to-read queue |ogs show the routing and scoring decisions queues make whilethey
are handling calls.
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Asthefirst step to using skills-based routing you must define a set of skills, that you can then
assign to users, calls, and queues.

To define skills

1 Choose Tools > System Settings, and go to the Queue \ Agents Skills tab.
{d System Settings
- Organizations ;I |SkiII Comments
- Buziness Hours
[#- Licenses -
- Dial-by-name Directory ?p;ar;:sh
- E-mail Netification slevantage
- Security TrekTrivia
[+ &udio
[#-Call Log and Trunk Log
- |nternal Dialing
[#- External Dialing
[+- Emergency
[#-Recordings
EI--Q:ueue
- S“tuorage
[#-&nalog Trunks
- Problem Report \Wizard = Add... | Edit... | Delete |
ak | Cancel | Help |

2 Click Add. The Agent Skill dialog opens.

3 Under Name, enter the name of the skill. Spaces and colons (:) are not legal characters.
Letters, numbers, and other characters are legal aslong asaletter isthefirst character. Skill
names are not case sensitive, so you cannot use the same skill name twice with different
case.

4 If necessary, enter any Comments to help identify the skill.

5 Click oK.

Note: You cannot delete a skill from that list if that skill is assigned to a user or queue.

6 When you are done entering skills, click OK to close the System Settings dialog.
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Assigning skills and attributes to users

Skills can be defined at the queue level or the user level. When auser hasaskill, it overridesthe
queue's default value for that skill. If aqueue uses askill that the agent does not have, the agent
istreated as though he or she had the skill at the queue’s default value. For example, if aqueue
uses Spanish with a default value of 50, then an agent without the Spanish skill istreated as
though he or she had a Spanish skill of 50. To represent an agent with no skill in Spanish, you
should add the Spanish skill to the user with avalue of 0.

You can also assign attributes other than skillsto users, for example the cost of the agent, and
have them factor into a custom routing algorithm.

The skill value scale

The scale for skills and attributes is 0-100, where 0 represents no skill and 100 represents the
highest possible skill. Thisscale balances skillswith other factorsif you use custom routing (see
“Using custom agent scoring” on page 7-18).

Assigning skills to a user

To assign skills to a user

1 Double-click the user in the User’s view to open the User dialog, and go to the Queue\
Skills tab.

2 Click Add. The Queue Skill dialog opens.
Queveskan |

Skill: - _|
FEroficiency: |1 uli}

QK I Cancel | Help |

3 Select the skill from the Skill drop-down list. To add another skill at the system level, click
the star icon, and see the previous section, “Defining skills” on page 7-4.

4 Under Proficiency, enter the user’s skill value (0-100).
5 Click OK.
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Assigning attributes to users

You can assign users the following non-skill attributes for call routing purposes:

e Cost. A measure of how expensive an agent isto you. For example, you may want your
most expensive agents to take fewer calls, freeing them to work on other tasks.
Alternatively, you may want your most expensive agentsto take the most calls, sincethey
have the most expertise.

e Custom attributes. You can define up to three custom attributes for agents and have them
affect call distribution. For example, you can define an attribute that represents “ Time with
company” so that your newest agents take fewer cals, giving them space to learn the
workflow.

To assign attributes to users

1 Double-click the user in the User’s view to open the User dialog, and go to the Queue\
Attributes tab.

2 Todefinetheuser'slevel in Cost and any of the Custom attributes, enter a value (0-100).
3 Click oK.

For the queueto route callsbased on an attribute, you must configure the queueto useitin agent
scoring. See “Configuring custom agent scoring” on page 7-20.

Adding skill requirements to calls

This section describes configuring an auto attendant to add skill requirementsto incoming calls.
An auto attendant can attach skill requirementsto acall in the following ways:
» Toall callerswho enter the auto attendant.

» To callerswho select a particular menu choice.

Note: You can also attach skill requirementsto acall using the Wave Call Classifier.
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To have an auto attendant attach skill requirements to calls

1

Edit the auto attendant by double-clicking it in the Auto Attendants view to open the Auto
Attendant dialog.
Do one of the following:

» To attach skill requirementsto al callers who enter the auto attendant, click the
Advanced tab in the Auto Attendant dialog.

» To attach skill requirements based on a particular menu choice, go to the Menu
Choicestab, Add or Edit that menu choice, and click the Advanced tab in the Menu
Choice didog.

Click Add. The Custom Data/ Skill Requirement dialog opens.

= Custom data: IPriorityEaIIer j ;?I

Wariable value: |

@ Agentskil.  [Engish =l

Minimum salue: |D

b aximum walue: |1 uli]

Cancel | Help |

Click Agent skill, and select the skill that you want to attach as a requirement to the call.
You can click the star icon to create anew skill at the system level (see“ Defining skills” on

page 7-4).
Under Minimum value and Maximum value, enter the range (from 0 to 100) that an agent’s
skill value must be within to qualify for taking the call.

Note: You can set up skills-based routing to ignore Maximum value, So that no agent is
considered “overqualified” for acall. You can also set up skills-based routing to gradually
relax the minimum requirements asthe caller’swait increases. See* Defining how skillsare
used in routing calls to queues’ on page 7-12.

Click oK.

When you are done adding skill requirements, click OK to close all dialogs and return to the
Auto Attendants view.
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Selecting and weighting relevant skills for a queue

For each queue that will use skills-based routing, you must select which skills are relevant to
the queue, and define the relative weight of those skillsin selecting agents for acall. Skillsin
your system that are not assigned to the queue play no part in routing the queue’s calls, even if
calls require these skills and agents have them.

To select and weight a queue’s skills

1

Edit the queue by double-clicking it in the Queues view to open the Queue dialog, and go
to the Skillstab.

2 Click Add. The Queue Skill dialog opens.

Quevesian |
Skilk [Televantage i |
Drefault proficiency: |1 uli]
Froficiency weight: |‘I.DD

Cancel | Help |

3 Select the skill from the skill drop-down list. To add another skill at the system level, click
the star icon, and see “ Defining skills” on page 7-4.

4 Under Default proficiency, enter a default value for this skill in this queue. Agents without
the skill will be treated as though they had the skill at this value. Agents with this skill
override the default.

The best value scale is 0-100, where 0 represents no skill and 100 represents the highest
possible skill. This scale balances skills with other factors if you use custom routing (see
“Using custom agent scoring” on page 7-18).
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5 Under Proficiency weight, enter anumber to define how important this skill is relative to
other skills and factors when routing calls to matching agentsin this queue. The agent’s
skill valueis multiplied by this number and added to the agent’stotal score (see “ The agent
scoring formuld’ on page 7-21).

Example: By giving Spanish aweight of 1 and Expertise aweight of 5, you make Expertise
five times as valuable when selecting an agent for a call. An agent with Spanish 50 and
Expertise 20 will get 50 points for Spanish and 100 points (20 * 5) for Expertise.

Weight can have a range from -1000 to 1000. With a negative weight, the agent’s skill is
multiplied by the weight and then subtracted from the agent’s score, meaning aptitude
makes the agent less eligible to receive matching calls.

6 Click OK.

7 When you are done adding the relevant skills for the queue, click OK to close the Queue dialog.

Setting up skills-based routing for a queue

Before setting up a queue for skills-based routing, you should have already defined skills and
assigned them to the queue, as well as to the users who will be agents in the queue. For
instructions, see the previous sections in this chapter.
To set up skills-based routing for a queue, you perform the following tasks:
» Choose skills-based or custom routing as the distribution algorithm. See the next section.
» Define how skills are used in routing. See page 7-12.
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Configuring skills-based routing for a queue

To configure skills-based routing for a queue
1 Click the Distribution \ Agent Scoring tab in the Queue dialog.

2 Select “Skills-based or custom routing” from the Agent scoring algorithm drop-down list.

%] Untitled - Queue

- QU_EUE Agent zcoring algarithm: Top down j
- Skill Top down

[]--A.ger.ﬂs _ Round rabin

= Dlstnbutlon Longest idle agent

- Agent Scoring Fewest callz
Least talk time

Simultaneous ring

Call Scoring

Agent Filkering [Skillz]
Agent Filkering [Overflow)
Expected ‘W ait Time
i Last Agent Routing
- Redirection

[+ Hold

[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

QK I Cancel Help
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When you select this option, additional fields are displayed on the Distribution \ Agent
Scoring tab:

241 Untitled - Queue

[+ E:ﬁue Agent zcoring algarithrn: ISkiIIs-based of custom routing j
- Skills
[+-&Agents Distribution calculations are based on queue calls ocourring in:
[=1- Distribution . .
: - T d:
- Agent Scoring me pena IDay j
~Call Scaring Direction: IInbound anly j

- Agent Filkering [Skillz]
- Agent Filkering [Overflow) Determine which agent gets the nest call uzing the following agent attributes:
- Expected Wait Time P

i Last Agent Routing
- Redirection

[+ Hold

[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording
- Statistics The agent's average proficiency in the skills required by the call. The queue
configuration may give more weight to zome skillz. This value will be between 0 and
101

QK I Cancel | Help |

3 Under Distribution calculations are based on queue calls occurring in, specify the
following:
¢ Time period. Choose whether to distribute calls based on totals for the current Shift or the
current Day (since midnight).
¢ Direction. Choose whether the algorithm only counts Inbound calls, or both Inbound
and Outbound calls.

Attributes
Standard agent scoring algorithms

4 Inthe Determine which agent gets the next call using the following attributes table, select
the Use checkbox for Proficiency in call skills to enable skills-based routing. For more
information on Weight and the rest of thistable, see “Using custom agent scoring” on page
7-18.

5 Click OK.
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Defining how skills are used in routing calls to queues

To define how Wave usesthe skillsyou defineto identify agentswho are qualified to take acall,
you specify the following:

e Minimum and maximum skill requirements. A skill requirement on acall includes a
minimum and maximum required value (see “ Adding skill requirementsto calls’ on page
7-6). You can choose whether the queue filters out agents who are underqualified (agents
who fail to meet the minimum skill requirement), or whether it also filters out
overqualified agents who exceed the maximum skill requirement.

e If and how skill requirements change over time. Based on how long a call remains
unanswered in the queue, you can reduce the minimum skill requirements so that the call
does not remain unanswered for too long.

Adjusting skill requirements over time

You can define whether minimum skill requirements get reduced as the caller waits, so that
eventually the call may be sent to aless-skilled or unskilled agent. If you are using maximum
skill requirements (see the previous section, “Defining how skills are used in routing callsto
gueues’ on page 7-12), you can have those increase over time, alowing more highly-skilled
agents to take the call. Choose one of the following:
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To define how skills are used in routing calls to the queue

1

%] Untitled - Queue

Category

[#- Queue

Distribution % Agent Filtering [Skills])

Send calls to agents:

Click the Distribution \ Agent Filtering (Skills) tab in the Queue dialog.

- Skillz

[+-&Agents

[=1- Distribution

Agent Scaring

Call Scoring
ent Filtering [Skills)

gent Filterin Dverlow]

~
o

IIgnoring the call's skill requirements

W ait indefinitely far & matching agent
Eeduce callz skill requirements after ISDD zeconds

LChange them again every IBU zeconds

Expected ‘W ait Time Skill

| Reduce minimurm by

Last Agent Routing
- Redirection

[+ Hold

[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

Mo skills defined in thiz queue

Cancel | Help |

o]

2 To specify the minimum and
Send calls to agents options:

maximum skill requirements, select one of the following

If the agent meets the minimum skill requirements. Callswill be routed only to agents

whose skill values meet or exceed the calls' minimum proficiency requirements for
those skills. Calls' maximum proficiency requirements are ignored, so no agents are
considered “overqualified” for acall.

If the agent’s skills are between the minimum and maximum requirements. Callswill

be routed only to agents whose skill values are within the range of the calls' minimum
and maximum proficiency requirements for those skills.

Note: Selecting Ignoring the

call’s skill requirements disables the filtering step. If you select

this option, calls are distributed to agents whether or not the agents meet the call's skill
requirements. Routing is then based entirely on non-skill factors, such as the weight of agents’
attributes and the queue’s standard agent scoring algorithms (see “ Using custom agent scoring”

on page 7-18).
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3 Depending on the option you selected in the previous step, specify how adjust skill

requirements over time.

%] Untitled - Queue

Distribution \ Agent Filtering (Skills]

[#- Queue

- Skillz

[+-&Agents

[=1- Distribution

Agent Scaring

Call Scoring

Agent Filkering [Skillz]
Agent Filkering [Overflow)
Expected ‘W ait Time
i Last Agent Routing
- Redirection

[+ Hold

[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording

[#- Statistics

Send calls to agents:

[ the agent meets the minimum skill requirements
= Wwait indefinitely for a matching agent
{* Beduce call's skill requirements after |3DD zeconds

Lhange them again every IBU zeconds

Sikill [

Mo gkills defined in thiz queue

Feduce minimum by

o]

Cancel | Help |

* Wait indefinitely for a matching agent. Calls with skill requirements wait indefinitely
until an appropriately skilled agent is available. They are never sent to agents who do
not meet those requirements.

* Reduce call’s skill requirements after __seconds. Enter atime (in seconds) to define
an initial threshold of waiting, during which the call’s skill requirements remain
intact. As soon as the initial threshold is passed, skill requirements are adjusted once.

* Change them again every __seconds. Enter an interval (in seconds) to determine
how often the skill requirements are adjusted, after the first adjustment following the

initial waiting threshold.
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4 Inthetable, define by how much each skill requirement is adjusted whenever the system
makes an adjustment pass. You can have the system adjust different skill requirements at
different rates.

For each skill, click the Reduce minimum by column to enter a number by which the skill
minimum will be reduced. If you are using skill maximums (see the previous section,
“Defining how skills are used in routing calls to queues’ on page 7-12), then you can click
the Increase maximum by column and enter a number by which the skill maximum will be
increased.

Note: Entering avalue of 0 means that skill requirement is never adjusted, and the call waits
indefinitely for an agent who has the required skill value. (Setting all skillsto O is equivalent to
selecting Wait indefinitely for a matching agent above).

5 Click OK.

Redirecting calls when no agents have matching skills

You can have the queue automatically redirect calls when there are no signed-in agents with
skillsthat match the call’ s skill requirements. See“ Redirecting callswhen there are no matching
agent skills” on page 2-22 for instructions.

Note: If you have set the queue to reduce calls' skill requirements over time (see the previous
section), then callswill not be redirected for lack of matching skills.

Wave Contact Center Administrator Guide
Wave 5.0 July 2016



Viewing an agent’s skills within a queue 7-16

Chapter 7: Using Skills-Based and Custom Routing

Viewing an agent’s skills within a queue

To view an agent’s skills within a queue

1 Edit the agent (see “ Adding primary agents to aqueue” on page 3-4) and then click the
Skills tab.

Generall Permissions Skillsl

Thiz agent has the following zkills in this queue:

Skill Proficiency

English 100 [queue]
Spanizh E5 [uszer]
TrekTrivia 55 [queus]

Edit User's Skills... |

Cancel | Help |

2 The Skillstab lists all the agent’s skills that are relevant within this queue. This user may
have other skills, but they do not appear if they are not relevant to the queue. To view or
edit acomplete list of the user’s skills, click Edit User’s Skills, and see “ Assigning skills
and attributes to users’ on page 7-5.

3 To change which skills are relevant to the queue, see “ Selecting and weighting relevant
skillsfor aqueue” on page 7-8.

The source of an agent’s skill value

In the Agent dialog \ Skillstab, the Proficiency column displays the agent's ability in that skill. It
also indicates whether the agent’s skill value comes from his or her own native skill set at the user
level (“user”), or the queue’sdefault value for that skill (“queue”). A user’s native skill value always
overridesthe queue default value. Queue default values are used only if the user does not have askill
that is relevant to the queue.
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Reducing wait time for calls with skill requirement matches

By default, calls are routed to agents in the order received, regardless of skill requirements. In
fact, callswith skill requirements may wait longer, since they are waiting on a smaller pool of
agents who have the required skills. You can counterbalance this by sending acall ahead in the
gueue when an appropriately skilled agent for that call becomes available. In essence, you are
giving calls higher priority when their skill requirements are met by an available agent.

For example, your queue uses the skills Spanish, Japan Travel, and China Travel. Only one
agent has all three skills, so that by default a call requiring all three skillswould haveto waitin
the queue for that one agent, while in the meantime the agent might be taking calls that could
be handled by other agents. If you reduce wait time based on skill, then as soon as the matching
agent became available, the call would jump ahead in the queue, increasing the efficiency of
your queue.

To reduce wait time for calls with skill requirement matches

1 Click the Distribution \ Call Scoring tab in the Queue dialog.

%] Untitled - Queue

[#- Queue A call's score iz bazed or:
- Skills * Time in this queue, in seconds
[+-&Agents

[=1- Distribution = Time in the system, in seconds

[~ Certain calls have a higher priority than other calls

gent Filtering [Overflaw) Priarity iz stared in custom wariable: IAccount Hurmber j ;?I
-~ Enpected Wait Time
L Last Agent Routing
- Redirection

[#-Hold For all zkills required by the call:
[?__\é::lc: glni:ly [~ Add the agent's average proficiency times IB— ta the call's score
- Dial-by-name Directory

- Sacurity

[+ Audio

- Recording

[#- Statistics

Far each unit of the variable's value add ID ta the call's score

QK I Cancel Help
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2 Check Add the agent’s average proficiency times __to the call’s score. Enter a number

that determines how much a call moves ahead in the queue when one or more of its skill
requirements find a matching avail able agent. When an agent with a matching skill
becomes available, his or her skill value is multiplied by that number and added to the
call’'s score. The higher the multiplier, the more matching calls are advanced in the queue.

In cases where the call has multiple skill requirements, the agent’s applicable skill values
are averaged, and that average value is multiplied by the number you enter.

Note: This setting applies only when comparing calls with skill requirements to calls with
no skill requirements. In cases where different calls have different skill requirements, this

setting isignored, and skills change the call’s score based only on their weight in the queue
(see “ Selecting and weighting relevant skills for aqueue’ on page 7-8).

3 Click OK.

Using custom agent scoring

A queue uses agent scoring when a call arrives and several agents are available to take it, to
determine which agent getsthe call. For each incoming call with more than one agent available,
the queue does the following:

1

Filters out those agents who are unable to take the call, for example, because they do not
meet the call’s skill requirements.

Calculates scores for the remaining agents.

Sends the call to the agent with the highest score.

Note: When two or more agentstiefor the highest score, the call always goesto thelongest idle
of the tied agents.

When you use a predefined routing algorithm, agent scores are calculated from O to 100. For
example, when using the “ Top down” agorithm, the topmost agent gets a score of 100, the
bottom agent gets a score of 0, and those in between get percentage scores representing how
close they areto the top.
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You can create your own customized agent scoring system that scores agents according to a
variety of factors. You determine how much weight each factor carriesin determining the
agents' scores. With custom agent scoring you can do the following:

Blend two or more predefined algorithms. For example, you could blend “Round robin”
and “Longest idle,” so that the randomness of round-robin distribution doesn’'t leave an
agent waiting too long.

Incorporate agents’ skill values. If acall requires Spanish and severa agentswith
Spanish are available, the agent with the highest Spanish skill will get ahigher score. You
can weight individual skills differently, for example, a 20 skill in Kazakhstan Travel
could increase the agent’s score by more than a 100 skill in Spanish.

Incorporate agents’ cost and custom attributes. See " Assigning attributesto users’ on page
7-6. After assigning cost and custom attributes to agents, you can weight them appropriately
and use them in routing. For example, you could blend “Least talk time” with a negative
“Cosgt,” so that your most expensive agents take fewer calls, freeing them for other tasks.
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Configuring custom agent scoring

To set up custom agent scoring
1 Click the Distribution \ Agent Scoring tab in the Queue dialog.

2 Select Skills-based or custom routing from the Agent scoring algorithm drop-down list.

%] Untitled - Queue

[+ E:ﬁ:e Agent zcoring algarithrn: ISkiIIs-based of custom routing j
[+-&Agents Distribution calculations are based on queue calls ocourring in:
1 Distribution e petiadt IDa}' j

- Redirection

[+ Hold

[#-Yoice Mail

- Caller Entry

- Dial-by-name Directory
- Sacurity

- Audio

- Recording
- Statistics The agent's average proficiency in the skills required by the call._The queue

- Agent Scoring
all Scoring Diirection: IInbound only j
gent Filtering [Skillz)

gent Filtering [Overflow] Determine which agent gets the nest call uzing the following agent attributes:

wpected Wait Time
Last Agent Routing

Attributes
Standard agent scoring algorithms

configuration may give more weight to zome skillz. This value will be between 0 and
101

QK I Cancel Help

3 IntheDetermine which agent gets the next call using the following agent attributes table,
expand the categories and do the following:

Check Use for each factor that you want to include in the agent’s score. Note that
checking “Proficiency in call’s skills’ makesall skillsafactor. To adjust the weight of
individual skills, see “ Selecting and weighting relevant skills for a queue’ on page
7-8.

To change the weight of afactor, click the weight column for that factor and enter the
new number. The factor’s value will be multiplied by that number and added to the
agent’s score. Weight has arange of -1000 to 1000. To choose a negative weight,
meaning the value will be subtracted from the agent’s score, use the minus sign to
enter a negative number (for example, “-1"). Setting Weight to 0 is equivalent to
deselecting Use, asit will ways add 0 to an agent’s score.

4 Click OK.
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The agent scoring formula
Agents are scored as follows:

Required skill proficiency weighted average (see below) * skill factor weight
plusCost * cost weight

plusCustom 1 * custom 1 weight

plusCustom 2 * custom 2 weight

plusCustom 3 * custom 3 weight

plusldle time agorithm rank * idle time weight

plusTak time algorithm rank * talk time weight

plusNumber of calls algorithm rank * number of calls weight

plusTop down agorithm order * top down weight

plusRound robin algorithm order * round robin weight

equalsAgent score

The Required skill proficiency weighted average is asfollows:
Required skill 1 proficiency * that skill’s proficiency weight

plus Required skill 2 proficiency * that skill’s proficiency weight

plus ... the same for each skill required by the interaction
over The sum of al proficiency weights

Wave Contact Center Administrator Guide
Wave 5.0 July 2016



Using custom agent scoring

7-22

Chapter 7: Using Skills-Based and Custom Routing

Example
I I

Factor Value | Weight | Score Factor Value | Weight | Score
Round robin 100 1 100 Round robin 0 1 0
Longest Idle 33 2 66 Longest Idle 100 2 200
Spanish 50 1 50 Spanish 100 1 100
Kazakhstan 20 10 200 Kazakhstan 0 10 0
Cost (neg) 50 1 -50 Cost (neg) 100 1 -100
Total 366 Total 200

Viewing agent and call scoring decisions

You can use the queue logs to review and analyze the step-by-step logic used by the queue to
route calls to your agents, including how it followed your custom agent scoring setup.
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About using contacts and call rules with a queue

This chapter describes how to use contacts and call rules with a queue. This procedureis
optional—you can run a Contact Center queue without using contacts and call rules.

To use contacts and call rules with aqueue, you create a utility user, which is adummy user
whose routing list contains only afinal action of transferring callsto the queue. The utility user
does not represent areal person. Its function isto receive queue calls, identify the callersif
possible, apply call rules when appropriate, and then transfer the calls to the queue for
distribution to agents. Callers are not aware of the utility user.
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Benefits of using contacts with a queue

By setting up public contacts for the queue that represent important customers or business
contacts, you can enjoy the following benefits:

» Wave can identify the queue's contacts when they call, so that calls appear in the agents
Call Monitors labelled with the contact’s name.

» All agentsin the queue can view the queue’s contacts and place calls to them if necessary.

» After acal, an agent can update a contact’s record with notes that all other agents can
also see.

Benefits of applying call rules to queue calls

By applying call rulesto incoming queue cals, you can handle individual calls based upon the
caller and the time of day. For example, you can:

» Havethe queue automatically take itself offline at 5:00 pm, sending all callsdirectly to
voicemail or playing a message explaining the department hours.

» Greet important customers with a special message before they enter the queue.You can
record a Welcome message that gives callers a code for a special discount, and you can
play the message only to favored customers.

» Change greetings and automatically transfer calls based upon the time of day. For
example, instead of using the manual Queue is closed field (see “Defining call logging
for aqueue” on page 2-24), you can use your Business Hours schedul e to have the queue
automatically play a“We're closed” greeting and route calls to a voice mailbox when
your businessis closed. You can use different schedules for different queues.

Y ou can use an auto attendant as well as a utility user to play greetings and transfer calls
based on time of day.
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Setting up a utility user for a queue

To set up autility user for aqueue, you must complete the following tasks, which are described
in detail in the next two procedures in this section:
e Creating the utility user

» Editing the utility user’srouting list

Creating the utility user

To create a utility user

1 If necessary, click the Administration tab in the Global Administrator Management

Console.
Click 2 Click the User/Group Management icon, located in the PBX Administration section.
. 3 Logon to the User/Group Management applet, which opensin aremote access window.
J.‘ Once you log on, the Users view opens.
4 ChooseFile > New > User. The User dialog opens.
er |
- User First name: ||
[#-Voice Mail
__ =T Last name: |
-Audio Title: |
[+ Security
--Queue Extension: I
- Diial-by-name Directory DID number: I
L iewPoint :

Password: I LConfirmation: I

Azsociated device

* Slot:port I Slot 5 [Ainalag) j I Port 4 j

" IP phone MAC address: I

Telephone type: IAnabg

[
[

Acoess profile: | Unrestricted

QK I Cancel | Help |
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5 Givethe user aLast Name that identifies the queue for anyone transferring calls to it. For

example, “Sales.” Users who transfer callsto the queue will do so by transferring them to

this user’s extension.

Givethe user an Extension and Password.

You do not need to specify anything in the Associated device section, since the utility user
does not have an associated phone.

7 Click the Voice Mail tab.

"USE' & Mailhox with [20 minute max size (9.2 MB]
E-mail Matification = Mo mailbox
Pager Motification : X
Send personal call recordings to: [y -
Call Nofifcation F teeordngs 1 fipis user =l

+- Phone

[-Audio

[ Security

7 Queus

Dial-by-name Directory
- WiewPoint

[ Allow voice mail lag on during greeting by pressing 3

o]

Cancel | Help

voice mailbox, so the utility user does not need one.

8 Select the No Mailbox checkbox. Voice messages for the queue will be stored in the queue’s

Wave 5.0

Wave Contact Center Administrator Guide

July 2016



Setting up a utility user for a queue

8-

Chapter 8: Using Contacts and Call Rules with a Queue

9 Click the Audio\ Voice Title tab.

- Uszer

Dial-by-name Directory
- WiewPaint

BEREEE

| Fieady to play

L5 ]

Cancel |

Help

10 Usethe audio controlsto record the queue's name, for example, “ Sales queue.” See“Using
the audio controls’ on page 1-8 for instructions.

11 Click the Phone\ Call Handling tab.

- Uszer

“oice Mail
Fhone

Station Features
Ring Patterms
Hands-free

- Automatic Log Out

Call Eorwarding... |

[~ Handle busy calls differently than calls nat answered

Action if the call iz not answered or the station iz busy

¥ Plap uszer's default greeting

[+ &udio Action Take a message j
[+ Security
- Queue

- Dial-by-name Directory

- WiewPoint

’TI Cancel Help
Wave Contact Center Administrator Guide
Wave 5.0 July 2016



Setting up a utility user for a queue 8-6
Chapter 8: Using Contacts and Call Rules with a Queue

12 Deselect all options.
13 Click the Dial-by-Name Directory tab.

& Untitled - User [ %]
Category Dial-by-name Directory

¥ List in dial-by-name directorny

¥ Flay extension to the caller

QK I Cancel | Help |

14 Check List in dial-by-name directory if you want callers and users to be able to find the
gueue by name.

Note: If you list the utility user in the dial-by-name directory, you should deselect this
option for the queue itself, so that callers who reach the dial-by-name directory do not hear
two entries for the queue.

15 Click OK.
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Creating the utility user’s routing list
1 Logonto ViewPoint asthe utility user.

2 ChooseFile > New > Routing List. If you see the Welcome to the Routing List Wizard
screen, click Routing List Editor. The Routing List dialog opens.

"3 Routing List - Routing List M=l B3

Mame:

Actions | If not answered or busy I

& New Action Edit Action | 4 Delete

Step | S |Acti0n
1 s Call my Preferred Location: x210

€

If niok answered or busy: Take a message

[T Use this routing list as the default For incoming calls

OF I Cancel | Help |

3 Givethe Routing List aName to help you identify it with the queue, such as“To Sales.”

4 If there are any actionslisted (for example, “Call my Preferred Location”), select each one
and then click Delete.
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5 Click theIf not answered or busy tab.

"3 Routing List - Routing List M= =

Mame: IRouting Lisk

Actions

Final action if the call is not answered or the station is busy

i Flay greeting: IActive (Initial Greeting) j |

Final action: ITake a message j

™ Handle busy calls differently

OF I Cancel | Help |

6 Under Final action if the call is not answered or the station is busy, do the following:
» Deselect the Play greeting checkbox.
» Select Transfer to an extension from the Final action drop-down list.
* Fromthe Transfer to drop-down list that appears, select the queue to which you want
the utility user to send calls.
7 OntheActionstab, select the Use this routing list as the default for incoming calls.

8 Click OK to savethe new routing list and exit the dialog.

When you are finished editing the utility user’s routing list, make sure the utility’s user’s
personal statusis set to Available.

Wave Contact Center Administrator Guide
Wave 5.0 July 2016



Creating queue contacts 8-9

Chapter 8: Using Contacts and Call Rules with a Queue

Creating queue contacts
You create contacts for the queue by creating public contacts for the utility user.

To create queue contacts
1 Logonto ViewPoint as the utility user.

2 Choose File > New > Contact to add a contact.

B Untitled - Contact W= B3
Create new contact in Folder: IContacts {Personal) j

General | Caller Identification I

. Phone numbers and addresses
Eirsk name: |

Mame | Address Description
Lask name: I Business
Business 2
Company: I Haome
. Home 2
Title: I Mobile
Account code: I Othgr
Ernail
Email 2
Preferred teleph ks
referred telephone prompts I Address
IEninsh {United States) j
Edit... Clear |
Motes
' =
E

OF I Cancel | Help |

3 Select Contacts (Public) from the Create new contact in folder drop-down list.

4 Enter contact information, and then click OK to save the new contact and exit the dialog.

Setting up call rules for a queue
You set up call rulesfor aqueue by creating call rules for the utility user.

Each call rule that you define for a gueue must handle calls by using a particular routing list.
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Example: Todefineacall rulethat plays certain callers (contacts) aspecial Welcome message
before they enter the queue, you would create acall rule that sends callsto a custom routing list
(arouting list created for the utility user) that has the following features:

* Noactions
* A greeting that plays the Welcome message before the final action

* Afinal action of Transfer to Extension that transfers callsto the queue

To set up call rules for a queue
1 Log onto ViewPoint as the utility user.

2 Choose Tools > Call Rules. The Call Rules dialog opens.

i call Rules =] 3
E;J Mew Rule Edit Rule | X Delste Move Up Move Down
Call Rule {applied in the order shown) | Enabled |

There are no items ko show in this view,

Rule description {click an underlined value ko edit):

Calls that do not match any rule will be handled according to vour active settings

Close I Help |

4

3 Click New Rule. The Call Rule Wizard starts. Follow the on-screen instructions to define
the new call rule.

Use only the call rule’s Routing List field and custom non-active routing lists to determine
how calls are handled. Do not use the call rule’s Personal Status or Taking Calls fields—if
you use these fields, calls may be lost.

To activate call rules based on individual callers, define those callers as contacts for the
utility user. See “ Creating queue contacts’ on page 8-9.

4 Make surethat Enable this call rule is checked.

5 Click OK. Repeat this procedure to create other call rulesfor the queue.

Wave 5.0

Wave Contact Center Administrator Guide
July 2016



Chapter 9

Supervising a Contact Center Queue

CHAPTER CONTENTS

About SUPErVISING QUEUES . . . ...t e e 9-1
Viewing currentqueue calls. ... ... ... 9-2
Monitoring queue statistics. . . . ....... ... . . 9-2
Supervising otheragents’calls. . . ........ ... .. . . 9-18
Managing agents’ status . ......... ... . ... 9-21
Managing a queue’s voice mailbox .. ......... .. ... 9-25

About supervising queues

You can assign agents any number of queue permissions that give them the ability to supervise

aqueue. Supervisors are merely agents with extra permissions. Supervisory tasks include the
following:

» Configuring the queue, including the which agents belong to the queue
» Signing agentsin or out of the queue

» Viewing real-time queue statisticsin ViewPoint

e Changing an agent’s personal status

» Managing a queue’s voice mailbox

e Supervising agent conversations by monitoring or coaching

You assign permissions separately for each queue. To give an agent supervisor permissionsin
more than one queue, you must edit the agent separately in each queue.

For instructions on adding agents to a queue and setting their permission levels, see “Adding

primary agents to a queue” on page 3-4. For alist of queue permissions, see “Agent
permissions’ on page 3-9.
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Exempting supervisors from receiving queue calls

Because supervisors are agents in the queue, by default they receive queue calls when they are
ready, just as other agents do. To exempt an agent from receiving calls from a queue, sign the
agent out for that queue, or configure the agent as an Observer.

When supervisors are signed out from a queue, the queue does not send callsto them. However,
supervisors can watch queue callsin the Call Monitor folder and answer them if necessary using
the Take call command. They can also perform all other queue monitoring and managing tasks
when they are signed out.

For instructions on signing a supervisor out, see “ Signing agentsin or out of a queue” on page
9-21.

Viewing current queue calls

Agents with the permission Access Queue call monitor can view al current queue activity on
the queue'stab in ViewPoint’s Call Monitor folder. Note that only calls associated with the
gueue appear in the queue's tab. If the agent is on a personal call or a call from another queue,
it does not appear in the queue tab.

For more information, see “Using the Call Monitor tabs’ on page 10-8.

Monitoring queue statistics

Agents who have the permission Monitor queue statistics set to Allow can monitor a queue's
performance via the Queue Monitor folder in ViewPoint.

Wave 5.0
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Viewing queue statistics in the Queue Monitor folder

To view statisticsfor aqueue, open that queuein the ViewPoint Queue Monitor. To do o, inthe

ViewPoint Call Monitor click on the queuein the navigation pane. Queue statistics are displayed
at the bottom of the Queue Monitor.

Q- Sales Queue’,Queue Monitor or - Yertical Wave ViewPoint

FEile Edit Yiew Tools Actions Help

Dial: Enter a number or name to dial -
New ~| 3 b Supervise | Show agent statistics by day - | &

Call Monitor =
A% all Manitar
s Extensions

e Y H ol Bennett Ready
M Manit
@ ain Quews| Quee Manitor e e 3 Kelley Feldman Ready

: 8ales Queue',Queue Monitor

5d 1134120
20d 4:36:51 a

a 000 00

Current status

Queue status:

Il:lpen

Agents on break: a
% Agents ready: 100%

Agents ready: I 3 Signed in and available: 3

4% Messages (1)

Calls waiting: I 0 Calls being placed: o Agents wrap-up! 1]
_ Inbound statistics IOuthund statistics | Combined statistics I
[= Contacts Inbound gueue statistics by day
3 Call Log

Calls answered: o Calls abandoned: a Calls to woice mail: I 0

Calls transFerred out: 0 Calls completed: 0 Tatal talk time: I 00:00:00
Calls received: 0 Avg, talk time: 00:00;00

*;“? Configuration

iE]

In order to view a queue’s statistics, you must:

Be an agent in that queue. If you do not want to receive calls from the queue, see
“Exempting supervisors from receiving queue calls’ on page 9-2.

Have the permission Access Queue call monitor set to allow for the queue.

For adetailed description of when Queue Monitor statistics reset to zero, see “When statistics
are reset” on page 9-12.

Note: You can continue to use the Call Monitor while you are in the Queue Monitor. Choose
View > Calls Pane to add the Call Monitor to the Queue Monitor folder as a separate pane.
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The Agents pane

At the top of the Queue Monitor folder, the Agents pane displays the names of all agentsin the
queue, their current statuses, and their performance, including inbound and outbound calls.

You can havethe Agents panedisplay statistics by day or by shift. ChooseActions > Show agent
statistics by day/shift. For information about shifts, see “ Defining shifts for statistics display”
on page 6-10.

Note: The Agents pan€’s statistics are those for the sel ected queue only. For example, the Calls
answered field showsthe number of calls an agent has answered for this queue. The agent may
have answered other calls such as personal calls or calls from other queues.

The Agents pane displays the information shown in the following table. Some columns may be
hidden by default. To show them, choose View > Current View > Show Columns.

Availability Icon showing the agent’s phone as on-hook or off-hook.
Personal Statusicon Icon for the agent’s current personal status.
Distribution Order The order in which agents are scheduled to receive calls. The

order is dependent on the queue’s distribution algorithm. The
agent who will receive the next call is the agent with the lowest
number among currently Ready agents.

This column may be disabled. See “Enabling and disabling the
Distribution Order column” on page 9-16.

Name Agent’s hame.
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Agent Sate Agent’s current level of availability to take calls from this queue.
Note than an agent can be in different states for different queues
at the same time. The possible states are:

Ready. The agent is signed in, and in the personal status Avail-
able or Available (Queue Only), and the phone is on-hook. The
agent is ready to take acall.

Active Inbound. The agent ison an inbound call from this
queue.

Active Outbound. The agent is on an outbound call associated
with this queue.

Wrap-up Inbound. The agent isin the wrap-up period immedi-
ately following the end of an inbound call associated with this
queue.

Wrap-up Outbound. The agent isin the wrap-up period imme-
diately following the end of an outbound call associated with this
queue.

Dialing. The agent is in the process of dialing an outbound call
as the queue.

Sandby. The agent is On Break, or isin anon-queue call (such
as apersonal call or acall from another queue.)

Signed out. The agent is signed out of this queue and so is not
taking calls from this queue.

Unavailable. The agent isin a personal status other than Avail-
able or Available (Queue Only), and so is not taking queue calls.

No answer. The agent did not answer the last queue call. The
gueue does not send callsto agentsin the No Answer status.
Wave automatically removes the agent from No Answer status
after a certain time based on what caused the No Answer status.

Offering. The agent's phone isringing with a call from this
gueue, but the agent has not accepted the call yet.

Timein Sate The length of time that the agent has been in the current state for
this queue. Times are displayed in the following format: days:
hours:minutes:seconds.
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Callsanswered Number of incoming calls from this queue that the agent has
answered since the beginning of the queue's current display
period. Does not include calls the agent participated in but did
not answer (see Total Calls- All)

Callsplaced Number of outbound calls associated with this queue that the
agent has placed since the beginning of the queue’s current dis-
play period. Does not include calls the agent participated in but
did not place (see Total Calls- All)

Timeon calls Thetotal time the agent has spent on this queue's calls since the
beginning of the shift.
You can show this column separately for inbound calls, outbound
cals, and al calls.

Longest call The length of time of the longest queue call (including wrap-up

time) that the agent handled since the beginning of the shift.

You can show this column separately for inbound calls, outbound
cals, and all calls.

Avg. call Average length of the agents' queue calls (including wrap-up
time) since the beginning of the shift.

You can show this column separately for inbound calls, outbound
cals, and al calls.

Longest talk The length of time of the longest single call the agent handled
(not including wrap-up time).

You can show this column separately for inbound calls, outbound
cals, and al calls.

Away A check mark indicates that the agent has been automatically
placed in On Break status by the queue for having let his or her
most recent queue callsring unanswered. See “Placing agents on
break if they do not answer calls’ on page 4-6.

Forced Break Number of times the queue has automatically placed the agent in
On Break statusfor letting queue callsring unanswered, since the
beginning of the current display period. See “Placing agents on
break if they do not answer calls’ on page 4-6.
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Inbound Calls Number of incoming queue calls that the agent has participated
in since the beginning of the queue's current display period,
including inbound calls transferred from other agentsin the

queue.

L ongest wrap-up The length of time that the agent spent in the longest wrap-up
after acall.

No Answer Number of queue calls to the agent that rang unanswered, since

the beginning of the current display period.

Outbound Calls Number of outbound queue calls that the agent has participated
in since the beginning of the queue's current display period,
including outbound bound calls placed by other agentsin the
gueue and then transferred to this agent.

Overflow The agent’s overflow tier. If no number islisted the agent isapri-
mary agent (assuming the overflow skill default is set to 0).

Personal Status Name Name of the agent’s current persona status.

Queue Name of the agent’s queue.

Signed in A check mark indicates that the agent is signed in to this queue.

Total calls- All The total number of calls associated with this queue in which the

agent has participated since the beginning of the queue’s current
display period. Includes inbound and outbound calls, and calls
where the agent did not answer or place the call (for example,
joining another agent in aconference call or having another agent
transfer acall to him)
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The Queue Statistics pane

At the bottom of the Queue Monitor folder, the Queue Statistics pane displays statistics for the
gueue as awhole. To show or hide the Queue Statistics pane, choose View > Queue Statistics
Pane.

You can display queue statistics for inbound calls only, outbound calls only, or al calls, by
clicking the appropriate button above the Queue statistics by day section.

EInbound skatisticsi  Quthound statistics | Combined statistics | 1

| Inbound queue statistics by day

For outbound calls to appear in the Outbound Statistics section, agents must place calls as the
gueue. See “Placing calls from a queue vs. calling as user” on page 10-10.

The Queue Statistics paneis divided into the following sections:
e Current status. Statistics for the number of agents and calls currently in the queue.

* Queue statistics by day. Statistics for calls since the beginning of the current day. These
statistics automatically reset to zero at midnight.

* Queue statistics by period and shift. Statistics for calls during the current period and
shift, compared to the previous period and shift. When the current period or shift ends,
the current statistics automatically reset to zero, and the totals that had accumulated are
moved into the Previous column.

For instructions on defining the statistics period and shifts, see“” on page 2-28. For detailed
descriptions of when day, period, and shift statistics reset to zero, see“When statistics are reset”
on page 9-12.

Note: Queue statistics by shift are not updated during gaps between shifts. For example, if one
shift ends at noon and the next shift begins at 12:30, queue activity between 12:00 and 12:301is
not reflected in the shift totals.
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The Queue Statistics pane displays the statistics shown in the following table.

Current Satus

Queue status Whether the queue is currently distributing calls to agents. The
possible statuses are:

Open. The queueisdistributing its calls to ready agents as
normal.

Closed. The queueis closed. No calls are being distributed
to agents.

Closed - No agents. All agentsin the queue are currently
signed out, so the queue is automatically sending its calls
directly to voicemail.

Agentson break Number of agents currently signed in and in the On Break per-
sonal status.
Agentsready Number of agents waiting to receive queue calls. Ready agents

are those who are signed in, have their personal statuses set to
Available or Available (Queue Only), and are not currently off
hook or in awrap-up period.

Signed in and available Number of agents eligible to receive queue calls, including those
currently on acall or in wrap-up period. To receive queue calls
an agent must be signed in and in apersonal status whose Queue
callsfieldisset to “Yes,” such as Available or Available (Queue

Only.)

% agentsready The percentage of agents eligible to receive queue callswho are
currently waiting for acall. The others are either off hook or in a
wrap-up period.

Callswaiting Number of calls currently waiting on the queue.

Number outbound callsin the process of being placed. (Con-

Calls being placed nected outbound calls are not counted.)

Number of agents currently in the wrap-up period following a

Agentswrap-up queue call.

Inbound Satistics

Callsanswered Number of calls answered by an agent.
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Number of calls transferred out of the queue without being han-
died by an agent, as aresult of calers pressing the transfer key.
(See “ Offering options while acaller is waiting on a queue” on

Callstransferred out

page 5-10.)
Callsreceived Total number of calls received, including abandoned calls.
Calls abandoned Number of callers who hung up without talking to an agent.
Callscompleted Number of completed callsin which a caller finished talked with
an agent. Completed calls are calls that ended by hanging up or
transferring.
Avg. talk time Length of the average time that callers spent talking with agents.
Callsto voice mail Number of callsthat went to voicemail without being handled by

an agent, as aresult of callers pressing the key to leave voice-
mail. (See* Offering options while a caller iswaiting on aqueue’

on page 5-10.)

Total talk time Total number of minutes that callers have spent talking with
agents.

Longest time Length of the longest time in each of the following categories (by
day only):

Talk time. Time spent talking with an agent.
Wait time. Time spent waiting on the queue.

Aver age wait time Average length of time callers waited on the queue for each of
the following categories:

All calls. All inbound calls to the queue.

Answered calls. All callsto the queuein which the caller
spoke with an agent.

Abandoned calls. All callsto the queue in which the caller
hung up or |eft avoice message.
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Redirection

Number of callsthat have been automatically redirected by the
queue, for each of the following categories:
Maximum hold. Callsthat reached the maximum wait time
without being answered (see page 2-20).

Queue busy. Calls that were redirected because the queue
was too busy (see page 2-17).

Queue closed. Calls that were redirected because the queue
was closed (see page 2-21).

Outbound Satistics

Callsplaced

Number of outbound calls placed by this queue.

Callscompleted

Number of connected calls that are now over.

Callsconnected

Number of calls that have connected with the called party.

Longest time*

Length of the longest time by one call.

Averagetime*

Length of the average time over al calls.

Total time*

Total number of minutes from all calls.

* Talk time = Time spent talking with an agent.

Combined Satistics

Callsattempted

Total number of inbound calls received and outbound calls
placed.

Calls completed Total number of inbound and outbound calls completed.

Calls connected Total number of inbound calls that were answered and outbound
calsthat were connected with the called party.

Longest time* Longest talk time counting both inbound and outbound calls.

Aver age time*

Average talk time counting both inbound and outbound calls.

Total time*

Total talk time adding inbound and outbound calls.

* Talk time = Time spent talking with an agent.
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When statistics are reset

Statistics are reset to zero at the following times:

Satistics by day At midnight, or when the Server is restarted.

Satistics by period On 15, 30, or 60 minute intervals, depending on your configura-
tion for Satistics period interval (see “Defining the statistics
period” on page 6-9). The intervals are counted from midnight,
so a 15-minute interval would reset at 12:15, 12:30, 12:45, etc.
All queues that share the same statistics period interval reset at
the same clock time.

Note: Period statistics are always reset counting from midnight,

not from the time of a Server restart. This could result in a short

period. For example, if the Server was started at 9:50, the period
would still end at 10:00, resulting in a 10-minute period.

Satistics by shift At the end of the shift, as you defined it (see “ Defining the statis-
tics period” on page 6-9).

Note: When acall overlaps areset time, some statistics for it will appear in the first grouping,
some in the second, depending on when the statistic is counted. For example, Calls Answered
is counted as soon asthe call isanswered, while Calls Completed is counted when the call ends.
Therefore, if acall lastsfrom 11:58 PM to 12:20 AM, it would be counted as a Call Answered
in Day 1, and a Call Completed in Day 2.
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When statistics are refreshed

By default the Queue Monitor folder refreshes with new statistics as soon as they become

available, providing areal-time picture of queue activity. You can enter a slower refresh rate to
improve the responsiveness of agents’ ViewPoint applications. You should change this setting
if you find that agents' ViewPoint applications are responding too slowly.

To change the Queue Monitor refresh rate

1
2
3

(2]

If necessary, click the Administration tab in the Management Console.

Choose Tools > System Settings. The System Settings dialog opens.
Click the Queue tab.

{d System Settings

— Quewe
[#-Server Queue statistics refresh interval: ID milizeconds
[#-Call Data

- Organizations ¥ Update Agent Distibution Order column in Queue Maonitar

- Business Hours
- Dial-by-name Directory
[#- E-mail Motification
[+ Security
- &udio
[#-Call Log
- |nternal Dialing
- External Dialing
[#- Recordings
=t

Agent Skills
- Storage

QK I Cancel Help

Click the User/Group Management icon, located in the PBX Administration section.

6 Enter the new refresh rate (in milliseconds) in Queue statistics refresh interval.
7 Click OK.

Log on to the User/Group Management applet, which opens in a remote access window.
Once you log on, the Users view opens.
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About agents’ personal status and state

When working with the Queue Monitor, it isimportant to distinguish between an agent’s
personal status and state.

e Personal status. Determines whether the agent receives queue calls. An agent's personal
status is the same across all queues.

» state. Displays the agent's current activity, for example, whether the agent is currently in
aqueuecall. An agent's state can be different in different queues. For example, if an agent
isamember of Queue A and Queue B, and the agent is currently in acall for Queue A,
his state would be Active in Queue A and Standby in Queue B.

For a description of agent states, see the Agent State column in the Agents pane table on page 9-4.

Monitoring the position of agents in the queue

The Queue Monitor’s Distribution Order column—displayed asin the Agents pane—showsthe
order in which ready agents are scheduled to receive calls. The agent with a1l inthe columnis
scheduled to receive the next call, followed by the agent with a2 in the column, and so on.
Unavailable agents do not receiveaposition number. Unavailable agentsinclude agentswho are
signed out or in apersonal status that makes them unavailable such as Do Not Disturb or
Available (Non-Queue).

Note: You can enable or disable the Distribution Order column. See page 9-16.

The agent with a1 in the distribution order will not necessarily receive the next cal. The
distribution order reflects the scheduled order according to the queue’s distribution algorithm,
but it does not reflect which agents are currently Ready. A Ready agent might have 5 in the
Distribution Order column and yet receive the next call because all other agents are busy at the
moment. The agent who will receive the next call isthe agent with the lowest distribution order
number among Ready agents.

Distribution order numbers for overflow agents follow those for primary agents. For example,
if agueue has 10 ready primary agents, the first scheduled overflow agent will display 11 inthe
Distribution Order column. The distribution order of overflow agentsis determined first by tier,
and then within each tier by the queue’ sdistribution algorithm. For more about overflow agents,
see “Including a queue in the dial-by-name directory” on page 2-16.
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The following table shows how agent positions are calculated for each distribution algorithm.
The descriptions apply separately to primary agents and to each tier of overflow agents.

Top down Agents’ positions are ordered by their order in the queue and do
not change.
Round robin Agents’ positions are reordered according to which agent

answered the previous queue call. Whenever an agent answers a
queue call, the next agent down in the list becomes 1, the agent
after that becomes 2, and so on. When the bottom of the queueis
reached, the order continues from the top down until it meetsthe
agent who answered the most recent call.

Longest idle agent Agent positions are ordered according to the length of time with-
out being in an Active state. The agent who has gone the longest
without being Active inbound isin position 1.

Note that talking on non-queue calls and being in the On Break
personal status place an agent in the Standby state, so that the
time since the agent was Active continuesto increase. Likewise,
Wrap-up is not an Active state, so agents' wrap-up time also
increases their “idle” time. Only receiving a queue call makes an
agent Active and resetsthe agent's “idle” time.

An agent's position is reduced by 1 whenever an agent with a
longer time since being Active receives or places aqueue call.
The only way for an agent's position to increase is for the agent
to receive a queue call.

Fewest calls Agent positions are ordered according to which agent has
received the fewest queue calls during the current display period.
The agent who has received the fewest queue calls since the
beginning of the shift is at position 1.

Note that the length of time spent on a queue cal is not signifi-
cant for adjusting position, only the number of queue calls partic-
ipated in.
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Least talk time Agent positions are ordered according to which agent has spent
the least time on inbound queue calls during the current display
period. The agent who has spent the |east time on inbound queue
calls since the beginning of the shift isat position 1.

Note that only callsfrom a queue count astalk timein that queue.
An agent working in two queues will have adifferent talk timein
each.

Simultaneousring Agents have no position, as each call rings all agents' phones
simultaneoudly.

Skills-based or custom rout- Agent positions are ordered according to their agent score, to
ing select the best-qualified agent for each call. See “Using custom
agent scoring” on page 7-18.

Note: Thedistribution algorithms Longest idle, Fewest calls, Least talk time count inbound
queue calls only.

Enabling and disabling the Distribution Order column

You can enable or disable the Distribution Order column in the Agents pane in the Queue
Monitor. Disabling the column can speed up system performance.
To enable or disable the Distribution Order column

1 Inthe User/Group Management applet, choose Tools > System Settings. The System
Settings dialog opens.

2 Click the Queue tab.
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3 Select or deselect the Update Agent Distribution Order column in Queue Monitor checkbox.

-'{:d System Settings E
— Quewe
[#-Server Queue statistics refresh interval: ID milizeconds
[#-Call Data

- Organizations ¥ Update Agent Distibution Order column in Queue Maonitar

- Business Hours

- Dial-by-name Directory
[#- E-mail Motification

[+ Security

- &udio

[#-Call Log

- |nternal Dialing

- External Dialing

[#- Recordings

- Agent Skills
[#- Storage
’TI Cancel Help
4 Click OK.

Monitoring queue statistics using the phone

Agents who have permission to monitor queue statistics can hear the current statistics for a
gueue at any time by picking up a Wave phone and dialing *55. The system prompts them to
select the queue for which they want to hear statistics.

Diaing *55 plays the queue statistics shown in the following table. Statistic totals are kept since
midnight at the beginning of the current day.

Callerswaiting Number of callers waiting on the queue.

Expected wait time Rough estimate of how long callers can expect to wait if they
called right now. The formula used is <total wait time of all
answered calls so far this day> / <number of answered calls so
far this day>.

Active agents Number of agents currently available. Thisincludes al agents
who are signed in and in the personal status Available or Avail-
able (Queue Only).
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Total calls Total number of calls received today (since the last midnight).

Abandon rate Abandoned calls as a percentage of total calls.

Supervising other agents’ calls

You can assign agents permission to supervise other agents' callsin the following ways:

* Monitoring an agent’s call. The supervisor can listen to another agent’s call without being
heard by the other agent or the caller.

* Coaching an agent on a call. The supervisor can coach another agent without being heard
by the caller. The agent hears the supervisor but the caller does not. The supervisors can
hear all parties.

» Joining an agent’s call. The supervisor can be conferenced in to another agent’'s call asa
full participant and be heard by both parties.

Supervising Contact Center callsis a separate feature from supervising personal cals, and the
two are controlled by different permissions, as follows:

* Supervising personal calls. Supervising personal calls requires Wave user permissions
set up by your system administrator. Users with only these permissions cannot supervise
Contact Center calls.

* Supervising Contact Center calls. To supervise Contact Center calls, you must be a
Contact Center agent with agent permissions set up per queue by your queue
administrator. As a Contact Center supervisor, you can supervise only other agentsin
your queue, and only their queue calls, not their persona calls.

Note the following:

» You can supervise an agent’s outbound queue calls only if the agent has associated his or
her outbound callswith the queue. See“Placing callsfrom aqueuevs. calling asuser” on
page 10-10.

» If the agent whose call you are supervising transfers the call to another party, or parksit
and it is unparked by another party, you are disconnected.

» Tocoach, monitor, or join acal, at least one party in the call must be from the local Wave
system. For example, monitoring a call between two Gateway users (a Wave user whose
“home” is another node in the WaveNet network) is not supported.
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How supervised calls appear in the Call Monitor

When you join another agent’s call, the call appearsin your Call Monitor as a normal
conference call.

When you monitor or coach an agent on acall, the call appearsin your Call Monitor showing
all three parties to the call. Your row—the top row in the call—is labelled “Monitoring” or
Coaching”. The following example shows a call being monitored.

x VI
N Unknown o Ative U
w b pgent 3 o Bctive 3

» If you are coaching an agent, the agent sees you as a party in the call.

» If you are monitoring an agent, the agent does not see you as a party, unless that agent has
the permission View agents being monitored set to Allow. See the next section, “Viewing
when agents are being monitored.”

To supervise another user’s call using ViewPoint
1 InViewPoint, select one of the following:
* A cdl inthe Cal Monitor
e A userinthe Extensionslist who is currently on acall

2 Choose Actions > Supervise, and select the supervisor mode you want to use—Coach,
Monitor, or Join. The Supervise option is available only if both you and the other usersin
the call permit that supervisor mode.

To supervise another user’s call using the phone

1 Pick up the phone and enter one of the following commands at the dial tone:
» *57 (Join)
» *58 (Coach)
» *59 (Monitor)

2 Enter the extension of the user whose call you want to join, coach, or monitor, followed by
#.

3 Press1 to confirm the extension, or press * to enter a different extension.
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Note: You can enter the complete digit string rapidly without waiting for the prompts. For
example, to coach extension 102, you can enter *58 102# 1.

4 Once connected to the call, you can use the following phone command options:

» To change the supervisor mode—for example, from monitoring to coaching—press
Flash, then enter the code for the new mode.

» Tosupervise adifferent user, press Flash # to return to the dial tone, then begin again.

Viewing when agents are being monitored

Agents who have the permission View agents being monitored set to Allow can see when an
agent is being monitored by another agent. The monitoring agent appearsin the Call Monitor as
another party in the call, identified by the Status “Monitoring”.

MU
- L s

nference i Bickive
Unknown o Bctive Un
e Agent 1 o7 Moritaring 10

Agents who have the permission set to Disallow (the default) cannot see when they or other
agents are being monitored.

Note the following:

» When asupervisor begins supervising aqueue call, any call notes disappear from the Call
Monitor. Thisis because the notes are stored for the queue, not the agents. To see the call
notes, ook at the queue’s Call Log. Agent notes made after the call will show in the
agent’'s Call Log.

» TheCal Log does not keep arecord of whether agents were monitored.
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Managing agents’ status

With supervisor permissions, agents can directly control the status of other agentsin the queue
in the following ways:

e Signing agentsin or out of a queue

e Changing an agent’s personal status

Signing agents in or out of a queue

An agent who is signed in to a queue receives calls from that queue when ready. When signed
out, the agent is still amember of the queue, but does not receive queue calls. An agent who is
signed out can still view queue callsin the Call Monitor folder and answer them if necessary by
using the Take Call command.

Supervisors with the Sign In/Out other agents permission can use sign other agentsin or out of
aqueue. You can use this feature to move agents among queues without having to delete them
from one queue and add them to another. For example, if Kim works as an agent in the Sales
gueue in the morning and in the Support queue in the afternoon, a supervisor can sign Kim out
for the Sales queue at midday and sign her in for the Support queue.

Note: Agentswith the Queue Sign In/Out permission can sign themselvesin and out of the
gueue. See “Signing in and out of a queue” on page 10-5.

You can sign agentsin or out viaViewPoint or the User/Group Management applet inthe Global
Administrator Management Console.

Signing agents in or out via ViewPoint

Note: To perform the following steps, you must have the agent permission Sign In/Out other
agents (see“Agent permissions’ on page 3-9) and the general Wave permission Access Queues
folder.
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To sign an agent in or out via ViewPoint
1 InViewPoint, open the Queue Monitor folder by clicking itsicon in the Folder List.

2 If there are tabs for more than one queue, click the tab of the queue for which you want to
sign the agent in or out.

3 Inthe Agents pane, select the agent.
4 ChooseActions > Sign this agent into queue or Sign this agent out of queue. The command
signsthe agent in or out.

Signing agents in or out via the Global Administrator Management Console

Note: To perform the following steps, you must have the general Wave permission Access
Queues Folder.

To sign an agent in or out via the Queue dialog

1 If necessary, click the Administration tab in the Global Administrator Management

Console.
Click 2 Click the User/Group Management icon, located in the PBX Administration section.
. 3 Log on to the User/Group Management applet, which opensin aremote access window.
_; Once you log on, the Users view opens.
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4 Double-click the queue in the Queues view to open the Queue dialog, and then click the

Agents tab.

15ales - Queue

- Hueue Drefault wrap up for new agents in seconds: |1 5
Skills
m [~ If an agent does nat answer, set that agent to On Break
s [;;;EL:?::IWS After how many unanswered calls: |2
- Redirection
-Haold |Agent Overflow Tier ~ |
[#-Yoice Mail
- Caller Entry Cecilia 5t. John 1] |
- Dial-by-name Directory Lou Antander 1]
- Sacurity Mathaniel Chestrut 0
- Audio
- Recording
[#- Statistics
Add.. Edi. | Dekte |
QK Cancel | Help

5 Double-click the agent’s namein the Agents in this queue list. The Agent dialog opens.

General | Permissionsl Skills I

This agent is the following user: I Lou Antander j
Wirap up time in seconds: I‘IS—
Owerflow tier: ID—
[~ This agent iz an observer, not shown in Queus Monitor
[~ Automatically record this agent's calls
Becord 1 call out of eveny: |5—
Fecording direction: [Inbound and outbound =l
Send agent call recordings to: I thiz Agent j
Wwhen mailbax iz full IDeIete oldest call recording j
QK I Cancel | Help
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6 Select or deselect the This agent is signed in checkbox.
7 Click OK to close the Agent dialog.
8 Click OK to close the Queue dialog.

Changing an agent’s personal status

A agent who has the permission Change an agent’s personal status set to Allow can directly
change the personal statuses of agentsin the queue. A supervisor can use thisfeature in the
following situations:

* When agents are prevented from changing their own personal status. In this case you
must manage their workflow for them, changing their personal status to begin and end
their workday and to let them take breaks.

* When agents leave their phones and forget to change their personal statuses themselves.
In this case, you can set the personal statuses of the agentsto On Break.

* When the queue is configured to automatically place agents On Break if they let calls
from the queue go unanswered. In this case, you ensure that agents become ready when
they return to their desks.

* When agents leave for the day and are still ready. In this case, you can change their
personal statuses to make the agents unavailable.

Important: If agentsleave at the end of their workday without making themselves unavailable,
you must make them unavailable before the start of the next workday, or the reports data will
be inaccurate.

To change an agent’s personal status

1 InViewPoint, select the agent on the appropriate tab in any of the following locations:
* The Extensionsfolder
» The Extensions panein the Call Monitor folder
» The Agents pane in the Queue Monitor folder

2 Choose Actions > Apply Personal Status, and then select a personal status.
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Managing a queue’s voice mailbox

Agentswho have the permission Access queue mailbox set to View and Edit can manage voice
messages that callersleave in the queue's voice mailbox. They can listen to messages, reply to
them, and delete them. They also can create voice mailbox folders and move messages among
those folders.

Agentswho have the permission set to View Only can see and listen to voice messages, but not
perform any other commands on them.

To access the queue’s voice mailbox in ViewPoint, click voicemail in the navigation bar, then
click the folder with the queue’'s name in the Favorite Folderslist.

Managing queue voice messages on the phone

You can also manage a queue’s voicemail using the phone by logging in as the queue. When
logging in, use the queue’s extension and password.
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Starting and ending your shift, and taking breaks

Important: Do not use this section if you are not allowed to change your own personal status.
In that case, a supervisor will control your workflow. Talk to your queue manager or Wave
system administrator about how to work in the queue.

As a Contact Center agent, you control your workday by changing your persona status. At the
beginning of your shift, you make yourself ready. At the end of your shift, you make yourself

unavailable. While you are ready, you receive callsfrom all queuesfor which you aresignedin.
When you make yourself unavailable, queues stop sending calls to you.

Note: If you have to temporarily leave your phone during your shift, choose Wave's On Break
personal status.

The following sections describe which personal statuses to use to make yourself ready and
unavailable.
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Starting your shift

To start your shift and begin receiving queue calls, make yourself ready by doing either of the
following:

» Using your phone keypad, press either of the following at adial tone:
e *50. This selects the Available persona status.
» *51. Thisselectsthe Available (Queue Only) personal status.
* InViewPoint, select either of the following personal statuses:
* Available. You receive personal calls (callsto your extension) aswell as queue calls.
* Available (Queue Only). You receive only queue calls. Personal calls are sent
directly to your voicemail.

If you will be making outgoing calls from the queue, see “Placing calls from a queue vs. caling as
user” on page 10-10.

Ending your shift

Important: Use this procedure at the end of your shift only. To take a break during your shift,
usethe On Break personal statusto ensure theintegrity of Contact Center statistics. Seethe next
section, “Taking a break.”

To end your shift and stop receiving queue calls, make yourself unavailable by doing either of
the following:

» Using your phone keypad, press*52 at adial tone. This selects the personal status
Available (Non-Queue).

» InViewPoint, select any personal status whose Queue calls preferenceis set to No, other
than On Break. For example, select the Personal status Available (Non-Queue) to receive
personal calls without receiving queue calls.

Note: If you have marked your outbound calls as being from the queue, you must switch back
to caling asyourself. Otherwise your outbound callswill continueto be marked ascoming from
the queue (and may be monitored), even though you have ended your shift. See “Placing calls
from a queue vs. calling as user” on page 10-10.
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Taking a break

To take a break from answering queue calls during your shift, do one of the following:

Pick up the phone and press *53.
In ViewPoint, select the personal status On Break.

Note: Select the On Break personal status whenever you leave your phone during your shift,
even for ashort time. If you leave your phone without selecting On Break, queue calls might be
sent to your phone, and callers will hear an interval of ringing before they are placed back on
the queue.

When you finish your break and are ready to receive calls again, make yourself ready again. Press
*51 on your phone or select the personal status Available or Available (Queue Only).

What Contact Center agents need to know

If you are working as a Contact Center agent, be aware of the following:

While you are ready, always take queue calls that are sent to you. If aqueue call rings
your phone and you do not answer, Callers will continue to hear music on hold as the
system offers the call to the next agent.

If you do not take aqueue call that is sent to you, your performance statistics will indicate
amissed call. Also, depending on how your system is configured, your phone may
automatically be put into the On Break personal status after one or more missed calls,
which could adversely affect your performance statistics.

Use the On Break personal status only to leave your phone during your shift. Making
yourself unavailable by using other statuses, such as Available (Non-Queue) or Do Not
Disturb, signals Wave that you are ending your shift (these statistics are reset daily).

Your personal status can be changed by others. If you do not answer queue calls that
ring your phone, the queue can automatically place you in the On Break personal status.
Also, asupervisor can change your personal status at any time.

Agents, call forwarding and routing lists

Queue calls sent to you do not use your routing list, so they cannot try you at multiple locations.
Queue calls do follow your call forwarding / Where | Am settings.
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Working at different phones

If you need to work at a phone other than your default station, or if you have no default station
and alwayswork at avariety of phones, add the following steps to your routine:

1 When you first sit down at a new phone to receive calls, before marking yourself as
Available, log on and forward your callsto your current location. Otherwise, your Contact
Center performance might be logged under another agent’s name. Use either of the
following methods:

» Pick up the phone and log in by pressing # <extension> # <password>. After about 2
seconds you will belogged in. Press 5 1 to forward calls to your current location.

» Start ViewPoint. The Select Your ViewPoint Phone dialog opens. Select the second
logon option, Use station <x> to place and answer calls as <your name>. Check
Forward my calls to this station.

Select Your ¥YiewPoint Phone

‘fou are logging on ko station & (Yin Wiliams) but your default station is 5.

" Use station & as a visitor

¥ Lse station & to place and answer calls as Miri Anatolia
¥ Forward riy calls ko this station

= Use my default skation (skation 5)
= I am not near a TeleYantage phone

Description:

This phone is configured For Yin Wiliams, This option allows vou ko use this -
phone to place and answer calls with your account until someone else logs on,

Calls to you will not ring at this phone unless your calls are forwarded, You can
also use the Call Monitar to kake a call at this phione. Calls Far Vin Williams will LI

Press *0 on your phone ko hear your station 1D,

Cancel | Help |

2 After you have logged on, make yourself ready as described in “ Starting your shift” on
page 10-2.

3 When you are finished using a phone, log off by either picking up the phone and pressing
*0 0, or by exiting ViewPoint.
Note: When you are logged in at a station other than your own, voice message indicators

apply to you. For example, if you hear stutter dial tone or see amessage waiting light on the
phone, it means you have new voice messages.

See page B-3 for stepsto resolve a potential issue that may occur when you log off via*0 0
from a phone that is not your own.
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Signing in and out of a queue

You can be either signed in or signed out of each queue to which you belong. Only when you
aresigned in do you receive callsfrom the queue. When you are signed out of a queue, you can
see and affect its callsin the Call Monitor, but the queue does not send calls to your phone.
As an agent, you might be signed out for the following reasons:

* You are a supervisor who wants to observe a queue and manually take calls if necessary,
but you do not want queue calls to ring your phone.

* You arean agent who isamember of multiple queues, and you periodically change which
gueue you receive calls from. You receive calls only from the queues to which you are
signedin.

Note: Other agents with permission can sign you in or out of a queue.

You must have permission to sign yourself in or out of queues. If you do not have permission,
talk to your Wave system administrator about procedures for signing in and out.

To see if you are signed in or out of a queue

In the ViewPoint Queue Monitor and Call Monitor views, the tab for a queue displays an
asterisk (*) if you are signed out from that queue.

-
l | Technical Support |Sa|85* I

To sign in or out of a queue using ViewPoint
1 IntheViewPoint Cal Monitor, right-click a Queue tab at the bottom of the screen.

2 Click Sign me into queue or Sign me out of queue.
To sign in or out of a queue using the phone

Using your phone keypad, press *56 at adia tone. Enter the extension of the queue for which you
want to sign in or out followed by #, for example, “*56 102 #.
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Receiving and handling queue calls

You can receive and handle queue calls by using either the phone commands or ViewPoint.
When the queue sends a call to you, your phone rings and the call appearsin ViewPoint’s Call
Monitor folder. Queue callsignore your routing list and only ring your “Wherel Am” location
(your station or call forwarding number).
To answer a call, do either of the following:

* Pick up the phone.

* Click theincoming call inthe Call Monitor and choose Actions > Take Call. If your phone

ison-hook, it rings to connect you to the call.

After you are connected to a queue call, you can use most Wave call-handling features such as
transfer, park, mute, and so forth.
Note the following:

* You cannot use the Hold command on aringing queue call. You can only put a queue call
on hold after answering it.

* Your queue calls are not shared, even if you are sharing your Call Monitor folder.

Viewing your position in the queue

If you have permission to see ViewPoint’s Queue Monitor folder, you can useit to monitor your
position in the queue, and determine when you are likely to receive the next call. See
“Monitoring the position of agentsin the queue” on page 9-14.
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Being monitored or coached by a supervisor

Contact Center supervisors have the ability to supervise your queue calls on the following
levels:

* Monitoring. A supervisor may listen in on any of your calls without you or the caller
hearing. You will be unaware of the monitoring unless you have the permission View
agents being monitored. If you do, the monitor appearsin the Call Monitor as an
indented line under the call.

e Coaching. A supervisor may speak to you during a call without the caller hearing.
Coaching appearsin the Call Monitor as a separate line under the call. If you are being
coached, try not to speak to the coach, as the caller will not be aware of the coach’s
presence on theline.

e Joining. A supervisor may join your call, essentially creating athree-way conference call
in which all parties can hear each other.

By default, only queue calls can be supervised, not your personal calls. Thisincludesinbound queue
calls and outbound calls that you have associated with a queue (see “Placing calls from a queue vs.
caling asuser” on page 10-10).

Having your calls recorded
The queue may be configured to record some or al of your queue calls. You receive no
indication that acall isbeing recorded. The queue may be configured to place call recordingsin

your Inbox as new voice messages.

Your non-queuecallswill not be recorded unlessthe Wave system has been configured to record
al calls.
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Using the Call Monitor tabs

When you are an agent in a Contact Center queue, your Call Monitor folder displaysthe

following tabs:
A tab that shows the queu€e’s calls, with the name of the queue on it. If the tab name
appears with an asterisk, it means that you are signed out from that queue.

Note: You must have permission to seethistab. If you do not seeit, see your Wave system
administrator.

The My Phone tab, which shows all the calls that are being handled by your phone,
including any queue calls you have taken.

» The All tab, which shows all your queue and personal calls together.

|J| Status | Nurnber | Duratior
There are no items ko show in this view

| I

441 Histary | _J Motes

<Enter notes here =

My FPhone | Al Y| Sales I

If you are an agent in multiple queues, the Call Monitor displays atab for each queue.

Click the My Phone tab or a queue tab to view only the calls for that tab. Click the All tab to
view &l calls at once.

Note: Your Call Monitor folder may display other tabs than the ones described in this section.

Wave Contact Center Administrator Guide
July 2016

Wave 5.0



Receiving and handling queue calls 10-9

Chapter 10: Working as an Agent in a Contact Center Queue

Wrap-up time

After you finish aqueue call, you are given wrap-up time to complete any work relating to the
call. During your wrap-up time you will not receive any queue calls. Your Wave system
administrator sets how much wrap-up time you have.

While you are in wrap-up time, © appears in the ViewPoint status bar.

Terminating your wrap-up time early

To terminate your wrap-up time early and mark yourself as ready to take queue calls again,
using your phone keypad, press *54 at adial tone.

Viewing queue activity

The Queue Monitor in ViewPoint displays alist of agentsin the queue and up-to-date queue
statistics. You can useit to see the status of other agentsin the queue and your current position
in the queue, among other things.

To see the Queue Monitor folder in your ViewPoint, you must have the appropriate permission.
For a description of the Queue Monitor folder, see “Monitoring queue statistics’ on page 9-2.
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Placing calls from a queue vs. calling as user

If you are aContact Center agent and you placeacall at your desk using the phone or ViewPoint,
by default Wave treats the call as one made by you. You can choose instead to place callsas a
gueue, which may be necessary for your work as a Contact Center agent. When you place calls
as aqueue, Wave treats the call asif the queue placed it. Other agents can seeit in their Call
Monitors, it can be monitored by supervisors, and statistics and reports can accurately reflect
gueue activity.

When calling as a queue, your calls appear on both the My Phone tab and the queue tab in your
Call Monitor. Thecallsarelogged both in your personal Call Log and the queue's Call Log, with
the queue name in the From column.

Note: Inthe Call Monitor, Owner iswho you arelogged in as, while User iswho you are calling
as.

Important: When you are done placing calls as a queue, be sure to switch back to calling as
yourself. If you don't, your personal callswill be treated as queue calls, meaning they will be
seen by all agents and will throw off queue statistics.

To place calls as a queue using ViewPoint

On the ViewPoint status bar, your name and extension are a drop-down list. Pull down the list
and select the queue as which you want to place calls.

| 0 Items Iiri Anatolia (x555) e Available

Calling as Sales

Calling as Miri Anatolia

To switch back to calling as yourself, select yourself from the drop-down list.
To place calls as a queue using the phone
Pick up your phone and press *14<queue’s extension># at adial tone.

To switch back to calling as yourself, press*14# at adia tone.
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Determining who you are calling as

ViewPoint’s status bar displays whether the system istreating outbound callsfrom its station as
being from you or from someone el se.

You can also learn from whom a station is placing outbound calls by picking up the station and
pressing *0. The stationinformation recording includestheline, “ The current extensionis<Ext.>
caling as <Queue>."

e <Ext.>isthe extension of the last user who logged in at the station.

e <Queue> isthe name of the queue that outbound calls are marked as being from.

For example, the recording might say, “ The current extension is 555, calling as Sales Queue.”

Popping up caller information

You can use the Wave Contact Manager Assistant to pop up information about callers that you
have in another contact manager application. Callers must be contacts in one of the following
contact manager or customer rel ationship management applications:

* Act! 3.0, 4.0, 6.0, and 2000

* Goldmine 4.0 and 5.0, and Goldmine Business Contact Manager 5.7
»  Goldmine FrontOffice 2000

» Microsoft Outlook 98, 2000, 2003, and XP

For instructions on configuring the Wave Contact Manager Assistant, see its online Help.

Act! can pop up contact information on its own, without the Contact Manager Assistant.

Note: Your office might also use a custom screen pop application created with the ViewPoint
API. If thisisthe case, see your Wave system administrator for instructions on using it.
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Working remotely

If you have a mobile extension, you can work remotely using that phone. Y ou can work at
remote phone that is not a mobile extension by forwarding your calls to another number.
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About the Contact Center Reporter

The Contact Center Reporter allows you to run detailed reports on Wave call activity and phone
usage. By carefully tracking the relevant call activity, you can quickly identify how effectively
your phone system is being used by agents, queues, or trunks.

With the Contact Center Reporter, you can report on queue call activity and non-queue call
activity, aswell as analyze general system data.

You can configure each report to show information over any time period, from asingle day to
months or even years.
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Contact Center Reporter requirements

To run the Contact Center Reporter, you need the following:
e Microsoft Excel 2003 SP3 or higher must be installed on the ViewPoint PC.

*  Wave permission to run reports. You must have the permission Access Contact Center
Reporter set to “Allow”.

» A Contact Center Reporter licenseis required to run all reports except those listed below.
The following reports are available with no licensing requirements on all systems:

» Cdl Log report

» Grouped Service Level report

» Outbound Call Comparison report

»  Qutbound Calls By Phone Number report

e Outbound Long Distance Summary report
e Cadl Transfer report

» Unanswered During Business Hours report
* User Call Trends report

» Toavoid apotential error when running reports, you must obtain the following updates
from the Microsoft Download Center (www.microsoft.com/downloads) and install them
on the ViewPoint PC:

» KB955466 (Excel 2003 update)
» KB907417 (Office 2003 update)
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Running areport
This section describes how to start the Contact Center Reporter and run a report.

Note the following:

* You cannot run reports on time periods for which you have archived the Call Log.
Archiving removes information from the Wave database and makes it unavailable for
reports.

 If you arerunning the Contact Center Reporter on acomputer other than the Wave Server
(for example, on a ViewPoint PC), make sure that the clocks on the two computers are
synchronized. All report times and dates are based on the clock of thelocal PC whereyou
run the report.

» Torunsome reports, you must first define general Reporter Options. See“ Setting general
Reporter options” on page 11-8.

About report templates

Each report is based on areport template (XLT) file stored on the ViewPoint PC and reserved
for the Contact Center Reporter’s own use. When you run areport, you make changes to the
template’'s options.

Important: Do not modify Contact Center report template filesdirectly! If you modify
report templates in any way, your changes will be lost, because Wave regularly overwrites the
templates. If you want to permanently modify areport template, save the XLT file with a
different name so that it is not automatically overwritten by the Contact Center Reporter.

Backups of original reports

Because a user may accidentally overwrite a shared report (see “Making areport Shared or
Local” on page 11-11) by sharing one of his own reports with the same name, backup copies of
the original Wave report templates are provided in the Reports_backup directory in the Wave
Server directory.
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Using the Contact Center Reporter toolbar in Excel

Wave makes Contact Center Reporter options available to you from within Excel on the
Reporter toolbar. To display the Contact Center Reporter Toolbar, in Excel, choose View >
Toolbars > Contact Center Reporter Toolbar.

_] Mew Wave Repart %Export without Macros -1?] Repart Options  |#] Refresh Repart ‘? Help

Note: The Contact Center Reporter toolbar isonly availablein Excel if you open areport from

the Contact Center Reporter dialog, as described in the steps starting on page 11-5. (The
Reporter Toolbar isnot available if you open areport directly in Excel.)

The Contact Center Reporter toolbar offers buttons for the commands listed in the following

table.

B

New Wave Report. Opens the Reporter dialog or bringsit to the front if itis
already open, so that you can select areport to run. See “Running areport” on
page 11-3.

=7

Export without Macros. Savesthe report so that it can be opened in Excel on
any PC. Reports saved with macros can be opened only on PCs with Wave
applications installed.

I

Report Options. Opens the Report Options dialog for the report currently
showing, so that you can change the report parameters and run the report

again.

=

Refresh Report. Runs the report again with the same options as were used to
generate the current report. Use to update the report with the latest data.

Help. Opens the Contact Center Reporter online Help.
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To run a Contact Center report

1 InViewPoint, choose Tools > Reports. The Contact Center Reporter dialog opens.

I Wave Call Center Reporter =] B3
File Tools Help |

CeRAIZIXn|9

by £ Agent 1/ :51:18 AM o age by hiztory by displaying a row for every char

Activity History by Queue . 5 Qusue 1/8/2009 9:51:14 AM 'B Shows a history of all of the agent activity in a queue by displaying
Agent by Queue and Skill Configuration : 2 Spstem  1/8/2009 94956 AM 'B Shows agent configuration including Queue and Skill azsignment.
Agent Call Trends : 5 Agent 1/8/2009 9:50:34 Ak 'B By howr, day, or any time interval, shows number of call: an agent
Agent Performance by Skil : 5 Agent 14872009 9:50:18 Ak 'B Shows agent performance by =kill in a queue.

Agent Performance Trends by Queue . 5 Agent 1/8/2009 9:51:58 Ak 'B By howr, day, or any time interval, shows number of call: an agent
Agent State Summary : 5 Agent 1/8/2009 9:50:30 Ak 'B Shows the tatal time spent in each agent state for all queues to whic
Agent State Summary By Queue . 5 Queue 1/48/2009 9:50:28 AM 'B Shows the tatal time spent in each agent state for all agents in a qu
Average Wait Time and Call Volumne by Time of Day 5 Queue 1/8/2009 9:51:52 AM 'B By howr, shows average wait time and inbound call volume,

Call Center Queue Information . 2 Spstem 17842009 9:51:08 &AM 'B Shows all vital information for every Call Center Queue and a breake
Call Distribution by Skill and Queue . 5 Qusue 1/8/2009 9:50:14 AM 'B Shows Call distribution by skill and queue.

Call Distribution by Skills and Agent : 5 Agent 14872009 9:50:10 Ak 'B Shows Call distribution by skills and agent.

Call Log : & User 1/8/2009 9:50:58 Ak 'B By date range, shows an agent's or queue's call log entries

Call Result by Skill . 5 Qusue 1/8/2009 9:43:46 AM 'B Summarizes call result by skill

Call Summary : 2 Biling 1/48/2009 9:50:46 AM T Shows the number and average duration of internal, external, or all ¢ =
r'_Iu o P = c..,.;...r 440 1 I0Na 3-EN- 20 Akd B Clmisie Mo i imnbme o Hrass mme broisafor boeosk Hoob o ammmified o, _I—I
Description:

Shows an agent's activity history by displaying a row for every change in agent state, and how long the agent spent in each state, for all the queues ta which the agent belongs.

|Susan St Maurice 2

2 Double-click the name of the report that you want to run. The report template for that
report opens in Microsoft Excel and shows the options most recently selected for that
report.

If the following prompt regarding macros appears while Excel is opening, check Always
trust macros from this source. Then click Enable Macros.

Security Warning B
Call Center Queue Information. xt

conkains macros by

Artisoft, Incorporated ..._Ee_t-ﬂi:..__j

Macros may conkain viruses, It is always safe to disable macros, but if
the macros are legitimate, you might lose some functionality

V! Blways brust macros from this source.,

Enable Macros More Infa
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3 The Options dialog for the selected report opens. If it does not, click “fagerertostins o the
Excel Reporter toolbar. (See “Using the Contact Center Reporter toolbar in Excel” on page
11-4 if you do not see the Contact Center Reporter toolbar.)

4 Inthe Options dialog, modify the report parameters to focus on the time period or other
criteriathat you are interested in. See " Setting individual report options’ on page 11-10 for
more information.

5 Click oK. The report runs and the results are displayed in Excel. See the next section for
more information about viewing report results.

The Contact Center Reporter dialog remains open after you run areport. You can have
multiple reports open at once. To run another report, double-click another report name.

Viewing report results

This section describes the following:
e Using Excel tabsto view report results. See page 11-6.
» Viewing report headers and footers. See page 11-7.

For details about viewing a specific report, see “Available reports overview” on page 11-16.

Using Excel tabs to view report results

Most Wave reports contain the following tabs when the results are displayed in Excel:
* Report tab. A graphical presentation of the data, for example abar or pie graph.

» Datatab. A numerical presentation of the data, for example totals or averages for various
statistics.
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Note: Sometimes totals on the Data tab may appear to be incorrect. Thisis usually dueto
the way Excel presents numbers by rounding them to the number of displayed digits. The

displayedtotal isalwaysformed by taking the sum of the compl ete numbers, then rounding,
asin the following example:

6.47 6.4650
5.87 5.8699
Totals 12.33 12.3349

* Totals tab. A summary of the totals for the statistics counted in the report.
* Report Options tab. A worksheet showing the options currently selected for the report.

The Report Optionstab in Excel isfor users who want to print out the full workbook,
including arecord of the options selected. Macro writers and other skilled spreadsheet
users can also use the tab to generate reports without using the Report Options dial og.

Most users—who simply want to run areport and then review or print the results—should
instead click Report Options on the Reporter toolbar and change report options via the
Options dialog, as described in “ Setting Reporter options” on page 11-8.

Viewing report headers and footers

You must have aprinter installed on your PC in order to view the headers and footers on reports.
The headers and footersinclude such data as report title, agent and queue name, date range, date
printed, and the days of the week for the report.

If you do not have a printer (local or network) configured on your PC, the headers and footers
will be blank.
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Setting Reporter options

You set Reporter optionsin the following ways:

Setting general Reporter options. See page 11-8.

Setting individual report options. See page 11-10.

Setting general Reporter options

Some reportswill not run unlessyou havefirst set general Reporter options. To do so, you must
have Administrator permissions.

To set general Reporter options

1

From the Reporter, choose Tools > Options. The Options dialog opens.

h] Options E

—Toll free options

Enter toll free or local area codesfexchanges separated by commas:

500, 666,677,555

Example: 800, 77, 617, 508452, 508673

=
[

—In-state options

Label For in-state category: In-state

Enter in-state area codes/exchanges separated by commas:

Example: 617, 978, 508452, 508673

—Criteria For counting calls

Minimum outbound number length: |1D— digits

Minimum outbound call duration: |3— seconds
Minimurm inbound call duration: ID— seconds
Short: call duration: |1D— seconds

Cancel

Help

Wave 5.0
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2 Under Toll-free options, enter the prefixes of phone numbers that can be dialed for free
from the local Wave Server. These prefixesinclude your local area code aswell as any
toll-free area codes such as “800” and “888”. Separate entries with commas. You do not
need to enter long-distance prefix digits, such asthe“1” used inthe U.S.

If your entire local area code (for example, “508") cannot be dialed for free, you can enter
each free exchange within the area code as area code plus exchange, for example “508452,
508673".

3 Under In-state options, use the following fields to define how in-state calls appear on the
outbound call reports:

» Label for in-state category. Type the name for in-state calls that will appear on the
x-axis of reports that use this option.

* Enter in-state... Enter alist of area code and exchanges that are in your State but not
free, for example area codes in your State other than your local one. You do not need
to enter long-distance prefix digits, such asthe“1” inthe U.S.

4 Under Criteria for counting outbound calls, use the following fields to define which calls
are counted in various report categories:

e Minimum outbound number length. In North Americathisfield should be left at 10 so
that the reports pick up all long-distance calls. Further filtering, for example for the
Outbound Long Distance Summary report, will be provided by the toll-free and
in-state fields above.

e Minimum inbound/outbound call duration. These two fields ensure that the reports
count only calls that were connected. You can adjust the setting as desired. A setting
of 1 second is generally sufficient to include all connected calls.

e Short call duration. Enter the number of seconds at or below which acall is
considered a“short call” by various reports, such as the Agent Performance by Skill
report.

5 Click OK.
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Setting individual report options

The Options dial og opens automatically whenever you run areport so you can specify the report
parameters. You can also click Report Options on the Reporter toolbar to change areport’s
parameters and run it again, for example, with a different date range.

Different reportsoffer different options. For example, the following example showsthe Options
diaog for the Call Transfer report.

Fiepart on the following:

7 Queue: I HueusZ j

© User: I FKelley Bennett j

" igwPoint Group: I [ffshare j

Period: I Custom Date Range j
Stat 111172009 |
End: f11/11/2009 |
QK I Cancel | Help |

Other reports have different or additional options. Seetheindividual report descriptions starting
on page 11-20 for a description of the available options for each report.

When you are done specifying options for areport, click OK in the Options dialog to run the
report.
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Customizing Contact Center Reporter

This section describes the following:
e Making areport Shared or Local. See page 11-11.
* Reporting on outbound Contact Center calls. See page 11-12.
* Reporting on internal calls. See page 11-12.

Making a report Shared or Local

Reports can be either shared or local, as follows:

* Shared reports are stored on the Wave Server and can be run from any ViewPoint PC.
Shared reports are indicated in the Reporter dialog by &2 (blank report) or # (report with
data) in the Shared/Data column.

The default path for shared reports on the Wave Server is.

C:\Program Files\Vertical Wave Server\Reports

* Local reports are stored on the ViewPoint PC itself, and can only be run from that PC.
Local reports are indicated in the Reporter dialog by @ in the Shared/Data column.

The default path for local reportsis:

C:\Program Files\Vertical Wave\ViewPoint\Reporter\Reports
The reports that come with Wave are al shared reports.

To share a local report
1 Select the report in the Reporter dial og.
2 ChooseFile > Share.

After sharing areport, click the Refresh button @ on the Reporter dialog toolbar to see the
shared report in the Reporter dialog.
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Reporting on outbound Contact Center calls

For an agent’ s outbound callsto appear in reports, the agent must mark his or her outbound calls
as callsthat are placed from the Contact Center. See “Placing calls from a queue vs. calling as
user” on page 10-10.

Reporting on internal calls

Toinclude internal (station-to-station) call datain your reports, turn on internal call logging in
the Call Log.

To turn internal call logging on or off

1 Inthe Administrator, choose Tools > System Settings.

2 Click the Cdll Log tab.

{d System Settings

Category Call Log
[#- Server ¥ Logcalls
[#-Call Data i
- Organizations ¥ Log intemal calls

- Buziness Hours ¥ Log call histary events
- Dial-by-name Directory

[#- E-mail Motification
[+ Security
- Audio

Delete call history events older than |5 days

e drchive
- |nternal Dialing
- External Dialing
[#-Recordings
- Queue
[+- Storage

QK I Cancel | Help |

3 Tologinternal calls, select the Log internal calls checkbox. To stop logging internal calls,
deselect the check box.

4 Click oK.
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Printing and scheduling reports with the Report Runner

The Report Runner enables you to create a desktop shortcut for running and printing a report.
You can then run the report just by clicking the shortcut. You can choose whether to send the
report to a printer or save it asafile.

You can also use the Windows Task Scheduler to run the Report Runner at any timeand interval
you choose. See your Windows documentation for the Task Scheduler for more information.
Before you can run areport using the Report Runner, you must perform the following tasks:

» Preparethe report manually and saveit as an XLSfile.

» Create a Report Runner shortcut to run the report.

» Configure Report Runner options for the report.

To prepare the report

1 Run the report manually using the desired criteria for the user you want and for the period
you want, according to the steps starting on page 11-5.

2 When the report results are displayed, clear all tabs except for the Report Optionstab. To
do so, click the top left cell on each tab to select al of the cells, and then press Delete.

3 To set report options, such as queue name or selected hours, use the Report Optionstab in
your saved XL S spreadsheet file.
4 On the Report Options tab, do the following:
» Clear the date range in the “Period” row (column B).
* Clear the datain the “Days’ row (columns B and C).
* In“Days’ row (column B) enter 1,2,3,4,5,6,7.
* Inthe“Days’ row (column C) enter Sunday, Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday.
b Set any additional report options

6 Savethereport with adescriptive name, for example “User Daily Activity Template.xIs’.
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To create a Report Runner shortcut to run the report

7 Create adesktop shortcut to the Report Runner, Tvrrun.exe. The default location for the
Report Runner is:

C:\Program Files\Vertical Wave\ViewPoint\Reporter\TVRRun\Tvrrun.exe

For instructions on how to create a shortcut, see your Windows documentation.

To configure Report Runner options for the report
8 Right-click the new shortcut and choose Properties.

9 Inthe Target field, enter the pathname of the XL Sfile you created previously after the
pathname of the Report Runner itself. (See page 11-15 for examples of how to use the
Target field.)

10 Optionally, enter one or more of the following parameters:

* -C. Sendsthe charted report results displayed on the Report tab to your default
printer.

e -T. Sendsthe tabularized report results displayed on the Data tab to your default
printer.

* -5 <output file>. Printsthereport to afilewith the name and path that you
specify. If you enter -s but do not specify an output filename and path, the new report
will overwrite the source XL S file each time the report isrun.

Note: Do not use quotes around the output file path.

11 Click oK.
To run the report using the Report Runner, click its desktop shortcut.

Note the following:

» If areport generates no data, the existing report will be cleared anyway, so you will no
longer see the data from the last time the report was run.

» The“Days’ option in the template will beignored if the period is“Today” or
“Yesterday.” In that case the day used will be the appropriate one for the period chosen.
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Examples: Report Runner shortcut Target fields

This example sends the charted results of the Wait by Outcomel report to the printer:

C:\Program Files\Vertical Wave\ViewPoint\Reporter\TVRRun\
Tvrrun.exe C:\Program Files\Vertical Wave\ViewPoint\Reporter\
Reports\Wait by Outcomel.xls -C

In this example, the source XL Sfile of the User Activity report is overwritten with the new
report results.

C:\Program Files\Vertical Wave\ViewPoint\Reporter\TVRRun\
Tvrrun.exe C:\Program Files\Vertical Wave\ViewPoint\Reporter\
Reports\User Activity.xls -S

In this example, the User Activity report is written to the file Fred_Sanders.xIsin the Reports
directory. (Note that there are no quotes around the output file path.)

C:\Program Files\Vertical Wave\ViewPoint\Reporter\TVRRun\
Tvrrun.exe C:\Program Files\Vertical Wave\ViewPoint\Reporter\
Reports\User Activity.xls -S C:\Program Files\Vertical
Wave\ViewPoint\Reporter\Reports\Fred_Sanders.xls

Running the Report Runner without a command line statement

If you run the file Tvrrun. exe without modifying its command line, the system opens aHelp
topic that explains the Report Runner commands.

4 Report Runner E

The Report Runner command line switches determine how a report iz printed and saved after
being run by the Report Runner.

Syntax:  tvrunexe InputFile -C -T -5 DOutputFile

Input File Fequired Fath and filename of a Teleantage Report workbook
[.ul file] .

- Optional Frint the chart

-T Optional Frint the tabular report

-5 Output File Optional Save the report. |f no Output File is specified, the

Input File will be ovenwritten.

Example: c:Mvreportsibviun exe o h\vreportsiiwait by Outcomel . xls -C-T -5

In the above example, the ‘Wait by Outcome report is run, the chart and tabular report are
printed, and the input fil is replaced with the new repart.

Wave 5.0
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Available reports overview

You can produce the reports listed in the following table. For detailed examples of the reports, see
the sections referenced in the table.

Name Description

Activity History by Agent Shows an agent's activity history by displaying arow for every change in agent
report state and personal status, and how long the agent spent in each state and personal
(see page 11-20) status, for all the queues to which the agent belongs.

Shows a history of al of the agent activity in aqueue by displaying arow for every
change in agent state and personal status, and how long each agent in the queue
spent in each state and personal status. Shows data for all agent activity in the
gueue.

Activity History by Queue
report
(see page 11-22)

Agent by Queue and Skill

Configuration report Lists each agent, showing to which queues he or she belongs and which skills he or

(see page 11-24) she po '
Agent Call Trendsreport Shows the number of calls an agent made or received and the agent’s average talk
(see page 11-25) time.

Agent Performance Trends
by Queuereport
(see page 11-27)

By hour, day, or any timeinterval, shows number of calls an agent made or received
while working in a queue and average talk time.

Agent Performance by Skill
report
(see page 11-28)

Provides summary data showing how each agent in a queue performed in agiven
period by skill

Agent Sate Summary report By hour, day, or any timeinterval, shows the amount of time an agent spent in each
(see page 11-29) state for each queue to which he or she belonged.

Agent Sate Summary by
Queuereport
(see page 11-31)

By hour, day, or any time interval, shows the amount of time each agent spent in
each state for a queue.

Average Wait Time and Call

Volume by Time of Day By hour, shows average wait time and inbound call volume for a queue or View-
report Point Group.

(see page 11-32)
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Name Description

Call Distribution by Skill
and Agent report
(see page 11-33)

Provides a summary of how many calls were answered per selected agents and
selected skills.

Call Distribution by Skill
and Queuereport
(see page 11-35)

Provides a summary of how many calls were answered per selected queues and
selected skills.

By any time interval, shows all the information that appearsin the Call Log for the
entire system or the selected user or queue, in aspreadsheet form that is easy to sort
or filter.

Call Logreport
(see page 11-36)

Call Result by Skill report

(see page 11-38) Shows comparative call results for all callswith skill requirements.

Call Summary report By extension or workgroup, shows the total number of calls and the average dura-
(see page 11-39) tion of calls placed.

Call Transfer report By any time interval, reports on all of the calls transferred to another entity by a
(see page 11-41) user, Contact Center queue, or ViewPoint Group.

Call Trendsreport By hour, day, or any timeinterval, shows total outbound calls made by agentsin a
(see page 11-43) queue.

Call Volume by Account By account code, shows the number of inbound and outbound calls made using
Codereport each account code and the total talk time, for a user, queue, workgroup, or al calls
(see page 11-45) in the system.

By Wave contact, showstotal calls a user, queue, or workgroup received and aver-
age talk duration. For example, if you created 5 contacts, each to track a different
promotional advertisement code (using PIN numbers to identify each contact), this
report would show how many people called for each promotion.

Call Volume by Identified
Caller report
(see page 11-46)

Contact Center Queue Infor-
mation report
(see page 11-33)

Listsall general information for each queue in your system, including alist of all
agents and their settings.

Contact Center Queue Infor-
mation report
(see page 11-47)

By agent, shows total calls made and received and average talk time for any queue
or workgroup.
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Name

Description

Custom Datareport
(see page 11-50)

Total calls and average talk time associated with calls from a user, queue, or al sys-
tem calls, that are identified by a specific custom data variable. For example, an
auto attendant could be configured to set the “ Product” custom variableto “ Apples’
or “Oranges’ based on the menu choice selected. This report would show how
many callers selected Apples versus Oranges, and the average length of those calls.

Grouped Service Level
report
(see page 11-52)

By five-second increments, shows wait time for all calls that were answered by a
user.

Inbound Call Outcome
Trendsreport
(see page 11-54)

By hour, day, or any time interval, shows total calls handled by one agent, multiple
agents, abandoned, sent to voicemail, and the total number of calls for any queue.

Inbound Call Volume Trends

report
(see page 11-56)

By hour, day, or any time interval, shows the total calls a queue received, average
wait time, and longest wait time.

Outbound Call Comparison

report
(see page 11-57)

Shows the number and duration of outbound calls in the following categories:
In-state, Toll-free, and Other.

Outbound Calls by Phone
Number report
(see page 11-57)

Shows the number and duration of outbound calls placed to prefixes that you spec-
ify, for example 800 or 212.

Outbound Long Distance
Summary report
(see page 11-61)

By any time interval, shows your outbound long-distance phone traffic and esti-
mates your phone bill.

Queue Call History Detail
report
(see page 11-64)

Shows the call history for a selected queue, including the skill requirements for
each call.

Queue Comparison report

Compares al queues on total number of calls, average wait time, and total calls
handled, abandoned, and sent to voicemail. For example, you can see how well

(see page 11-64) your sales queue performs compared to your technical support queue.
Queue Performance Sum- Lists performance information for each agent in a queue, including inbound, out-
mary by Agent report bound, and internal call statistics, as well as the percentage of time spent in each
(see page 11-67) agent state.
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Name Description
Service Level report By wait time, shows the percentage of calls answered, abandoned, or sent to voice-
(see page 11-68) mail during atime range for a queue.

Service Level by Skill report By wait time, shows the percentage of calls with asingle skill requirement in asin-
(see page 11-70) gle queue that were answered, abandoned, or sent to voicemail.

Skill Assignment by Agent Shows which agents have which skills within which queues.

report
(see page 11-71)

Unanswered CallsDuring
Business Hoursreport
(see page 11-72)

By any time interval, shows inbound calls during your Wave business hours that
were not answered by a user.

User Activity report Pie charts showing the percentage of an agent's time spent in active versus other
(see page 11-74) statuses. Shows the kinds of calls that make up the active calls.

User Call Trendsreport

Shows the number of calls auser made or received and the user’s average talk time.
(see page 11-75)

Wait by Outcome report By hour, day, or any time interval, shows how long callers waited before their calls
(see page 11-77) were handled, abandoned, or sent to voicemail.
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Activity History by Agent report

TheActivity History by Agent report displaysarow for every changein agent state and personal
status, and how long the agent spent in each state, for all the queues to which the agent belongs.

Setting options: Activity History by Agent report

Important: Thisreport can return avery large amount of data, so you should runit only for the
date range required to avoid negatively impacting system performance.

Reading the Activity History by Agent report

Report tab

Thereis no Report tab for this report.

Data tab

The Data tab displays the following information:
» Time. Date/time at which the agent changed state.
* Personal Status. The agent’s history of personal status changes.
* Time in personal status. The amount of time spent in each instance of a personal status.

* Queue. Name of the queue in which this state change was made. A blank cell indicates
that the change applied to all queuesin which the agent was a member.

» State. The state to which the agent changed. For an explanation of states see“The Agents
pane’ on page 9-4.

* Duration. How long the agent remained in the state.
Filtering the Activity History by Agent report

To view all the entries of one type only, click the arrow button in any column header and select
the element you want to view. The report isfiltered to display only the records for that element.
For example, you could filter the State column for “ Standby” to see how many times the agent
was checking voicemail, or filter the Personal Status column for “On Break.”
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Totals tab
A B | c | D | E | =
Date Calls Answered Calls Placed Total Calls - All  Time on Calls Inbound  Time
1
| 47 |B/23/2005 21725 2:11:02 16:00:09
| 48 |B/24/2005 53921 1:45:00 15:59:39
| 45 |B/25/2005 a02:22 1.52:18 15:50:22
| 50 |B/26/2005 1:54:08 1:15:29
| 51 |B/25/2005 6:20:46 15:59:40
| 52 |B/30,/2005 2:20:28 2:55:00 18:36:03
| 53 |B/31/2005 5:46:56 21718 16:06:34
a4
| 55 | Totals 84:00:26 48:30:26 523:11:39 0:00:06 -
M 4 » M} Data }Totals { Report Options 14 | r
Ready P 0 Jeoml 0] 2

The Totals tab displays the following statistics for the agent for each date in the date range:
* Calls answered. Tota inbound calls answered.
» Calls placed. Tota outbound calls placed.
* Inbound calls. Total number of inbound calls
* Outbound calls. Total number of outbound calls.
» Total calls. Total number of callsincluding inbound and outbound.
* Time on calls. Total time on queue calls for inbound, outbound, and all calls.
* Avg. call. The average length of acall, for inbound, outbound, and al calls.
* First Activity. Time of the agents’ first state change that day.
* Last Activity. Time of the agents’ last state change that day.
* First Queue Call. Time of the agent’s first queue call that day.
* Last Queue Call. Time of the agent’slast queue call that day.
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Activity History by Queue report

The Activity History by Queue report shows arow for every change in agent state and personal
status, and how long each agent in the queue spent in each state.

Setting options: Activity History by Queue report

Important: Thisreport can return avery large amount of data, so you should runit only for the
date range required to avoid negatively impacting system performance.

Reading the Activity History by Queue report

Report tab

Thereis no Report tab for this report.

Data tab

The Data tab displays the following information:
» Time. Date/time at which the agent changed state or personal status.

» Agent. Agent’sname. Thefirst and last activity of each day is displayed in bold face for
each agent.

* Personal status. The personal status that the agent selected.

* Time in personal status. Thelength of time the agent spent in that iteration of the
personal status.

» State. The state to which the agent changed. For an explanation of states see“The Agents
pane’ on page 9-4.

» Time in state. The length of time the agent spent in that iteration of the state.

* Signed in/out. Displays when an agent signed in or out of the queue.
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Filtering the Activity History by Queue report

To view all the entries of one type only, click the arrow button in any column header and select
the element you want to view. The report isfiltered to display only the recordsfor that element.
For example, you could filter by The Agent column for “Melody Altan” to see the activity of
that agent only.

Totals tab

To view performance subtotals for each agent and totals for the queue as awhoale, click the
Totalstab at the bottom of the report.

2, E | C | 5] I E -
Date Agent  Calls Answered Calls Placed Total Calls - All
1

1524 |5/31/2005 Kilri Srith 1:56:47
1525 |8/31/2005 Mary Macanas 2:83:32 14:04:46
1526 |5/31/2005 Mike “ieira 4:28:08 15:37:54
1527 |5/31/2005 Feter Renzes 2:86:42 17:16:33
1528 |5/31/2005 Fenata Menitt 2:85:26 2:01:05
1525 |8/31/2005 - Totals 55:19:48 98:35:07
530
1531 | Totals 2170:40:40 245:05:44 3819:26:21_
532 et
M 4 » M4 Data }Totals { Report Options 14 | r
Ready e AN N R

The Totals sheet for the Activity History by Queue report displays the following statistics for
each agent and for the queue as awhole:

» Calls answered. Total inbound calls answered.

e Calls placed. Total outbound calls placed.

* Total calls. Total number of callsincluding inbound and outbound.

e Time on calls. Total time on queue calls for inbound, outbound, and al calls.

* Avg. call. The average length of acall, for inbound, outbound, and all calls.
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Agent by Queue and Skill Configuration report

The Agent by Queue and Skill Configuration report lists each agent, the queues each agent
belongs to, and the skills the agent possesses

Setting options: Activity History by Queue report

There are no report options for this report, which reports on al agents, all queues, and al skills.

Reading the Activity History by Queue report

A | B [ 5

1 |Agent Queue Skill
| 2 |Chris Brooks Sales Cueue Dos
| 3 | InstantOffice
| 4 | TeleVantage
| 5 | Unix
| 6 |
| 7 | Support Dos
| 3 | Unix

o
| 10 |Mark Zeeg Sales Cueue Dos
|11 | InstantOffice
| 12 | TeleVantage
| 13 | Unix

14
| 15 |¥ia0 Doarn Sales Cueue Dos
| 16 | InstantOffice
| 17 | TeleVantage
| 18 | Unix
| 19 |
| 20 | Support Dos
| 21 | Unix
| 22 |

2
144 » b1} Report ; Data / 4]
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Agent Call Trends report

The Agent Call Trends report displays the number of inbound and outbound calls an agent
handled, with the average talk time for each category.

Reading the Agent Call Trend report

Agent Call Trends - Jan Dowen
{2/25/2004 - 2125/2004)

120.00
= 100.00
+ 50.00
T 60.00
-+ 40.00
= 20.00
r 0.00

Calls

Talk Time

L R (I R L = st |
TR

& & & &S
I A A

Hours

&
BU O

||:|Inh0und Calls mmmm Outhound Calls —&— Average Talk Time Inbound (minutes) —s—Average Talk Time Outbound (minutes) |

Report tab

The Report tab displays the following information in a stacked bar chart:
» Interval. Each interval in the reporting period is labeled along the x-axis of the report.

e Calls. Total number of Inbound Calls and Outbound Calls per interval. Displayed as
stacked bars, and read against the |eft y-axis of the report.

e Talk Time. Average Talk Time Inbound (minutes) and Average Talk Time Outbound
(minutes) per interval. Displayed as two lines, and read against the right y-axis of the

report.
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Data tab
The Data tab displays the following information:

The following fields appear in this report:
* Time interval. Displays as the x-axis of the report.
* Calls. The number of calls. Displays as the y-axis of the report.
* Inbound calls / Outbound calls. Displays as different-colored bars.

* Average talk time Inbound/Outbound. In minutes. Displays as two lines.

Wave Contact Center Administrator Guide
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Agent Performance Trends by Queue report

The Agent Performance Trends by Queue report shows the number of calls a user made or

received for a particular queue and the average talk time. Personal calls—those sent directly to
or made from the user’s extension—are not included. Station-to-station callsare not included in

this report unless the Administrator selects the Log Internal Calls option.

Reading the Agent Performance Trends by Queue report

Calls

Agent Performance Trends by Queue - Agent's Name

(17112001 - 12131/2001)
160 1 800

120+

120

FOD $imem oo o
] Y

B & e B
w o s .\‘:9. \{9 P b -

WeEhS

Report tab

The Report tab displays the following information in a stacked bar chart:

Interval. Each interval in the reporting period is labeled along the x-axis of the report.

Calls. Total number of Inbound Calls and Outbound Calls per interval. Displayed as
stacked bars, and read against the left y-axis of the report.

Talk Time. Average Talk Time Inbound (minutes) and Average Talk Time Outbound
(minutes) per interval. Displayed astwo lines, and read against the right y-axis of the
report.

Wave 5.0
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The Agent Performance by Skill report provides summary data showing how each agentin a
gueue performed in a given period by skill. This report allows setting various thresholds on
Report Optionstab in Excel that are colored on the Report and Datatabs if those values exceed

the thresholds you specify.

Reading the Agent Performance by Skill report

A [ B B [ D | E [ B =
| 1| Agent Performance by Skills - Sales Queue BE
[ (5/1/2005 - 5/31/2005, 9:00 AM - 5:00 PM)

Short Calls
3 | Skill Date Agent Calls Answered Answered  Wrap Up Time
| 4 |DOS 05/23/2005 Mark Zernma 2 1] 0:00:10
5 Hiao Douy 1 1 0:00:20
| B | Summary 3 1 0:00:30
7
8 |English 05/23/2005 Hiao Douy 1 1] 0:00:10
| 9 | Summary 1 1] 0:00:10
10
| 11 |Spanish 05/23/2005 Mark Zemma 2 0 0:00:10
12 Hiao Douy 1 1 0:00:20
| 13 | Summary 3 1 0:00:30
14
15 [Unix 05/23/2005 Hiao Douy 1
| 16 | Summary 1
| 17 |
| 18 |Report Summary 8
1 19|
| 20 |
121 |
22
[4[«]» [»i}\Report {Data f Repart Cptions / |41

Thisreport isin dataform only. For each skill, it shows the queue performance of each agent

with that skill asfollows:

e Short Calls Answered. A call is considered short call if wait timeislessor equal to the
short call threshold (see “ Setting general Reporter options’ on page 11-8).

* Answered. The number of calls answered including short calls.
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* Wrap Up Time. The time between calls to finish up paper work.
* Talk Time. Thetota talk time on the answered calls.
» Average Talk Time. Talk Time/ (Answered + Short Calls Answered).

*  Work Time. Talk Time + Wrap Up Time.

Agent State Summary report

The Agent State Summary report shows how much time an agent spent in each state, with
separate displaysfor each queue to which the agent belonged. For an explanation of agent states,
see page 9-4.

Reading the Agent State Summary report

Agent State Summary - Jan Dowen
(2/26/12004 - 2126/2004)

90.00
§0.00
70.00
60.00
50.00 1
40.00
30.00
20.00
10.00
0.00 A

Total Duration {minutes)

Cust Serv Call Center Sales Call Center THL SMQ WRM Queue

O Signed out H Ready O Standby OWrap-up inbound  m Offering
O Mo answer | Active inbound mActive outbound  mWrap-up outbound m Dialing
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Report tab

The Report tab displays the following information in a stacked bar chart:

Queue. Each queue of which the agent is amember is labeled along the x-axis of the
report.

Total Duration (minutes). Total amount of time the agent spent in each of the following
agent states per queue. Displayed as stacked bars, and read against the left y-axis of the
report.

Signed out

Ready

Standby

Wrap-up inbound
Wrap-up outbound
Offering

No answer

Active inbound
Active outbound

Dialing

For the exact breakdown of thetime the agent spent in various agent states per queue, click
the Data tab.
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Agent State Summary by Queue report

The Agent State Summary by Queue report shows how much time each agent in a queue spent
in each state. For an explanation of the various agent states, see page 9-4.

Reading the Agent State Summary by Queue report

Agent State Summary By Queue - Sales Call Center
{11112004 - 1/31/2004)

50000.00
45000.00

T p— . fr—

L] 40000.00

£ 35000.00 4 - - —

£ 000000 4

=

_% 25000.00 +

S 2000000 - .

=]

- 15000.00 1

[}

E 10000.00 1 -

5000.00 1
0.00 - T T T T T T
Debbie Altman  Eric Lane Jan Derby Wark Dow tark Mike Bell  “icky Fringe
Finocchilezza

O Signed out H Ready O Standby OWrap-up inbound  m Offering
O Mo answer | Active inbound mActive outbound  mWrap-up outbound m Dialing

Report tab

The Report tab displays the following information in a stacked bar chart:
» Agent. Each agent in the queueis labeled along the x-axis of the report.
» Total Duration (minutes). Total amount of time spent in each of the following agent states
per agent. Displayed as stacked bars, and read against the |eft y-axis of the report.

¢ Signed out
¢ Ready
¢ Standby
¢« Wrap-up inbound
*  Wrap-up outbound
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Offering

No answer
Active inbound
Active outbound
Dialing

For the exact breakdown of thetime each agent spent in various agent states, click the Data
tab.

Average Wait Time and Call Volume by Time of Day report

The Average Wait Time and Call Volume by Time of Day report shows the average time that
callerswaited and the average call volume for all inbound calls to a queue or workgroup,
displayed by time of day.

Reading the Avg Wait Time/Call Volume by Time of Day report

Call Volume

Average Wait Time and Call Volume by Time of Day - Tech Support
(7/1/2001 - 7/31/2001) - Mon, Tue, Wed, Thu, Fri

L — 400

Wiait Time

Time of Cay

B Average Call Volume —— Average Wait Time (minutes) |
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Report tab

The Report tab displays the following information in a bar chart:
» Time of Day. Each hourly time period is labeled a ong the x-axis of the report.

» Call Volume. Average Call Volume (number of inbound calls) for each hourly time period.
Displayed as bars, and read against the |eft y-axis of the report.

* Wait Time. Average Wait Time (minutes) from the time the call arrived on the Wave
Server until it was answered by an agent. Displayed as aline, and read against the right
y-axis of the report.

Note: A cal islogged in the hourly time period during which it arrives on the Wave Server, not
the hourly period during which it is answered. For example, if acall arrivesat 1:59 PM and is
answered at 2:01 PM, it isincluded in the 1:00 PM period.

Call Distribution by Skill and Agent report

The Call Distribution by Skill and Agent report provides a summary of how many calls were
answered per agent and per skill. In the Options dialog you can select one or more agents, one
or more skills, and the report period. Thisreport allows setting various threshol ds on the Report
Optionstab in Excel that are colored on the Report and Data tabs if those values exceed the
thresholds you specify.
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Reading the Call Distribution by Skill and Agent report

Call Distribution by Skills and Agent
(5/1/2005 - 5/27/2005 9:00 AM - 5:00 PM)

2
PR
"
]
1 U S—
1 | E—
D T T
& *& o
o .
oS ® 4®
O English m Spanish ODOS O Unix
Report tab

The Report tab displays the following information in a side-by-side bar chart:
e Agent. Each agent islabeled along the x-axis of the report.

e Calls. Total number of callswith a skill requirement answered per agent. Displayed as
side-by-side bars, and read against the left y-axis of the report. Colored bars

Note: If acall has more than one skill requirement, that call is counted multiple times, oncefor
each skill.
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Call Distribution by Skill and Queue report

The Call Distribution by Skill and Queue report provides a summary of how many calls were
answered per queue and per skill. In the Options dial og you can select one or many queues, one
or many skills, and the report period. Thisreport allows setting various threshol ds on the Report
Optionstab in Excel that are colored on the Report and Data tabs if those values exceed the
thresholds you specify.

Reading the Call Distribution by Skill and Queue report

Call Distribution by Skill and Queue
{5/112005 - 5/27/2005 9:00 AM -5:00 PM)

Calls

0O = = k)R W ks
T R S B

oQQO

B English @ Spanish 0DOS O Unix |

Report tab

The Report tab displays the following information in a side-by-side bar chart:
* Queue. Each queueislabeled along the x-axis of the report.

» Calls. Total number of callswith askill requirement answered per queue. Displayed as
side-by-side bars, and read against the left y-axis of the report.

Note: If acall has more than one skill requirement, that call is counted multiple times, once for
each skill.
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Call Log report

The Call Log report shows all theinformation that appearsinthe Call Log for auser or aqueue,
in a spreadsheet form that is easy to sort or filter. Using Microsoft Excel’s drop-down filtering
tools, you can filter by any column to seejust the calls you want.

Thisreport should only be run for asmall number of days due to the quantity of datathat may
be produced.

Setting options: Call Log report

The following options are available for this report:
* One of the following:
* Queue. Select the queue to report on from the drop-down list.
e User. Select the user to report on from the drop-down list.

* All calls. Select this option to report on all calls, including callsinvolving agentsin
queues.

» Period. Select the time frame to report on from the drop-down list. If you select Custom
Date Range, select the range's Start and End dates.

Reading the Call Log report

Note: By default you can report only on your Call Log and all Call Logsthat are visibleto you
in ViewPoint (for example, aqueue's Call Log if you have permission to view it, and any Call
Logs that have been shared with you). To report on any Call Log, you must have the Wave
permission Report on all call logs set to Allow.

E [ F I H N hl
Start Time End Time Duration Result _ILeft MiNo Org Acci Answered By
1 - - - - |~ =] +
| 35 1011472002 7:06:29 PR 101142002 7:068:23 PR 00:00:00  Supervised transfer Mo Tech Support Afte
| 36 101472002 7:62:26 PR 10M142002 7:52:26 PR 00:00:00  Supervised transfer Mo Tech Support Afte
| 37 10152002 9:.02:04 AW 1011552002 9:.02:04 AW 00:00:00  Supervised transfer Yes Tech Support Afte
| 38 |10/15/2002 9:21:45 AM  10/15/2002 9:22:55 AWM 00:01:10  Connected Mo Rob Simsox
| 39 |10/15/2002 9:26:40 AM  10/15/2002 9:31:53 AWM 00:05:13  To voice mail Mo Shane Wilcoh
| 40 |10/15/2002 9:38:17 AM  10/15/2002 9:35:17 AW 00:00:00  Blind transfer Mo Shane Wilcoh
| 41 10152002 9:32:81 AWM 10M1502002 9:44:26 AWM 00:11:35 Ta vaice mail Mo Unknown
| 42 |10/15/2002 9:44:13 AM  10/15/2002 9:46:53 AW 00:02:40  Connected Mo Rob Simsox
| 43 101152002 9:43:41 AW 101552002 9:80:27 A 00:00:46  Connected Mo Unknown
44 101552002 2:50:33 AWM 101552002 2:55:56 AWM 00:05:23  To voice mail Mo Rob Simsox
| 45 [1NAE20N2 9-573-43 At TNARLNND 9-5R-57 Ak nn&s14  (Toownice mail Mn Shane Wilrnh

Wave 5.0

Wave Contact Center Administrator Guide

July 2016



11-37

Call Log report
Chapter 11: Running Contact Center Reports

Filtering Call Log data by column

To filter the report by column, click the arrow on any column header. From the drop-down list,
select the column entry that you want to display. The report shows only calls with that column
entry. Alternately, select Custom to filter by more complex criteria.

Y S|

Direction |

“|iTop 10...)
{Custom,..)
_| Inbound

Cuthbound

Examples of using the filter include viewing the following:
» All calswith account code 55 (Account Code column)
» All inbound or al outbound calls (Direction column)
» All calslonger than 30 minutes (Duration column, select Custom)
» All abandoned calls (Result column)
» All calsthat were automatically recorded by the queue (Recorded by Queue column)
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Call Result by Skill report

The Call Result by Skill report shows comparative call results for al calls with skill
requirements. In the Report Options dialog you can select which skillsto report on, and which
gueuestoincludeinthetotals, in addition to thereport period. Thisreport allows setting various
threshol ds on the Report Options tab in Excel that are colored on the Report and Data tabs if
those values exceed the thresholds you specify.

Reading the Call Result by Skill report

Call Result by Skill
(64512005 - 6/11/2005 9:00 AM - 11:00 PM)

9 120
8 f
e 1100
7 o
3
B 80 &
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0 i i : — 0
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m Ahandoned == *oice Mail CAnswered

Average Abandoned Wait Time —— Average Yoice Mail Wait Time —e— Average Answered Wait Time
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Report tab

The Report tab displays the following information in side-by-side bar chart:
» Skill. Each selected skill islabeled along the x-axis of the report.

» Calls. Total number of Abandoned, Voice Mail, and Answered calls per skill. Displayed
as side-by-side bars, and read against the |eft y-axis of the report.

* Average Wait Time (sec). Average Abandoned Wait Time, Average Voice Mail Wait
Time, and Average Answered Wait Time per skill. Displayed as three lines, and read
against the right y-axis of the report.

Each selected skill appears as a grouping along the x-axis. Colored bars corresponding to
different call results show how many calls had each result per skill.

Call Summary report
This report shows the total number of calls and the average duration of calls placed from an

extension or a ViewPoint Group. You can choose whether the report shows internal or external
cals.

Note: When internal callsis selected, the report includes users who are calling from trunks,
such as users with 1P phones or users calling from remote phones and logging in.
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Reading the Call Summary report

Call Summary - Sales (Field)
{2/25/2004 - 2125/2004) - All Calls
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Report tab

The Report tab displays the following information in a bar chart:

» User. Each user who placed acall from an extension or a ViewPoint Group is labeled
along the x-axis of the report.

* Number of calls. Total number of calls placed per user. Displayed as bars, and read
against the left y-axis of the report.

* Average Duration (minutes). Average duration of each call. Displayed as aline, and read
against the right y-axis of the report.

Data tab
The Data tab displays the following information:

The Data tab of this report shows Total Duration.
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Call Transfer report

Call Transfer report

This report shows how many calls were transferred during the reporting period, and to whom
the calls were transferred. You can report on all transferred calls, or on calls transferred by an
individual user, queue, or ViewPoint Group.

Setting options: Call Transfer report

The following options are available for this report:
* One of the following:
*  Queue. Queueto report on.
e User. User to report on.
* ViewPoint Group. Group to report on.
* All calls. Report on al transferred calls.

* Period. Time frameto report on. If you select Custom Date Range, you must aso specify
the range’s Start and End dates.

Wave Contact Center Administrator Guide
Wave 5.0 July 2016



Call Transfer report 11-42

Chapter 11: Running Contact Center Reports

Reading the Call Transfer report

E:I Call Transferl M= E3

Call Transfer - All users
(11/9/2009 - 11113/2009)

Number of Transfers
(8]

a f f f i i i
Eric Sawyer Musa Amodio Mian Archa Ben Dionne Samantha Tan Dan Sirma Mike Tarcha

Transfer Target

O Mumber of Transfers

M 4 » M[\Report {Data / Report Options /

Report tab

The Report tab displays the following information in a bar chart:

» Transfer Target. Each party to whom acall was transferred is labeled along the x-axis of
the report.

* Number of Transfers. Total number of transfers per transfer target. Displayed as bars, and
read against the left y-axis of the report.
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Data tab

The Data tab contains the following columns:

» Transfer Target. Each party to which a call was transferred is displayed asarow in the
report.

* Number of Transfers. Total number of callstransferred to the transfer target.

* Inbound Calls. Total number of inbound calls received by the transfer target.
Totals tab

Thereis no Totals tab for this report.

Call Trends report

The Call Trends report showstotal number of inbound and outbound callsfor a Contact Center
gueue by its agents. The agents must place calls as the queue for outbound calls to be reported
(see“Placing calls from a queue vs. calling as user” on page 10-10). Thisreport is useful for
tracking calls made to customers or calls made during marketing campaigns. It does not include
personal calls (calls made when the outbound queue-calling feature was not activated).
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Reading the Call Trends report

Call Trends - Tech Support Call Center
(6/17/2001 - 6/23/2001)
Eam i |

8] 16.00
&
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(1] 12.00
s0 10.00
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ki) 600
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1] T v T 000
] ] e
&' & ig e
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|- Inbound Calls B Cutbound Calls —— Average Talk Time Inbound (min) —— Average Talk Time Cuibound Lmirlll
Report tab

The Report tab displays the following information in a stacked bar chart:
* Interval. Each interval in the reporting period is labeled along the x-axis of the report.

e Calls. Total number of Inbound Calls and Outbound Calls per interval. Displayed as
stacked bars, and read against the left y-axis of the report.

e Talk Time. Average Talk Time Inbound (min) and Average Talk Time Outbound (mins)
per interval. Displayed astwo lines, and read against the right y-axis of the report.

Note: The entire call length isincluded in Talk Time, regardless of when during the call the
account code was entered.
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Call Volume by Account Code report

The Call Volume by Account Code report shows the inbound calls, total calls (inbound and
outbound), and talk timefor all callsfor which an agent entered an account code. Thisreportis
useful for billing customersfor service given to them over the phone or for tracking marketing
campaigns.
You can report on calls that used account codes from any of the following categories:

e All cdlshandled by aparticular agent or other user

» All cdlshandled by a queue, regardless of the agent involved

» All calssystem-wide

Reading the Call Volume by Account Code report

Call Volume by Account Code - Sales Queue
(1/1/2001 - 8/1/2001)
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Report tab

The Report tab displays the following information in a stacked bar chart:
* Account code. Each account code is |abeled along the x-axis of the report.

* Calls. Total number of Inbound Calls and Outbound Calls per account code. Displayed as
stacked bars, and read against the left y-axis of the report.

» Talk Time. Talk Time Inbound (minutes) and Total Talk Time (minutes) per account code.
Displayed as two lines, and read against the right y-axis of the report.

Note: Theentire call length isincluded in Talk Time, regardless of when during the call the
account code was entered.

by Identified Caller report

The Call Volume by Identified Caller report shows the number of callsauser or queuereceived
from each identified contact and the average talk time. For example, if you created 5 contacts,
each to track adifferent promotional advertisement code (using PIN #sto identify each contact)
this report would show how many people called for each promotion.

Note the following:

*  When reporting on aqueue, only callsfrom public contacts are listed, since the queue has
no personal contacts.

» When reporting on a Contact Center queue agent, all personal calls sent to the agent are
listed, even if someone else answered the call. Calls sent to other agents are not reported
on, even if the agent answered them.

Report tab

The following fields appear in this report:
» Contacts. Displays on the x-axis of the report. Public and private contacts are both listed.

» Calls. Thetotal number of calls from each contact. Displays as a bar for each contact.
Read against the |eft y-axis of the report.

» Average Talk Time. The average time the agent spent talking with each contact. Displays
asaline. Read against the right y-axis of the report.
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Contact Center Queue Information report

The Contact Center Queue Information report shows general information about each queuein
your system, including alist of agentsand their current settings. Usethisreport to get asnapshot
of aqueue's setup without using the Administrator.

Reading the Contact Center Queue Information report
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Thisreport isin dataform only. For each queue, it shows general information about the queue
on the top line. Below the queue ling, it shows the following information for each agent in the
queue:

e Extension. The agents extension.

» Signed in. Whether or not the agent can receive calls from the queue. See “Signing in and
out of aqueug’ on page 10-5.

» Observer. Whether or not the agent is an observer. Observer agents can monitor the queue
without being seen by other agents. See “Adding primary agentsto a queue” on page 3-4.

* Record Nth Call. How often Wave automatically records the agent’s queue calls.
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* Permissions. The agent’s permissions. See “ Agent permissions’ on page 3-9.

» Overflow tier. The agent’s overflow tier. See “Including a queue in the dial-by-name
directory” on page 2-16. A value of 0 indicates a primary agent.

* Skills. A list of the agent’s skills.

Cumulative Calls and Average Talk Time by Agent report
The Cumulative Calls and Average Talk Time by Agent report shows the total queue or

workgroup callsan agent received and made (inbound and outbound) and the averagetalk time.
The agent’s personal calls are not included in this report.

Reading the Cumulative Calls/Avg Talk Time by Agent report

Cumulative Calls and Average Talk Time by Agent - Queue 1
(11112001 - 6/13/2001)
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+ 160

- 140

Tatal Calls Talk Time:
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Report tab

The Report tab displays the following information in a stacked bar chart:

» Agents. Each agent in the queue is |abeled aong the x-axis of the report. There are two

additional labels:
* Unknown Agent(s). Used for calls involving agents who have been deleted from
Wave.

* Directly to Voice Mail. Used for calls that the queue sent directly to Voice Mail
without ringing any agent’s phone.

» Total Calls. Total number of Inbound Calls and Outbound Calls per agent. Displayed as
stacked bars, and read against the left y-axis of the report.

* Talk Time. Average Talk Time Inbound (minutes) and Average Talk Time Outbound
(minutes) per agent. Displayed as two lines, and read against the right y-axis of the
report.

Data tab

The Data tab displays the following information:
* Agents. Displays on the x-axis of the report.
* Unknown agents. Callsinvolving users who have been deleted from Wave.

» Directly to voicemail. Calls that the queue sent directly to voicemail without ringing any
agent’s phone.

* Inbound and outbound calls. Displays as stacked bars for each agent. Read against the
left y-axis of the report.

* Average Talk Time for Inbound and Outbound Calls. Displays astwo lines. Read against
the right y-axis of the report.
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Custom Data report

The Custom Data report shows the total number and average talk time of inbound calls
involving a specific custom data variable for a user, queue, or for al calls.

For example, you could configure an auto attendant to set the “Product” custom variable to
“Apples’ or “Oranges’ based on the menu choice selected. You could then run this report to
show how many callers selected Apples versus Oranges, and the average length of those calls.

Setting options: Custom Data report

The following options are available for this report:
* One of the following:
* Queue. Queueto report on.
e User. User to report on.
» All calls. Report on al calls, including calls involving agents in queues.
* Custom Data. Custom data variable to report on.

* Period. Time frameto report on from the drop-down list. If you select Custom Date
Range, you must also specify the range's Start and End dates.
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Reading the Custom Data report

Custom Data - Sales Call Center: Call Type
(2222004 - 2128/2004)
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||:|Inh0und Calls Average Talk Time Inbound {minutes) |

Report tab

The Report tab displays the following information in a stacked bar chart:

* Variable setting. Each possible setting for the specified custom data variable is labeled
along the x-axis of the report.

e Calls. Total number of callsthat involved the specified custom data variable. Displayed
as bars, and read against the left y-axis of the report.

* Talk Time. Average Talk Time (minutes) for calls that involved the specified custom data
variable. Displayed as aline, and read against the right y-axis of the report.
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Grouped Service Level report

Thisreport showswait timefor al external calls, displayed in five-second groupings. Wait time
includes the amount of time that the caller waited between the extension being dialed and the
user picking up, plus any time spent in ablind transfer later in the call. Note that wait time does
not include time that the caller spent on hold, parked, or in a supervised transfer.

Setting options: Grouped Service Level report

The following options are available for this report:
* One of the following:
e Organization. Organization to report on.
* ViewPoint Group. Group to report on.

» All calls. Report on al externals cals, including those involving agents in queues
and members of ViewPoint Groups.

* Period. Time frameto report on from the drop-down list. If you select Custom Date
Range, you must also specify the range's Start and End dates.
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Reading the Grouped Service Level report

Grouped Service Level - All Calls
(2/26/12004 - 2126/2004)
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Report tab

The Report tab displays the following information in a stacked bar chart:

e Wait Time (sec). Wait timesin 5-second intervals are labeled along the x-axis of the
report.
* 9% of Calls. Percentage of the total number of calls per each 5-second wait timeinterval.

Displayed as bars, and read against the | eft y-axis of the report. The total number of cals
is displayed at the bottom of the report.
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Inbound Call Outcome Trends report
The Inbound Call Outcome Trends report shows the total number of callsto a queue and how
those calls were handled, including the total calls handled by one agent, handled by multiple
agents, sent to voicemail, and abandoned.

Setting options: Inbound Call Outcome Trends report

The following options are available for this report:

* Period. Time frame to report on from the drop-down list. If you select Custom Date
Range, you must also specify the range’s Start and End dates.

Reading the Inbound Call Outcome Trends report

Inbound Call Outcome Trends - Sales Call Center
(5/1/2001 - 5/31/2001)
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Report tab

The Report tab displays the following information in a stacked bar chart:

Period. Each day in the reporting period is |abeled along the x-axis of the report.

Calls. Total number of calls per day. Displayed as stacked bars, and read against the left
y-axis of the report.

Each stacked bar displays the total number of calls per queue/period that resulted in any
of the following outcomes:

Handled - One Agent
Handled - Multiple Agents

Voice Mail. This outcome represents calls that went to Voice Mail while the queue
was sending callsto agents.
Abandoned

Directly to Voice Mail. This outcome represents calls that went to Voice Mail
because the queue was configured to send calls directly to Voice Mail.

For the exact number of calls that resulted in each outcome, click the Data tab.
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Inbound Call Volume Trends report

The Inbound Call Volume Trends report shows the number of calls that a queue received, the
average time callers waited, and the longest time a caller waited.

Note: If the queue was configured to send calls directly to voicemail, those calls are included
in the report and are treated as having await time of 0.

Reading the Inbound Call Volume Trends report

Inbound Call Volume Trends - Sales Call Center
(1112001 - 6/13/2001)
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Report tab

The Report tab displays the following information in a stacked bar chart:
* Interval. Each interval in the reporting period is labeled along the x-axis of the report.

* Inbound Calls. Total number of inbound calls per interval. Displayed as stacked bars, and
read against the left y-axis of the report.

*  Wait Time. Average Wait (minutes) and Longest Wait (minutes) per interval. Displayed as
two lines, and read against the right y-axis of the report.
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Outbound Call Comparison report

The Outbound Call Comparison report separates your outbound calls into three categories:
In-state, Toll-free, and Other. The In-state and Toll-free categories depend on your settingsin
the general Reporter Options dialog (see “ Setting general Reporter options’ on page 11-8).

Standard long-distance calls (calls made to non-free area codes) are included under “Other.”

Setting options: Outbound Call Comparison report

The following options are available for this report:
* One of the following:
e Organization. Organization to report on.
e All calls. Report on al outbound calls, including those involving Organizations.

e Period. Timeframeto report on. If you select Custom Date Range, you must specify the
range’s Start and End dates.
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Reading the Outbound Call Comparison report

QOutbound Call Comparison - All Calls
(2/26/12004 - 2126/2004)
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Report tab

The Report tab displays the following information in abar chart:

» Categories. Each category—In-state, Toll-free, and Other—is labeled along the x-axis of
the report.

* Number of Calls. Total number of outbound calls per category. Displayed as bars, and
read against the left y-axis of the report.

* Total Duration (minutes). Total duration of all outbound calls per category. Displayed asa
line, and read against the right y-axis of the report.
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Outbound Calls by Phone Number report

Thisreport counts the number and duration of outbound calls placed to a specified list of phone
number prefixes. Enter the prefixesin the Number prefixes field in the Options dialog for this
report (separate prefixes with commas).

Note: If your prefixes overlap, acall can show up in more than one column. For example, if
you enter a prefix of 6 and another of 617, calls beginning with 617 will be counted in both
columns.

Setting options: Outbound Calls by Phone Number report

The following options are available for this report:
» Oneof the following:
* Organization. Organization to report on.
* All calls. Report on all outbound calls, including those involving Organi zations.

* Number prefixes. One or more phone number prefixes to report on. Use commas to
separate multiple prefixes.

* Period. Time frame to report on from the drop-down list. If you select Custom Date
Range, you must also specify the range’s Start and End dates.
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Reading the Outbound Calls by Phone Number report

Qutbound Calls By Phone Number - All Calls
(2222004 - 2128/2004)
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Report tab

The Report tab displays the following information in a stacked bar chart:

* Number prefixes. Each prefix you selected to report on islabeled along the x-axis of the
report.

* Number of Calls. Total number of outbound calls per prefix. Displayed as bars, and read
against the left y-axis of the report.

* Total Duration (minutes). Total duration of all outbound calls per prefix. Displayed asa
line, and read against the right y-axis of the report.
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Outbound Long Distance Summary report

You can usethisreport to track your outbound long-distance phone traffic and estimate a phone
bill for agiven period. The chart displays the total number of outbound long distance calls and
the duration of each. The Data tab shows the estimated cost of your long distance calls.

Before running the Outbound Long Distance Summary report

You cannot run this report unless your system has been set up in the following way:
*  One or more Organizations are defined.

* In-state area codes are defined in the Reporter Options dialog.

Setting options: Outbound Long Distance Summary report

The following options are available for this report:
* Organization. Organization to report on.

» Period. Time frameto report on. If you select Custom Date Range, you must aso specify
the range’s Start and End dates.

* Interval. Interval by which results are to be reported (Hours, Days, Weeks, Months,
Quarters, Or Years).
Your long distance carrier can provide you with exact values to enter in the following fields:

* Cost per minute. Per-minute cost of your long distance calls. For example, to represent a
cost of 5 cents (US) per minute, enter .05.

* Cost interval in seconds. Length of each interval into which aminute is divided for the
purposes of calculating the cost of each call.
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Reading the Outbound Long Distance Summary report

QOutbound Long Distance Summary - ABC
(6/1/2003 - 6/712003)
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Report tab

The Report tab displays the following information in abar chart:
» Interval. Eachinterval in the reporting period is labeled along the x-axis of the report.

* Long Distance Calls. Total number of outbound trunk calls per interval whose numbers
do not begin with any of the digit sequences listed in the Toll free options field in the
Reporter Options dialog. Displayed as bars, and read against the |eft y-axis of the report.

e Duration. Total duration of all outbound long distance calls per interval. Displayed as a
line, and read against the right y-axis of the report.
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Data tab

The following fields appear on the Data tab of this report. Each is totaled at the bottom.

Interval. The time interval chosen.

Outbound calls. The total number of outbound trunk calls, long distance or otherwise.
Note that to count as an outbound call, acall must match the Criteria for counting
outbound calls defined in the Reporter Options dialog (see “ Setting general Reporter
options’ on page 11-8).

Long distance calls. Thetotal number of long distance calls.
Duration. The total duration of long distance calls for each interval.

Cost. Thetotal cost of long distance calls for each interval, based on the Cost per minute
and Cost interval in seconds datayou entered.
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Queue Call History Detail report

The Queue Call History Detail report shows the call history for a selected queue during the
selected time period, including the skill requirements for each call.

Reading the Queue Call History Detail report

1 K L M [ M [ 0 [

Bl Skills

2 Talk Time  Wrap Up Time Wait Time DOS Office TeleVantag Unix
| 3 | 0:00:.07 0:00:00 0:00:.07
| 4 | 0:00:05 0:00:15 0:00:12
| 5 | 0:00:05 0:00:15 0:00:06
| 6 | 0:02:08 0:00:15 0:00:03
| 7 | 0:00:08
| 8 | 0:00:06 0:00:15 0:01:11
| 9 | 0:00:13
|10 | 0:00:34 0:00:15 0:00:14 1 1
11| 0:01:21 0:00:10 0:00:03
112 | 0:00:27 0:00:25 0:00:03 1 1
113 | 0:00:44 0:00:10 0:00:04 1 1
| 14 | 0:02:38 0:00:10 0:00:28 1 1

15 0:00:51 1 1

el =] .m0 1 1

The report shows the following information for each call:
» Date and Time that the call entered the Wave system.

e Call ID. Thesystem ID number of the particular call. Call 1D can be displayed asacolumn
in the Call Monitor and Call Log (hidden by default), and it appears in the queue logs.

e DID. The DID number dialed, if any.

* Result. Whether the call was abandoned, answered, sent to voicemail, or redirected.
* Agent. The agent(s) who participated in the call.

e Statistics. The call’s wait time, talk time, and wrap-up time.

e Skills. The cal’s skill requirements.

Queue Comparison report

The Queue Comparison report compares the performance of all queuesin terms of total number
of calls, average wait time, and the number of calls handled, sent to Voice Mail, abandoned,
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redirected, and transferred out of the queue. For example, you can see how well the sales queue
is performing compared to the technical support queue.

Reading the Queue Comparison report

Queue Comparison
(21112004 - 212912004)
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Report tab

The Report tab displays the following information in a stacked bar chart:
* Queues. Each queueislabeled along the x-axis of the report.

* Total Calls. Total number of calls handled per queue. Displayed as stacked bars, and read
against the left y-axis of the report.
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Each stacked bar displays the total number of calls per queue that resulted in any of the
following outcomes:

e Handled

* Voice Mail*

¢ Abandoned

¢ Redirected*

¢ Transferred Out of Queue

For the exact number of callsthat resulted in each outcome, as well as a breakdown of the
Voice Mail and Redirected categories, click the Data tab.

Wait Time. Average Wait (minutes) per queue. Displayed asaline, and read against the
right y-axis of the report.

Data tab

The Datatab displays the following information:

Queues. Displays on the x-axis of the report.

Handled, voicemail, Abandoned, Redirected, Transferred out of Queue. Displays as
stacked bars. Read against the |eft y-axis of the report. For the exact number of each
category and a breakdown of voicemail and Redirected, click the Data tab.

Average wait time. Displays as aline. Read againgt the right y-axis of the report.
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Queue Performance Summary by Agent report

The Queue Performance Summary by Agent report lists performanceinformation for each agent
in aqueue, including inbound, outbound, and internal call statistics, aswell asthe percentage of

time spent in each agent state.

Reading the Queue Performance Summary by Agent report
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The report displays the following information for each agent:

* Signed In. Thetotal time the agent spent in all states other than “signed out.”
* Inbound/Outbound/Internal. The following statistics display for each category of calls:

e Count. Thetota number of calls.

* Average Length. The average length of those calls.

* %. The percentage of signed-in time spent on those calls.

* Percent Time Per Agent State. The percentage of signed-in time that the agent spent in

A N RaE N | E | |
| 1| Agent Duration Incoming Calls
2
3 Hame Ex Signed In Count_Average Length %
| 4 |Cristy Kramer o613 5:02:39 13 0:02:21 1.8%
| 5 |C3A- 5620 5620 0:00:00 0 0:00:00 0.0%
| B |Drew Hehdaon o624 17:17:18 24 0:02:43 6.7 %
| 7 |Kip Kerrick 5627 1:14:85 9 0:03:30 0.3%
| 8 |Leann YWirtala ak32 5:21:41 22 0:02:42 3.4%
| 9 |Rebecca Rissmann G621 16:00:00 1] 0:00:00 0.0%
| 10 |Sandy Smallack aE22 224540 7 0:03:37 1.8%
| 11 |Theresa Kruize SE26 19:37:26 4 0:02:22 0.8%
12
| 13 |Total 15:23:47 79 3:45:39
| 14 |Average 16:95:28 9.9 0:02:51 0.1%
15

each state—Ready, Standby, Active Inbound, Active Outbound, Wrap-up Inbound,
Wrap-up Outbound, Dialing, Offering, and No Answer.

* Work Time. Thetotal duration and the total percentage of signed-in time that the agent

spent in the Active (inbound and outbound), Wrap-up (inbound and outbound), and

Dialing states.
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Service Level report

The Service Level report tracks wait time by showing the percentage of callsto a queue that
have been answered, sent to voicemail, abandoned, re-directed, or transferred as wait time
progresses. Thetotal number of callsin each category is shown in parentheses at the bottom of
the report.

Note: In order to plot the curve smoothly on the chart, the curve only shows 100% of the calls
if thereisnot alarge difference between the 95th% and the 100th%. Frequently, there are afew
callsin aset of records that have an extremely long wait time before something happens to the
call. These calls can cause the plotted curve to seem very long and disproportionate. In these
cases, Wave plots only the top 95th% of calls (as shown in the preceding illustration).

Reading the Service Level report

Service Level - Tech Support Call Center
(111/2001 - 6/15/2001)

% of Calls.

The following fields appear in this report:
* Wait Time (sec). Displays on the x-axis of the report.

* % Answered. Displays as aline. Read against the x-axis and y-axis of the report to find
what percentage of calls reached aresult by that length of wait time.
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Service Level report worksheet totals

To view service level totals, click the Totals tab at the bottom of the report.

A [ B [ B [ o E [ £ [ G
"o Answered Tt Sent to Voice Mail "o Abandoned Redirecied Caller Transferred
1 |wrait Time (sec) fout of 7 calls) {out of 0 calls] fout of 2 calls) [our of 0 calls) fout of 1 callsy  Total Humber of Calls
2 1.0 1.0% “00.0% 0.2% 1w
|3 [=0 14.3% “00.0% 0.0%
2 [=n PARY% MN% 7%
5 (4.0 429% “00.0% 0.2%
B |50 E7.1% T00.0% 0.0%
¢ [14n 71 4% MN% 7%
G |Z40 714 ‘00.0% 100.0%
9 |=80 85.7% T00.0% 100.0%
1 [FAN N% MN% 10N 1%
11 ]
12

The Totals sheet for the Service Level report displays the following statistics by wait time for
the reporting period:

*  %Answered. Percentage of callsthat were answered.
* % Sent to Voice Mail. Percentage of callsthat were.
*  %Abandoned. Percentage of calls that were abandoned by the caller.
* Redirected. Total number of callsthat were re-directed for any of the following reasons:
» The queue wastoo busy.
» A cal exceeds the maximum wait time.
* The queue was closed.
» There were no agents with matching skills to take the call.
» Caller Transferred. Total number of callsthat were transferred to another number.

» Total Number of Calls. Total number of calls covered by the report.
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Service Level by Skill report

The Service Level by Skill report tracks wait time for calls with a single selected skill
requirement in a single queue by showing the percentage of calls that has been answered, sent
to voicemail, and abandoned as wait time progresses. The total number of callsis shownin
parentheses at the bottom of the report.

Reading the Service Level by Skill report

Service Level by Skill - Sales Queue I DOS
(64512005 - 6/11/2005 9:00 AM - 11:00 PM)
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The following fields appear in this report:
* Wait time. Displays on the x-axis of the report.

* 9% Answered. Displays asaline. Read against the x-axis and y-axis of the report to find
what percentage of calls reached aresult by that length of wait time.
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Skill Assignment by Agent report

The Skill Assignment by Agent report shows skills by agent by queue.

Setting options: Skill Assignment by Agent report

There are no report options for this report, which reports on al agents, all queues, and al skills.

Reading the Skill Assignment by Agent report

A [ B | B [
1 |Skill ~|Agent ~|Queue |
| 2 D03 Chris Brooks Sales Cueue
| 3 D03 Chris Brooks Support
| 4 DO Mark Zeeg Sales Cueue
| & |DO3 Hian Doarn Sales Cueue
| B DO Hiao Doarn Support
| 7 |English Hiao Dong Sales Queue
| 8 |English Hiao Doarn Support
| 9 |Spanish Mark Zeeg Sales Queue
| 10 |Unix Chris Brooks Sales Cueue
| 11 |Unix Chris Brooks Support
| 12 |Unix Hian Doarn Sales Cueue
| 13 |Unix Hiao Doarn Support
14
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Unanswered Calls During Business Hours report

The Unanswered Calls During Business Hours report shows external inbound calls during your
Wave business hours that were not answered by a user. Thisincludes calls that were answered
by another extension type, such as a queue or an auto attendant, but never picked up by a user.

Note: Thereport counts callsthat show aResult of “Abandoned” or “To voicemail” in the Call
Log. Because of this, callsthat auser answered and then sent to voicemail count as unanswered.

Setting options: Unanswered Calls During Business Hours report

The following options are available for this report:
» Oneof the following:
* Organization. Organization to report on.
e ViewPoint Group. Group to report on.

* All calls. Report on al calls, including those involving Organizations and members
of ViewPoint Groups.

* Period. Timeframeto report on. If you select Custom Date Range, you must also specify
the range’s Start and End dates.

* Interval. Interval by which results are to be reported (Hours, Days, Weeks, Months,
Quarters, Or Years).
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Reading the Unanswered Calls During Business Hours report

Unanswered Calls During Business Hours - All Calls
{6/1/2003 - 6/18/2003)

08
0B 50%
0.4
0z

% Unanswered

Unanswered Calls

e

&

Hours

||:|Unanswered Calls —=— % Unanswered |

Report tab

The Report tab displays the following information in a stacked bar chart:
» Interval. Eachinterval in the reporting period is labeled along the x-axis of the report.

e Unanswered Calls. Total number of unanswered calls per interval. Displayed as stacked
bars, and read against the left y-axis of the report.

* % Unanswered. Unanswered calls as a percentage of all calls per interval. Displayed asa
line, and read against the right y-axis of the report.
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User Activity report

The User Activity report breaks down an agent’s time by activity in pie-chart form, showing
both total activity and activity by queue. The Active Details pie chart appears only for agentsin
Contact Center queues.

Setting options: User Activity report

The following options are available for this report:
e Agent. Agent to report on.

* Period. Time frameto report on. If you select Custom Date Range, you must al so specify
the range’s Start and End dates.

* Hours. Enter the From and To times of day to report on. (This option is not available if
you specify aPeriod of Today.)

» Days. Oneor more daysto report on. (Thisoption is not available if you specify aPeriod
of Today.)

Reading the User Activity report

Call Activity - Agent 1
(7/1/2001 -7/31/2001 Mo, Tu, We, Th, Fr 9:00 AM - 5:00 PM)

Call Activity

Active Details

Wrasi i) - Cust Senv Cal Cemar |

g = - Sales Gl Corte |
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The User Activity pie chart shows the percentage of time that the user spent in each of severa
states. Thefollowing table showshow the states correspond to personal statusesand other states
for agents and non-agent users.

Sate Agent Personal Satus Non-Agent Personal Satus
Unavailable Available (Non-Queue) N/A
Available fvaae (Quese Only) Available
Break On Break In aMeeting .
In apersona call Out of the Office
Training In aMeeting N/A
Active In aqueue cal

User Call Trends report

The User Call Trends report displays the number of inbound calls received and outbound calls
placed by auser, including averagetalk time for each category. Setting optionsfor the User Call

Trends report
The following options are available for this report:
* Agent. Agent to report on.

* Period. Time frameto report on. If you select Custom Date Range, you must aso specify
the range’s Start and End dates.

* Interval. Interval by which results are to be reported (Hours, Days, Weeks, Months,
Quarters, Or Years).
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Reading the User Call Trends report

User Call Trends - Krista Cronin
(7/1/2009 - 7/8/2009 M, T, W, T, F, 6:00 AM - 6:00 PM)
70 3.00

'y

/ [

T 200

60

50
=2 40 E
® [
© =
] \ // .
30 + \ \ // \\
T+ 1.00
20 +— \ V
\ / \ + 0.50
10 +— \
0 T T T T T T T 0.00
71112009  7/2/2009  7/3/2009 7.’4.’2009D 7/5{2009  7/6/2009  7/7/2009  7/8/2009
ays
‘ == Inbound Calls mmm Cutbound Calls —ik— Average Talk Time Inbound {minutes) —8— Average Talk Time Outbound (minutes) |

Report tab

The Report tab displays the following information in a stacked bar chart:
» Interval. Eachinterval in the reporting period is labeled along the x-axis of the report.

e Calls. Total number of Inbound Calls and Outbound Calls per interval. Displayed as
stacked bars, and read against the left y-axis.

e Talk Time. Average Talk Time Inbound (minutes) and Average Talk Time Outbound
(minutes) per interval. Displayed as two colored lines, and read against the right y-axis.
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Data tab

The Data tab displays the following information:
» Interval. Eachinterval during the reporting period is displayed as a separate row.
* Inbound calls. Total number of inbound calls.
* Outbound calls. Total number of outbound calls.
* Average Talk Time Inbound (minutes). Average talk time per inbound call.
* Average Talk Time Outbound (minutes). Average talk time per outbound call.
* Total Calls. Total number of calls.

* Total Talk Time. Tota talk timein minutesfor al calls.

Wait by Outcome report

The Wait by Outcome report shows how long callers waited before their calls were handled,
abandoned, to voicemail, or transferred out of the queue.
The following fields appear in this report:

 Interval. Displays on the x-axis of the report.

* Average wait - Handled, Average wait - voicemail, Average wait - Abandoned, Average

wait - Transferred out of Queue. Displays as bars. Read against the y-axis of the report.

Note the following:

» Cadlsinwhich the caller pressed a key to go to voicemail are counted under voicemail.

» Cadllsthat are redirected to voicemail are not counted in this report.
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CHAPTER CONTENTS

Aboutcustomreports. . ... .. A-1
Connecting to the Wave database. .. ......... ... ... .. ... ... ... .... A-1
Wave database schema. . ........ ... . . . . e A-2

About custom reports
The database used for the Wave datais Microsoft SQL Server. By using athird-party reporting
application such as Microsoft Access®, Microsoft Excel®, or Crystal Reports® to query the
SQL Server database, you can create your own reports that report on Wave Contact Center and
other data.
This appendix provides the database schemain which Wave report datais stored in the SQL
Server database.

Connecting to the Wave database

To access Wave data, use the following settings:

Server <Your Vertical Wave Server name>

Database GDR

Login ID tv_browse

Password tv_browse_account

These settings provide read-only access.
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The Wave database contains the following tables that are used for reporting:

CallLog table (page A-3)

Partyl og table (page A-5)
QueueEncounter table (page A-8)
AgentStateChange table (page A-9)
UserStateChange table (page A-10)
PhoneBookEntry table (page A-10)
ExtensionSettings table (page A-11)
Agent table (page A-11)

QueueSkill Definitions table (page A-12)
PBEQueueSkills table (page A-12)
PBEQueueAttributes table (page A-12)
Personal Status table (page A-13)
Queue table (page A-13)

QueueSkills table (page A-14)
SkillRegL og table (page A-14)
UserPSChange table (page A-14)

As Contact Center agent-states change and calls are completed, the Wave Server uses SQL
Server-stored procedures to write the appropriate data into these tables for later reporting. In
some cases the stored procedures themselves calculate the values of other fieldsto improve the
performance of later dataretrieval.

Note: Not all columnsin all tables are listed.
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The CallL og table contains datafor each completed call. At the completion of each call, asingle
row is added to the table. The majority of columnsin the table contain redundant data that can
be found in other tables; they are included only to speed up dataretrieval for the Administrator
and ViewPoint application Call Log views.

The following are columns are unique to the CallLog table:

1D

Uniqueidentifier for the call.

Direction

Direction of the call from the point of view of the Wave Server:

0 = Inbound

1 = Outbound

2 = Internal (station to station)
3 = Conference

SartTime

Timestamp for when the call started. Thisis when the Wave
Server picks up the call.

SopTime

Timestamp for when the call ended. Thisis when the Wave
Server drops the call.

AssocPbel D

ID of the row in the PhoneBookEntry table that is associated
with thiscall. Thisis either the user or contact that one of the
users associated with the call.

AssocFirstName

First name of the associated person.

AssoclL astName Last name of the associated person.
- Number of seconds the caller waited before being connected

WaitTime .
with an agent.
Separated list of all PhoneBookEntry 1D values that were

PbeL ist involvedinthecall. Thisisused to speed performance of loading
the Call Log views.

PartyCount Number of partiesin the call.

AnsweredBy PhoneBookEntry 1D of the person who answered the call.

AnsweredByFirstName

First name of the person who answered the call.
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AnsweredByL astName

Last name of the person who answered the call.

PlacedBy

PhoneBookEntry 1D of the person who placed the call.

PlacedByFirstName

First name of the person who placed the call.

PlacedByL astName

Last name of the person who placed the call.

FromPhoneNumber

This column is not currently supported.

Thefollowing CallL og table columns are copies of datafrom the PartyL og table (see page A-5)
for either the “from” party (thefirst party in the call), the “to” party (the last party in the cal),

or both.

FromID TolD PartyPbel D
FromFirstName ToFirstName FirstName
FromLastName ToLastName PrimaryName
CallerIDName CallerIDName
Callerl DNumber ToPhoneNumber Callerl DNumber
CallerIDAccessCode ServiceAccessCode ServiceAccessCode
CallerIDType ToPhoneNumberType CallerIDType
CallerlDQ931Type sg‘;me’\' umberSb CallerlDQ931Type
CustomData CustomData
CallbackAddress CallbackAddress
Result Result
DIDNumber DIDNumber
DeviD ToDevID DeviD
Messagel D Messagel D

Dia String Dia String

Wave 5.0
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AccountCode AccountCode

The PartyLog table

The PartyL og table contains data for each party in a completed call. Each person in the call
counts as aparty, so there can be multiplerowsin thistablefor asinglerow inthe CallLog table.

The following are the columns in the PartyL og table:

ID Unique identifier for the party.

CalliD ID of the call that owns the party row.
ID of the row in the PhoneBookEntry table that is associated with
this party. Thisis either the user or contact that represents the

PartyPbel D party. If Wave does not know who the party is (for example, no
contact match) the column contains 33 which is the “unknown”
ID.

FirtName First name of the user or contact represented by the PartyPbel D

column.

PrimaryName

Last name of the user or contact represented by the PartyPbel D
column.

SartTime Timestamp for when this party was added to the call.
SopTime Timestamp for when this party was removed from the call.
CallerlDName Name portion (if any) for the Caller ID datafor this party.

CallerIDNumber

Number portion (if any) for the Caller ID datafor this party.

DeviD

Device number used for this party. Positive values are stations and
negative values are trunks.

M essagel D

ID of arow in the Message table for amessage (if any) left by this
party.

DialString

The exact sequence of digits dialed by the Wave Server for this
party.
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The direction for this party:
Direction 0=_Cadlee
1=_Cdler

What role the party played in the call:
3 = Peer
Role 13 = Coach
15 = Pupil
16 = Monitor

The reason this party was removed from the call:
0=Noreason

1 = Party hung up

2 = Party was hung up on

3 = Party abandoned call before anyone answered
4 = Party went to voicemail

5 = Party was blind transferred

6 = Party was supervised transferred

7 = Party was merged into a conference call

8 = Party isauser who logged in

9 = Party was sent directly to voicemail

10 = No answer

11 = Call was abandoned on this party

12 = Maximum login attempts failed

13 = Party was redirected by the queue (see the next entry)
14 = Transfer key was pressed by party

ReasonForLeaving

This clarifiesitem 13, “Party was redirected by the queue,” in the
previous entry. The possible reasons for redirection are:

1 = Maximum Wait Time Exceeded

2 = Queue Closed

3 = Queue Closed - No agents

4 = Maximum No. of Callers Exceeded

5 = Caller to Agent Ratio Exceeded

6 = Long Expected Wait Time

ReasonFor Redirecting

DIDNumber DID digits that were received from the device for this party.
AcceptedTime Timestamp for when this party accepted the call.
AnsweredBy ID of the user who accepted the call.
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ID of the workgroup that accepted the call (if any). In the case of a

GrouplD Routing List that calls several workgroups thiswill be the ID of
the one that accepted.
The type of phone number used for the Caller ID number:
CallerIDType 6 = Centrex number or Internal number (Internal if ServiceAccess-

Code is blank, otherwise Centrex)

CallerIDQ931Type

Whether phone number parsing rules were used:
0=No
8=Yes

Access code for the service used by the party. For outbound calls

ServiceAccessCode thisisthe dialing service selected. For inbound callsthisisthe ser-
vice that received the call (if known).
CustomData String containing any custom data written to the call for

third-party applications.

CallbackAddress

ID of arow in the Address table that describes the callback num-
ber the caller |eft.

Class value that represents what type of party thisis:
1301 = User

PartyClass 0901 = Queue
0501 = Contact
AccountCode Account code sequence (if any) entered for this party.
PartyNumber S_equence number (starting at 0) that determines the order the par-
ties entered the call.
ACDPartyNumber Thisfeature is not currently supported.

WrapUpDuration

The time an agent spent in wrap up after the call.
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The QueueEncounter table

Each inbound or outbound call for aqueue resultsin arecord in thistable. A cal that travels
from one queue to another queue will create two records in this table.

ID Unique identifier of the encounter entry.

CalllD ID of the CallLog entry for this encounter.

Queuel D ID of the Queue entry that had this encounter.

Time Timestamp for when the encounter occurred.
WaitTime Total time in seconds the caller waited.
AgentTalkTime Total time in seconds that agents talked to the caller.
Number Agents How many agents were involved.

Same as the ReasonForL eaving column in the PartyL og table (see

Result page A-6).
When the Result column is 13 (redirecting), this column contains
information asto why the call was redirected, as follows:
1 =Max wait time reached
2 = Queue closed
ReasonFor Redirecting 3 = Queue closed - no agentsin the queue
4 = Queue too busy - exceeded the number of agents
5 = Queue too busy - exceeded caller/agent ratio
6 = Queue too busy - expected wait time istoo long
7 = No matching skills
Direction of the call from the point of view of the Wave Server:
0 = Inbound
Direction 1 = Outbound

2 = Internal (station to station)
3 = Conference
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The AgentStateChange table

The AgentStateChange table contains data that tracks the state of agents.

Pbel D ID of the PhoneBookEntry row that represents the user.

ID of the queue row that represents the queue that this change was

Queuel D madein.

Time Timestamp for when the user entered the state.

Duration Number of seconds the user was in the state before it changed.

The state the agent was in before the change. The state values are:
0 = Logout

1=Available

2 = Standby

3 = Wrapup

4 = Offering

5= No answer

6 = Active

7 = Active outbound

8 = Wrapup outbound

Sate

The state the agent was in after the change. The state values are

ToSate the same as the Sate column values.
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The UserStateChange table

The UserStateChange table contains data that tracks the state of users.

Pbel D ID of the PhoneBookEntry row that represents the user.
Time Timestamp for when the user entered the state.
Duration Number of seconds the user wasin the state before it changed.

The state the user was in before the change.

The state values are:

0= Sign out

1 = Ready

2 =Break

3 =Training

4 = Unavailable

5=ACD Active. Thisfeatureis not currently supported.

6 = Non ACD Active. Thisfeatureis not currently supported.
7 = Sign out Active

Sate

The state the user wasin after the change. The state values are the

ToSate same as the Sate column values.

The PhoneBookEntry table

Most types of Wave extensions (users, auto attendants, queues, etc.) have an entry in the

PhoneBookEntry table.
]
ID Unique identifier of arecord.
Primary Name Last name.
FirstName First name.
EntryType 1=User

21 = Contact Center queue.
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The ExtensionSettings table

Many types of Wave extensions (users, auto attendants, queues, etc.) have an entry in the
ExtensionSettings table.

Same number as the corresponding record in the PhoneBookEn-

D try table.
Number Extension number.
0= Normal user
User Type 1= ACD workgroup user. Thisfeature is not currently supported.
yp Use this column and Entry Type in the PhoneBookEntry table to
find out if arecord isfor anormal user or a queue.
LastAppliedSatusi D The current personal status. Refer to the Personal Status record.
Agent table

Each agent in aqueueresultsin arecord in thistable.

Queuel D Refer to PhoneBookEntry record.
UserlD Refer to PhoneBookEntry record.
0=Signedin.
Observer 1= Signed out.
0= Agent.
RealObser ver 1 = Obsarver.
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QueuesSkillDefinitions table

The system-wide skill list is saved in this table.

ID Uniqueidentifier of each skill.

Name Name.

PBEQueueSkills table

Agent skills are saved in this table.

ID Refer to agent/user's PhoneBookEntry record.
SkilllD Refer to QueueSkill Definitions record.
ProficiencyValue The proficiency value.

PBEQueueAttributes table

Agent attributes are saved in this table.

ID Refer to agent/user's PhoneBookEntry record.
Cost Agent's Cost.

Customl Agent's Custom1 value.

Custom?2 Agent's Custom2 value.

Custom3 Agent's Custom3 value.
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PersonalStatus table

Each personal status for each user has arecord in thistable.

ID Unique ID to identify the record.
OwnerlD Refer to user's PhoneBookEntry record.
Name The internal name that will be trandlated into localized names
when used.
0 = User's custom personal status.
| sSystem 1 = System created personal status.
Queue table

Each queue defined in the system has arecord in thistable.

ID Same number used in PhoneBookEntry table.

0=Top Down

1 = Round Robin

2 = Longest Idle Agent
DistributionType 3 = Fewest Call

4 =Least Tak Time

5 = Simultaneous

6 = Skill-based Custom Routing
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QueueSkills table

Each skill defined in a queue has arecord in this table.

QueuelD Refer to PhoneBookEntry record of the queue

SkilllD Refer to QueueSkillDefinitions record of the skill.

SkillRegLog table

For each skill requirement of acall, thereisarecord in thistable.

ID Unique identifier of arecord.

CalliD Refer to the record in the CallLog table.

sSkilllD Refer to the record in the QueueSkillDefinitions table.
MinReq Minimum requirement for the skill of the call.
MaxReq Maximum requirement for the skill of the call.

UserPSChange table

Each user personal status change resultsin arecord in thistable.

ID Unique identifier of arecord.

Pbel D Refer to the user's PhoneBookEntry record.

SartTime The time of the change.

SatusiD The personal status a user changed to, reference the Personal -
Status table record.

Duration The duration user stayed in this personal status.
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Troubleshooting queue behavior using queuelogs .. ..................... B-1
Troubleshooting agentissues . ........ ... ... . i B-3

Troubleshooting queue behavior using queue logs

Queuelogs can be an inval uabl e troubleshooting tool, hel ping you determine exactly why acall
did or did not go to a given agent. It can be especially useful to see the inner workings of
skills-based or custom routing.

Queue logs are text file logs that show the step-by-step logic of queue routing in easy-to-read
detail. The logs list every action taken in or by the queue with timestamps showing when it
occurred, including:

» Agentssigning in or out or changing status
* New callsarriving

» The process of filtering agents

» The numbers used to score available agents

» The numbers used to score waiting calls

Enabling queue logging

To enable queue logging:

1 Edit the queue in the Queue dial og.

2 Onthe Queuetab, check Trace queue and agent activity to queue logs.
3 Click oK.
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About queue log files

When enabled, queue logs are created on the Wave Server in the following location:

C:\Program Files\TeleVantage Server\Logs

Queue log files are incrementally named using the format TV Queue* .txt for example,
TVQueuel.txt, TVQueue2.txt, and so forth.

The maximum size of a queue log fileis 4MB, and by default the maximum number of queue
log filesis 20. When 20 4MB files have been created, the Server begins overwriting the old files
beginning with TV Queuel.txt.

To modify the maximum number of queue log files:

1 Add/Edit the following DWORD registration key on the Wave Server:

HKEY_ LOCAL_MACHINE\SOFTWARE\Artisoft\TeleVantage\Server\Settings\Qu
eueNumLogs

2 Set the value to the number maximum queue log files to create before overwriting.

Viewing queue logs

You can open aqueue log text filein Notepad or other text editor.

.,J Tv¥Queue.TXT - Notepad [_ (O] %]
File Edit Format Help

[05/05,/05 21:49:32.665 - 934 - TID 0x934 ] starting TwQueue Log i’
[05/05/05 21:49:32.680 - 934 - TID 0x934 IR LR L LR bbb
[05/05,/05 21:49:32.680 - 934 - TID 0x934 ] computer name: 'TELEVANTAGE'

[05/05,/05 21:49:32.680 - 934 - TID 0x934 ] process dd: 2344 (C:ZProgram FileshTelevantage
[05/05/05 21:49:32.680 - 934 - TID 0x934 IR AL L LR LR bbb
[05/05,/05 21:49:32.680 - 934 - TID 0x934 ] max Tog size: 4mhb

[05/05,/05 21:49:32.680 - 934 - TID 0x934 ] max num Togs: 20

[05/05,/05 21:49:32.680 - 934 - TID 0x934 ] min log hours: 0

[05,/05,/05 22:02:00.211 - 954 - QCT ] A\.ra"l'lag'le agent Leehi Burkest (x175) signed int
[05/05,/05 22:02:00.211 - 954 - QCT ] Finding the highest scored <all 9n TML sSmQ
[05/05,/05 22:02:00.211 - 954 - QCT ] TML EMQ has no waiting calls

[05/05,/05 22:02:00.211 - 954 - QCT ] Mo waiting call now, agent Leehi Burkest (x17
[05/05,/05 22:02:03.961 - 954 - QCT ] available agent Leehi Burkest (xLls5) signed int
[05/05,/05 22:02:03.961 - 954 - QCT ] Finding the highest scored <all 9n TML sSmQ
[05/05,/05 22:02:03.961 - 954 - QCT ] TML EMQ has no waiting calls

[05/05,/05 22:02:03.961 - 954 - QCT ] Mo waiting <all now, aient Leehi Burkest (x17
[05/05,/05 22:19:52.274 - 954 - QCT ] available agent Leehi Burkest (xLls5) signed int
[05/05,/05 22:19:52.274 - 954 - QCT ] Finding the highest scored <all 9n TML sSmQ
[05/05,/05 22:19:52.274 - 954 - QCT ] TML EMQ has no waiting calls

[05/05,/05 22:19:52.274 - 954 - QCT ] Mo waiting call now, agent Leehi Burkest (x17
[05/05,/05 22:58:46.758 - 954 - QCT ] available agent Leehi Burkest (xLls5) signed int
[05/05,/05 22:58:46.758 - 954 - QCT ] Finding the highest scored <all 9n TML sSmQ
[05/05,/05 22:58:46.758 - 954 - QCT ] TML 5MG has_no waiting calls |

[05/05,/05 22:58:46.758 - 954 - QCT ] Mo waiting call now, agent Leehd Burkest (x17
[05/06/05 04:39:27.463 - 954 - QCT ] availahkle aﬁent keith Boreg(x220) signed into -
[05/06/05 04:39:27.463 - 954 - QCT ] Finding the highest scored call in Tech Suppi,
« | _>I7I
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Note that each call islisted with its Call ID number in parentheses. You can view the Call 1D
number in the Administrator or ViewPoint Call Log by showing the Call ID column (hidden by
default). Call ID also appearsin the Queue Call History Detail report (see page 64).

Troubleshooting agent issues

Problem: When an agent at a phone other than his or her own logs out with *0 0, the agent’s
hook state can remain red (off-hook) indefinitely.

Resolution:

1

Add the following registry key on the Wave Server:

HKEY_LOCAL_MACHINE\SOFTWARE\Artisoft\TeleVantage\Server\Settings\Mo
nitorLocPbe

Set the value to 1.
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*50 (select Available personal status) 10-2

*51 (select Available Queue Only personal status)
10-2

*52 (select Available non-Queue personal status)
10-2

*53 (select On Break persona status) 10-3

*54 (terminate wrap-up time) 10-9

*55 (hear queue statistics) 9-17

*56 (signin or out of aqueue) 10-5

A

account codes report 11-45
Activity History by Agent report 11-20
Activity History by Queue report 11-22
Agent by Queue and Skill Configuration report
11-24

Agent Call Trends report 11-25
Agent diaog 3-4
Agent Performance by Skill report 11-28
Agent Performance Trends by Queue report 11-27
agent scoring

overview 7-18

formula 7-21

in queue logs B-1
Agent State Summary by Queue report 11-31
Agent State Summary report 11-29
agent states, defined 9-5
agents

adding to aqueue 3-4

assigning skillsto 7-5

changing order of 3-12

changing personal status 9-24
configuring ringback 5-9

defined 1-7

disallowing personal status change 3-11
handling queue calls 10-6
hot-desking 3-13

monitoring, coaching, and joining calls 9-18
overflow groups 3-14

performance trends by queue 11-27
permissions 3-9

placing automatically On Break 4-6
placing on and off call 9-21
recording calls 3-7

roaming 3-13

setting default permissions 3-3
viewing skills 7-16

viewing them being monitored 9-20
working at another phone 10-4
working remotely 3-13

Agents Pane 9-4
attributes, assigning to users 7-5
audio controls 1-8
audio recordings
creating 1-8
auto attendant menu choice
creating for queues 2-14
auto attendants, adding skill requirements with 7-6

Average Wait Time and Call Volume by Time of
Day report 11-32

B
backup reports 11-3
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c

Call Distribution by Skill and Agent report 11-33
Call Distribution by Skill and Queue report 11-35
Cadl ID number B-3
Call Log

queue activity in 2-24
Cdl Log report 11-36

Call Monitor
tabs for contact center agents 10-8

call priority 4-9
Cadll Result by Skill report 11-38
call rules, applying to queue calls 8-9
call scoring
overview 4-7
in queue logs B-1
timein queue vstimein system 4-8
with call priority 4-9
with skills 7-17
Cal Summary report 11-39
Call Transfer report 11-41
Call Trendsreport 11-43
Cadll Volume by Account Code report 11-45
Call Volume by Identified Caller report 11-46
callback phone number, setting option, for callers
2-13
callback phone numbers, setting option, for callers
on hold 5-16
caller ID, setting for outbound queue calls 2-25
coaching agents’ calls 9-18
conditional Hold prompts 5-14
contact center
agent availability 10-1
agent workday procedures 10-1
determining if you are on call for a queue 10-1
ending your shift 10-2
ready 10-1
starting your shift 10-2
taking abreak 10-3

taking breaks 10-1
terminology for 1-7
unavailable 10-1
user activity report 11-74
using Contact Manager Assistant 10-11
viewing pop-up information about acaller 10-11
wrap-up time 10-9
contact center agents
Call Monitor view tabs 10-8
signing in and out 10-1
taking breaks 10-1
contact center featurelist 1-3
contact center queue
callback 5-16
adding prompt to hold menu 5-17
callback statistics 5-17
setting up 5-18
Contact Center Queue Information report 11-47
Contact Center Reporter
overview 11-1
requirements 11-2
using Excel toolbar 11-4
contacts
report on call volume 11-46
sharing with a queue 8-9
cost, assigning to users 7-6
Cumulative Calls and Average Talk Time by Agent
report 11-48
Custom Data report 11-50
custom data variable, for call priority 4-11
custom data variables
overview 6-12
for conditional Hold prompts 5-15
for storing entered information 5-2
custom reports A-1

D
dataentry by callers 5-2
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database connection settings A-1
database schema A-2
default wrap-up time and permissions, setting 3-2
deleting

gueue 6-16
dial-by-name directory, listing queuesin 2-16
distribution algorithms 4-1

E

Examples
call rule for special Welcome message 8-10
conditional Hold prompt 5-15
printing reports with Report Runner 11-15

Excel, using reports toolbar in 11-4
expected wait time, improving 6-3
exporting

voicefiles 1-9
extensions for queues 2-6

F

featurelist 1-3
fewest calls distribution 4-1, 4-3
files

importing and exporting 1-9

G

greetings 2-11
creating 1-8
Grouped Service Level report 11-52

H

headers and footers, viewing in reports 11-7
hold

music for 5-7
options while waiting on 5-10
Hold Prompt dialog 5-12

Hold prompts

conditional 5-14

creating 5-11

using custom data variables with 5-15
hot-desking 3-13

|
importing
voicefiles 1-9
Inbound Call Outcome Trends report 11-54
Inbound Call Volume Trends report 11-56

J
joining agents' calls 9-18

L

language of prompts for a queue 2-8
last agent routing 4-4

least talk time distribution 4-2, 4-3
local reports 11-11

logging queue calls 2-24

longest idle agent distribution 4-1, 4-3

M

mailbox, setting up for a queue 5-21
maximum wait time, defining 2-20
menu choice for queues 2-14
monitoring agents’ calls 9-18
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N
notifications for voice messages 5-23

0]

On Break status, automatically placing agentsin
4-6

options for waiting callers 5-10

Outbound Call Comparison report 11-57

outbound caller ID 2-25

Outbound Calls by Phone Number report 11-59

Outbound Long Distance Summary report 11-61

overflow agents
defined 1-7
using in queues 3-14

P

password security 2-27
permissions
defined 3-9

for contact center agentsto supervise other agents

1-7

setting defaults 3-2
personal calls, defined 1-7
personal status

and state 9-14

changing an agent’s 9-24

preventing agents from changing 3-11
placing calls from a queue 10-10
popping up caler information 10-11
priority, setting for calls 4-9

Q

Queue Call History Detail report 11-64
Queue Comparison report 11-64
Queuedialog 2-5

Queue Monitor view 9-3, 10-9

Queue Performance Summary by Agent report
reports
Queue Performance Summary by Agent report
11-67
Queue Statistics pane 9-8
gueues
overview of creating 2-2
adding agentsto 3-4
agent permissions 3-9
call distribution 4-1
call outcome report 11-54
cal priority 4-9
call volume report 11-56
callback 5-16
adding prompt to hold menu 5-17
callback statistics 5-17
setting up 5-18
caler ID for 2-25
caller options while waiting 5-10
clearing lockout 2-28
closing 6-15
comparison report 11-64
contacts for 8-9
creating a utility user for 8-3
creating Hold prompts for 5-11
data entry by callers 5-2
defined 1-7
deleting 6-16
distribution algorithms 4-1
extensions for 2-6

prompts )

conditional Hold 5-14 hold music for 5-7

Welcome 2-10 language of phone prompts 2-8
listing in dia-by-name directory 2-16
logs B-1
menu choices for 2-14
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prompt language 2-8

recording calls 6-6

setting up menu choice for 2-14
signing in and out 10-1
skillsfor 7-8

statistics by phone 9-17
supervising overview 9-1

talk time report by agent 11-48
trends report 11-27

using call ruleswith 8-9

using contacts with 8-2

using overflow agents 3-14
utility user 8-3

validating data entry by callers 5-5
viewing statistics online 9-2
voice mail greetingsfor 2-11
voice mailbox for 9-25
voicetitlefor 2-9

wait by outcome report 11-77
Welcome prompt for 2-10

Queuesview 2-3

R

receiving and handling queue calls 10-6

recording
agents' calls 3-7
queue calls 6-6

recordings
creating 1-8
redirecting calls 2-17
remote agents 3-13
reports
overview 11-1
Activity History by Agent 11-20
Activity History by Queue 11-22
Agent by Queue and Skill Configuration report
11-24
Agent Call Trends 11-25
Agent Performance by Skill 11-28

Agent Performance Trends by Queue 11-27

Agent State Summary 11-29

Agent State Summary by Queue 11-31

Average Wait Time and Call Volume by Time of
Day 11-32

backups for 11-3

Call Center Queue Information 11-47

Cdll Distribution by Skill and Agent 11-33

Cdll Distribution by Skill and Queue 11-35

Call Log 11-36

Call Result by Skill 11-38

Cdl Summary 11-39

Call Transfer 11-41

Call Trends 11-43

Cdl Volume by Account Code 11-45

Cadl Volume by Identified Caller 11-46

Cumulative Calls and Average Talk Time by
Agent 11-48

custom A-1

Custom Data 11-50

Grouped Service Level 11-52

Inbound Call Outcome Trends 11-54

Inbound Call Volume Trends 11-56

optionsfor 11-10

Outbound Call Comparison 11-57

Outbound Calls by Phone Number 11-59

Outbound Long Distance Summary 11-61

Queue Call History Detail 11-64

Queue Comparison 11-64

running 11-3

ServiceLevel 11-68

Service Level by Skill 11-70

shared and local 11-11

Skill Assignment by Agent report 11-71

Unanswered Calls During Business Hours 11-72

User Activity 11-74

User Call Trends 11-75

using Exced toolbar to run 11-4

viewing headers and footers 11-7

Wait by Outcome 11-77

reset times for statistics 9-12

Wave Contact Center Administrator Guide

Wave 5.0

July 2016



Index-6

ringback, configuring for agents 5-9
roaming agents 3-13
round robin distribution 4-1, 4-3

S

schema for database A-2
security
Wave system 1-9
security, managing for a queue 2-27
Service Level by Skill report 11-70
Service Level report 11-68
shared reports 11-11
shifts
with call center queues 6-9
signing in and out 10-1
simultaneous ring distribution 4-2, 4-3
Skill Assignment by Agent report 11-71
skills
adding to calls as requirements 7-6
adding to queues 7-8
adjusting requirements over time 7-12
assigning to users 7-5
configuring a queue to use 7-9
defining 7-4
reducing wait time for 7-17
value scale for 7-5
viewing an agent’s 7-16
weighting for a queue 7-8
states for agents, defined 9-5
statistics
configuring collection of 6-9
displayed for queues 9-2
when reset 9-12
supervising
changing agents’ personal status 9-24

monitoring, coaching, and joining agents' calls

9-18
overview 9-1

without receiving calls 9-2
supervisor, defined 1-7
support services 1-9
system security 1-9

T

technical support 1-9

terminology 1-7

time-of-day wait time and call volume report 11-32
toolbar, for reports, using in Microsoft Excel 11-4
top down distribution 4-1, 4-3

transfer, option while waiting 5-10

trends report 11-43

U

Unanswered Calls During Business Hours report
11-72

User Activity report 11-74

User Call Trends report 11-75

utility user 8-3

Vv

validating caller data 5-5
voicefiles
importing and exporting 1-9
voice mail
callback phone numbers 2-13
creating greetings 2-11
notifications for 5-23
option while waiting 5-10
setting up for aqueue 5-21
voicetitle for queues 2-9
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w

Wait by Outcome report 11-77
Web site 1-9
weighting skills 7-8
Welcome prompt, recording 2-10
working remotely 10-12
wrap-up time

default setting for 3-2

ending early 10-9

using 10-9
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